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1 Introduction

1 Introduction

1.1 Target group

This documentation is aimed at users with the following knowledge and skills:

 Basic knowledge of the industrial robot

1.2 Industrial robot documentation

The industrial robot documentation consists of the following parts:

 Documentation for the manipulator

 Documentation for the robot controller

 Operating and programming instructions for the KUKA System Software

 Documentation relating to options and accessories

 Parts catalog on storage medium

Each of these sets of instructions is a separate document.

1.3 Representation of warnings and notes

Safety These warnings are relevant to safety and must be observed.

This warning draws attention to procedures which serve to prevent or remedy 
emergencies or malfunctions: 

Notes These hints serve to make your work easier or contain references to further 
information.

For optimal use of our products, we recommend that our customers 
take part in a course of training at KUKA College. Information about 
the training program can be found at www.kuka.com or can be ob-

tained directly from our subsidiaries.

These warnings mean that it is certain or highly probable 
that death or severe injuries will occur, if no precautions 

are taken.

These warnings mean that death or severe injuries may 
occur, if no precautions are taken.

These warnings mean that minor injuries may occur, if 
no precautions are taken.

These warnings mean that damage to property may oc-
cur, if no precautions are taken.

These warnings contain references to safety-relevant information or 
general safety measures. 
These warnings do not refer to individual hazards or individual pre-

cautionary measures.

Procedures marked with this warning must be followed 
exactly.
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1.4 Trademarks

Windows is a trademark of Microsoft Corporation.

WordPad is a trademark of Microsoft Corporation.

Tip to make your work easier or reference to further information.
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2 Product description

2 Product description

2.1 Overview of the industrial robot

The industrial robot consists of the following components:

 Manipulator

 Robot controller

 Teach pendant

 Connecting cables

 Software

 Options, accessories

2.2 Overview of KUKA System Software (KSS)

Description The KUKA System Software (KSS) is responsible for all the basic operator 
control functions of the industrial robot.

 Path planning

 I/O management

 Data and file management

 etc.

Additional technology packages, containing application-specific instructions 
and configurations, can be installed.

smartHMI The user interface of the KUKA System Software is called KUKA smartHMI 
(smart Human-Machine Interface).

Features:

 User administration

Fig. 2-1: Example of an industrial robot

1 Manipulator 3 Robot controller

2 Connecting cables 4 Teach pendant
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 Program editor

 KRL (KUKA Robot Language)

 Inline forms for programming

 Message display

 Configuration window

 etc.

 (>>> 4.2 "KUKA smartHMI user interface" Page 47)

2.3 System requirements

KSS 8.3 can be run on the following robot controller:

 KR C4 

 with Windows Embedded Standard 7 V4.x

 and with 2 GB RAM

2.4 Intended use of the KUKA System Software

Use The KUKA System Software is intended exclusively for the operation of a 
KUKA industrial robot or customer-specific kinematic system. 

Each version of the KUKA System Software may be operated exclusively in 
accordance with the specified system requirements.

 (>>> 2.3 "System requirements" Page 14)

Misuse Any use or application deviating from the intended use is deemed to be imper-
missible misuse. The manufacturer cannot be held liable for any damage re-
sulting from such use. The risk lies entirely with the user. 

Examples of such misuse include:

 Operation of a kinematic system that is neither a KUKA industrial robot nor 
a customer-specific kinematic system

 Operation of the KSS not in accordance with the specified system require-
ments

2.5 KUKA USB sticks

The following KUKA USB sticks exist for the KR C4 robot controller:

 KUKA USB stick 2.0 NB 4 GB

Not bootable

Art. no. 00-197-266

 KUKA USB stick 2.0 Recovery 4 GB

Bootable

Component of the product KUKA.RecoveryUSB 1.0, art. no. 00-198-642

If a task requires the use of a specific stick, this is indicated in the description 
of the task.

Depending on customer-specific settings, the user interface may vary 
from the standard interface.
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Fig. 2-2: KUKA USB stick 2.0 NB 4 GB, not bootable (art. no. 00-197-266)

Fig. 2-3: KUKA USB stick 2.0 Recovery 4 GB, bootable (art. no. 00-198-
642)
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3 Safety

3 Safety

3.1 General

3.1.1 Liability

The device described in this document is either an industrial robot or a com-
ponent thereof.

Components of the industrial robot:

 Manipulator

 Robot controller

 Teach pendant

 Connecting cables

 External axes (optional)

e.g. linear unit, turn-tilt table, positioner

 Software

 Options, accessories

The industrial robot is built using state-of-the-art technology and in accor-
dance with the recognized safety rules. Nevertheless, misuse of the industrial 
robot may constitute a risk to life and limb or cause damage to the industrial 
robot and to other material property.

The industrial robot may only be used in perfect technical condition in accor-
dance with its designated use and only by safety-conscious persons who are 
fully aware of the risks involved in its operation. Use of the industrial robot is 
subject to compliance with this document and with the declaration of incorpo-
ration supplied together with the industrial robot. Any functional disorders af-
fecting safety must be rectified immediately.

Safety infor-

mation

Safety information cannot be held against KUKA Roboter GmbH. Even if all 
safety instructions are followed, this is not a guarantee that the industrial robot 
will not cause personal injuries or material damage.

No modifications may be carried out to the industrial robot without the autho-
rization of KUKA Roboter GmbH. Additional components (tools, software, 
etc.), not supplied by KUKA Roboter GmbH, may be integrated into the indus-
trial robot. The user is liable for any damage these components may cause to 
the industrial robot or to other material property.

In addition to the Safety chapter, this document contains further safety instruc-
tions. These must also be observed.

3.1.2 Intended use of the industrial robot

The industrial robot is intended exclusively for the use designated in the “Pur-
pose” chapter of the operating instructions or assembly instructions.

Using the industrial robot for any other or additional purpose is considered im-
permissible misuse. The manufacturer cannot be held liable for any damage 
resulting from such use. The risk lies entirely with the user.

Operating the industrial robot and its options within the limits of its intended 
use also involves observance of the operating and assembly instructions for 

Further information is contained in the “Purpose” chapter of the oper-
ating instructions or assembly instructions of the industrial robot.
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the individual components, with particular reference to the maintenance spec-
ifications.

Misuse Any use or application deviating from the intended use is deemed to be imper-
missible misuse. This includes e.g.:

 Transportation of persons and animals

 Use as a climbing aid

 Operation outside the permissible operating parameters

 Use in potentially explosive environments

 Operation without additional safeguards

 Outdoor operation

 Underground operation

3.1.3 EC declaration of conformity and declaration of incorporation

This industrial robot constitutes partly completed machinery as defined by the 
EC Machinery Directive. The industrial robot may only be put into operation if 
the following preconditions are met:

 The industrial robot is integrated into a complete system.

Or: The industrial robot, together with other machinery, constitutes a com-
plete system.

Or: All safety functions and safeguards required for operation in the com-
plete machine as defined by the EC Machinery Directive have been added 
to the industrial robot.

 The complete system complies with the EC Machinery Directive. This has 
been confirmed by means of an assessment of conformity.

Declaration of 

conformity

The system integrator must issue a declaration of conformity for the complete 
system in accordance with the Machinery Directive. The declaration of confor-
mity forms the basis for the CE mark for the system. The industrial robot must 
be operated in accordance with the applicable national laws, regulations and 
standards.

The robot controller is CE certified under the EMC Directive and the Low Volt-
age Directive.

Declaration of 

incorporation

The industrial robot as partly completed machinery is supplied with a declara-
tion of incorporation in accordance with Annex II B of the EC Machinery Direc-
tive 2006/42/EC. The assembly instructions and a list of essential 
requirements complied with in accordance with Annex I are integral parts of 
this declaration of incorporation. 

The declaration of incorporation declares that the start-up of the partly com-
pleted machinery remains impermissible until the partly completed machinery 
has been incorporated into machinery, or has been assembled with other parts 
to form machinery, and this machinery complies with the terms of the EC Ma-
chinery Directive, and the EC declaration of conformity is present in accor-
dance with Annex II A.

The declaration of incorporation, together with its annexes, remains with the 
system integrator as an integral part of the technical documentation of the 
complete machinery. 

3.1.4 Terms used

STOP 0, STOP 1 and STOP 2 are the stop definitions according to EN 60204-
1:2006.
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Term Description

Axis range Range of each axis, in degrees or millimeters, within which it may move. 
The axis range must be defined for each axis.

Stopping distance Stopping distance = reaction distance + braking distance

The stopping distance is part of the danger zone.

Workspace The manipulator is allowed to move within its workspace. The work-
space is derived from the individual axis ranges.

Operator
(User)

The user of the industrial robot can be the management, employer or 
delegated person responsible for use of the industrial robot.

Danger zone The danger zone consists of the workspace and the stopping distances.

Service life The service life of a safety-relevant component begins at the time of 
delivery of the component to the customer.

The service life is not affected by whether the component is used in a 
robot controller or elsewhere or not, as safety-relevant components are 
also subject to ageing during storage.

KCP The KCP (KUKA Control Panel) teach pendant has all the operator con-
trol and display functions required for operating and programming the 
industrial robot.

The KCP variant for the KR C4 is called KUKA smartPAD. The general 
term “KCP”, however, is generally used in this documentation.

CRR Controlled Robot Retraction

CRR is an operating mode only available when KUKA.SafeOperation or 
KUKA.SafeRangeMonitoring is used. If the robot has violated a monitor-
ing function and been stopped by the safety controller, it can only be 
moved out of the violated area in CRR mode.

Manipulator The robot arm and the associated electrical installations

Safety zone The safety zone is situated outside the danger zone.

Safe operational stop The safe operational stop is a standstill monitoring function. It does not 
stop the robot motion, but monitors whether the robot axes are station-
ary. If these are moved during the safe operational stop, a safety stop 
STOP 0 is triggered.

The safe operational stop can also be triggered externally.

When a safe operational stop is triggered, the robot controller sets an 
output to the field bus. The output is set even if not all the axes were sta-
tionary at the time of triggering, thereby causing a safety stop STOP 0 to 
be triggered.

Safety STOP 0 A stop that is triggered and executed by the safety controller. The safety 
controller immediately switches off the drives and the power supply to 
the brakes.

Note: This stop is called safety STOP 0 in this document.

Safety STOP 1 A stop that is triggered and monitored by the safety controller. The brak-
ing process is performed by the non-safety-oriented part of the robot 
controller and monitored by the safety controller. As soon as the manip-
ulator is at a standstill, the safety controller switches off the drives and 
the power supply to the brakes.

When a safety STOP 1 is triggered, the robot controller sets an output to 
the field bus.

The safety STOP 1 can also be triggered externally.

Note: This stop is called safety STOP 1 in this document.
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3.2 Personnel

The following persons or groups of persons are defined for the industrial robot:

 User

 Personnel

User The user must observe the labor laws and regulations. This includes e.g.:

 The user must comply with his monitoring obligations.

 The user must carry out instructions at defined intervals.

Personnel Personnel must be instructed, before any work is commenced, in the type of 
work involved and what exactly it entails as well as any hazards which may ex-
ist. Instruction must be carried out regularly. Instruction is also required after 
particular incidents or technical modifications.

Personnel includes:

 System integrator

Safety STOP 2 A stop that is triggered and monitored by the safety controller. The brak-
ing process is performed by the non-safety-oriented part of the robot 
controller and monitored by the safety controller. The drives remain acti-
vated and the brakes released. As soon as the manipulator is at a stand-
still, a safe operational stop is triggered. 

When a safety STOP 2 is triggered, the robot controller sets an output to 
the field bus.

The safety STOP 2 can also be triggered externally.

Note: This stop is called safety STOP 2 in this document.

Stop category 0 The drives are deactivated immediately and the brakes are applied. The 
manipulator and any external axes (optional) perform path-oriented 
braking.

Note: This stop category is called STOP 0 in this document.

Stop category 1 The manipulator and any external axes (optional) perform path-main-
taining braking. 

 Operating mode T1: The drives are deactivated as soon as the robot 
has stopped, but no later than after 680 ms.

 Operating mode T2, AUT, AUT EXT: The drives are switched off after 
1.5 s.

Note: This stop category is called STOP 1 in this document.

Stop category 2 The drives are not deactivated and the brakes are not applied. The 
manipulator and any external axes (optional) are braked with a path-
maintaining braking ramp.

Note: This stop category is called STOP 2 in this document.

System integrator
(plant integrator)

System integrators are people who safely integrate the industrial robot 
into a complete system and commission it.

T1 Test mode, Manual Reduced Velocity (<= 250 mm/s)

T2 Test mode, Manual High Velocity (> 250 mm/s permissible)

External axis Motion axis which is not part of the manipulator but which is controlled 
using the robot controller, e.g. KUKA linear unit, turn-tilt table, Posiflex.

Term Description

All persons working with the industrial robot must have read and un-
derstood the industrial robot documentation, including the safety 
chapter.
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 Operators, subdivided into:

 Start-up, maintenance and service personnel

 Operating personnel

 Cleaning personnel

System integrator The industrial robot is safely integrated into a complete system by the system 
integrator.

The system integrator is responsible for the following tasks:

 Installing the industrial robot

 Connecting the industrial robot

 Performing risk assessment

 Implementing the required safety functions and safeguards

 Issuing the declaration of conformity

 Attaching the CE mark

 Creating the operating instructions for the complete system

Operator The operator must meet the following preconditions:

 The operator must be trained for the work to be carried out.

 Work on the industrial robot must only be carried out by qualified person-
nel. These are people who, due to their specialist training, knowledge and 
experience, and their familiarization with the relevant standards, are able 
to assess the work to be carried out and detect any potential hazards.

Example The tasks can be distributed as shown in the following table.

Installation, exchange, adjustment, operation, maintenance and re-
pair must be performed only as specified in the operating or assembly 
instructions for the relevant component of the industrial robot and only 

by personnel specially trained for this purpose.

Tasks Operator Programmer
System inte-
grator

Switch robot controller 
on/off

x x x

Start program x x x

Select program x x x

Select operating mode x x x

Calibration 
(tool, base)

x x

Master the manipulator x x

Configuration x x

Programming x x

Start-up x

Maintenance x

Repair x

Decommissioning x

Transportation x

Work on the electrical and mechanical equipment of the industrial ro-
bot may only be carried out by specially trained personnel. 
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3.3 Workspace, safety zone and danger zone

Workspaces are to be restricted to the necessary minimum size. A workspace 
must be safeguarded using appropriate safeguards.

The safeguards (e.g. safety gate) must be situated inside the safety zone. In 
the case of a stop, the manipulator and external axes (optional) are braked 
and come to a stop within the danger zone.

The danger zone consists of the workspace and the stopping distances of the 
manipulator and external axes (optional). It must be safeguarded by means of 
physical safeguards to prevent danger to persons or the risk of material dam-
age.

3.4 Triggers for stop reactions

Stop reactions of the industrial robot are triggered in response to operator ac-
tions or as a reaction to monitoring functions and error messages. The follow-
ing tables show the different stop reactions according to the operating mode 
that has been set.

Fig. 3-1: Example of axis range A1

1 Workspace 3 Stopping distance

2 Manipulator 4 Safety zone

Trigger T1, T2, CRR AUT, AUT EXT

Start key released STOP 2 -

STOP key pressed STOP 2

Drives OFF STOP 1

“Motion enable” input 
drops out

STOP 2

Robot controller switched 
off (power failure)

STOP 0

Internal error in non-
safety-oriented part of the 
robot controller

STOP 0 or STOP 1

(dependent on the cause of the error)
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3.5 Safety functions

3.5.1 Overview of the safety functions

The following safety functions are present in the industrial robot:

 Mode selection

 Operator safety (= connection for the guard interlock)

 EMERGENCY STOP device

 Enabling device

 External safe operational stop

 External safety stop 1 (not for the controller variant “KR C4 compact”)

 External safety stop 2

 Velocity monitoring in T1

The safety functions of the industrial robot meet the following requirements:

 Category 3 and Performance Level d in accordance with EN ISO 13849-
1:2008

 SIL 2 according to EN 62061

The requirements are only met on the following condition, however:

 The EMERGENCY STOP device is pressed at least once every 6 months.

The following components are involved in the safety functions:

 Safety controller in the control PC

 KUKA Control Panel (KUKA smartPAD)

 Cabinet Control Unit (CCU)

 Resolver Digital Converter (RDC)

 KUKA Power Pack (KPP)

 KUKA Servo Pack (KSP)

 Safety Interface Board (SIB) (if used)

There are also interfaces to components outside the industrial robot and to 
other robot controllers.

Operating mode changed 
during operation

Safety stop 2

Safety gate opened (oper-
ator safety)

- Safety stop 1

Releasing the enabling 
switch

Safety stop 2 -

Enabling switch pressed 
fully down or error

Safety stop 1 -

E-STOP pressed Safety stop 1

Error in safety controller 
or periphery of the safety 
controller

Safety stop 0

Trigger T1, T2, CRR AUT, AUT EXT

In the absence of operational safety functions and safe-
guards, the industrial robot can cause personal injury or 

material damage. If safety functions or safeguards are dismantled or deacti-
vated, the industrial robot may not be operated.
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3.5.2 Safety controller

The safety controller is a unit inside the control PC. It links safety-relevant sig-
nals and safety-relevant monitoring functions.

Safety controller tasks:

 Switching off the drives; applying the brakes

 Monitoring the braking ramp

 Standstill monitoring (after the stop)

 Velocity monitoring in T1

 Evaluation of safety-relevant signals

 Setting of safety-oriented outputs

3.5.3 Mode selection

The industrial robot can be operated in the following modes:

 Manual Reduced Velocity (T1)

 Manual High Velocity (T2)

 Automatic (AUT)

 Automatic External (AUT EXT)

 CRR

During system planning, the safety functions of the overall system 
must also be planned and designed. The industrial robot must be in-
tegrated into this safety system of the overall system.

Do not change the operating mode while a program is running. If the 
operating mode is changed during program execution, the industrial 
robot is stopped with a safety stop 2.

Operat-
ing mode

Use Velocities

T1
For test operation, pro-
gramming and teach-
ing

 Program verification:

Programmed velocity, maxi-
mum 250 mm/s

 Jog mode:

Jog velocity, maximum 250 mm/
s

T2 For test operation

 Program verification:

Programmed velocity

 Jog mode: Not possible

AUT
For industrial robots 
without higher-level 
controllers

 Program mode:

Programmed velocity

 Jog mode: Not possible
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3.5.4 Operator safety

The operator safety signal is used for interlocking physical safeguards, e.g. 
safety gates. Automatic operation is not possible without this signal. In the 
event of a loss of signal during automatic operation (e.g. safety gate is 
opened), the manipulator stops with a safety stop 1.

Operator safety is not active in the modes T1 (Manual Reduced Velocity), T2 
(Manual High Velocity) and CRR.

3.5.5 EMERGENCY STOP device

The EMERGENCY STOP device for the industrial robot is the EMERGENCY 
STOP device on the KCP. The device must be pressed in the event of a haz-
ardous situation or emergency.

Reactions of the industrial robot if the EMERGENCY STOP device is pressed:

 The manipulator and any external axes (optional) are stopped with a safe-
ty stop 1.

Before operation can be resumed, the EMERGENCY STOP device must be 
turned to release it.

There must always be at least one external EMERGENCY STOP device in-
stalled. This ensures that an EMERGENCY STOP device is available even 
when the KCP is disconnected.

AUT EXT
For industrial robots 
with higher-level con-
trollers, e.g. PLC

 Program mode:

Programmed velocity

 Jog mode: Not possible

CRR

CRR is only available if KUKA.SafeOperation or KUKA.Saf-
eRangeMonitoring is used. 

If the robot has violated a monitoring function and been 
stopped by the safety controller, it can only be moved out of 
the violated area in CRR mode.

Speeds similar to T1

Operat-
ing mode

Use Velocities

Following a loss of signal, automatic operation must not 
be resumed merely by closing the safeguard; it must first 

additionally be acknowledged. It is the responsibility of the system integrator 
to ensure this. This is to prevent automatic operation from being resumed in-
advertently while there are still persons in the danger zone, e.g. due to the 
safety gate closing accidentally.

 The acknowledgement must be designed in such a way that an actual 
check of the danger zone can be carried out first. Acknowledgement 
functions that do not allow this (e.g. because they are automatically trig-
gered by closure of the safeguard) are not permissible.

 Failure to observe this may result in death to persons, severe injuries or 
considerable damage to property.

Tools and other equipment connected to the manipulator 
must be integrated into the EMERGENCY STOP circuit 

on the system side if they could constitute a potential hazard.
Failure to observe this precaution may result in death, severe injuries or con-
siderable damage to property.
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 (>>> 3.5.7 "External EMERGENCY STOP device" Page 26)

3.5.6 Logging off from the higher-level safety controller

If the robot controller is connected to a higher-level safety controller, this con-
nection will inevitably be terminated in the following cases:

 Switching off of the robot controller via the main switch or due to a power 
failure

In this case, it does not matter whether the Cold start or Hibernate start 
type has been selected.

 Shutdown of the robot controller via the smartHMI

 Activation of a WorkVisual project in WorkVisual or directly on the robot 
controller

 Changes to Start-up > Network configuration

 Changes to Configuration > Safety configuration

 I/O drivers > Reconfigure

 Restoration of an archive

Effect of the interruption:

 If the X11 interface is used, this triggers an EMERGENCY STOP for the 
overall system.

 If the Ethernet interface is used, the KUKA safety controller generates a 
signal that prevents the higher-level controller from triggering an EMER-
GENCY STOP for the overall system. 

3.5.7 External EMERGENCY STOP device

There must be EMERGENCY STOP devices available at every operator sta-
tion that can initiate a robot motion or other potentially hazardous situation. 
The system integrator is responsible for ensuring this.

There must always be at least one external EMERGENCY STOP device in-
stalled. This ensures that an EMERGENCY STOP device is available even 
when the KCP is disconnected.

External EMERGENCY STOP devices are connected via the customer inter-
face. External EMERGENCY STOP devices are not included in the scope of 
supply of the industrial robot.

If the Ethernet safety interface is used: In his risk assess-
ment, the system integrator must take into consideration 

whether the fact that switching off the robot controller does not trigger an 
EMERGENCY STOP of the overall system could constitute a hazard and, if 
so, how this hazard can be countered.
Failure to take this into consideration may result in death to persons, severe 
injuries or considerable damage to property.

If a robot controller is switched off, the E-STOP device on 
the KCP is no longer functional. The user is responsible 

for ensuring that the KCP is either covered or removed from the system. This 
serves to prevent operational and non-operational EMERGENCY STOP de-
vices from becoming interchanged.
Failure to observe this precaution may result in death to persons, severe in-
juries or considerable damage to property.
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3.5.8 Enabling device

The enabling devices of the industrial robot are the enabling switches on the 
KCP.

There are 3 enabling switches installed on the KCP. The enabling switches 
have 3 positions:

 Not pressed

 Center position

 Panic position

In the test modes and in CRR, the manipulator can only be moved if one of the 
enabling switches is held in the central position.

 Releasing the enabling switch triggers a safety stop 2. 

 Pressing the enabling switch down fully (panic position) triggers a safety 
stop 1.

 It is possible, for a short time, to hold 2 enabling switches in the center po-
sition simultaneously. This makes it possible to adjust grip from one en-
abling switch to another one. If 2 enabling switches are held 
simultaneously in the center position for a longer period of time, this trig-
gers a safety stop after several seconds.

If an enabling switch malfunctions (jams), the industrial robot can be stopped 
using the following methods:

 Press the enabling switch down fully

 Actuate the EMERGENCY STOP system

 Release the Start key

3.5.9 External enabling device

External enabling devices are required if it is necessary for more than one per-
son to be in the danger zone of the industrial robot. They are connected to the 
robot controller via an interface.

External enabling devices are not included in the scope of supply of the indus-
trial robot.

3.5.10 External safe operational stop

The safe operational stop can be triggered via an input on the customer inter-
face. The state is maintained as long as the external signal is FALSE. If the 
external signal is TRUE, the manipulator can be moved again. No acknowl-
edgement is required.

3.5.11 External safety stop 1 and external safety stop 2

Safety stop 1 and safety stop 2 can be triggered via an input on the customer 
interface. The state is maintained as long as the external signal is FALSE. If 

The enabling switches must not be held down by adhe-
sive tape or other means or manipulated in any other 

way.
Death, injuries or damage to property may result.

Which interface can be used for connecting external enabling devices 
is described in the “Planning” chapter of the robot controller operating 
instructions and assembly instructions.
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the external signal is TRUE, the manipulator can be moved again. No ac-
knowledgement is required.

3.5.12 Velocity monitoring in T1 and CRR

The velocity at the TCP is monitored in the T1 and CRR modes. If, due to an 
error, the velocity exceeds 250 mm/s, a safety stop 0 is triggered.

3.6 Additional protective equipment

3.6.1 Jog mode

In the operating modes T1 (Manual Reduced Velocity), T2 (Manual High Ve-
locity) and CRR, the robot controller can only execute programs in jog mode. 
This means that it is necessary to hold down an enabling switch and the Start 
key in order to execute a program.

 Releasing the enabling switch triggers a safety stop 2. 

 Pressing the enabling switch down fully (panic position) triggers a safety 
stop 1.

 Releasing the Start key triggers a STOP 2.

3.6.2 Software limit switches

The axis ranges of all manipulator and positioner axes are limited by means of 
adjustable software limit switches. These software limit switches only serve as 
machine protection and must be adjusted in such a way that the manipulator/
positioner cannot hit the mechanical end stops.

The software limit switches are set during commissioning of an industrial ro-
bot.

3.6.3 Mechanical end stops

Depending on the robot variant, the axis ranges of the main and wrist axes of 
the manipulator are partially limited by mechanical end stops.

Additional mechanical end stops can be installed on the external axes.

3.6.4 Mechanical axis range limitation (optional)

Some manipulators can be fitted with mechanical axis range limitation in axes 
A1 to A3. The adjustable axis range limitation systems restrict the working 

No external safety stop 1 is available for the controller variant “KR C4 
compact”.

Further information is contained in the operating and programming in-
structions.

If the manipulator or an external axis hits an obstruction 
or a mechanical end stop or axis range limitation, this 

can result in material damage to the industrial robot. The manipulator must 
be taken out of operation and KUKA Roboter GmbH must be consulted be-
fore it is put back into operation  (>>> 10 "KUKA Service" Page 225).
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range to the required minimum. This increases personal safety and protection 
of the system.

In the case of manipulators that are not designed to be fitted with mechanical 
axis range limitation, the workspace must be laid out in such a way that there 
is no danger to persons or material property, even in the absence of mechan-
ical axis range limitation.

If this is not possible, the workspace must be limited by means of photoelectric 
barriers, photoelectric curtains or obstacles on the system side. There must be 
no shearing or crushing hazards at the loading and transfer areas.

3.6.5 Axis range monitoring (optional)

Some manipulators can be fitted with dual-channel axis range monitoring sys-
tems in main axes A1 to A3. The positioner axes may be fitted with additional 
axis range monitoring systems. The safety zone for an axis can be adjusted 
and monitored using an axis range monitoring system. This increases person-
al safety and protection of the system.

3.6.6 Devices for moving the manipulator without the robot controller (options)

Description The following devices are available for moving the manipulator after an acci-
dent or malfunction:

 Release device

The release device can be used for the main axis drive motors and, de-
pending on the robot variant, also for the wrist axis drive motors. 

 Brake release device

The brake release device is designed for robot variants whose motors are 
not freely accessible.

The devices are only for use in exceptional circumstances and emergencies, 
e.g. for freeing people.

Procedure Moving the manipulator with the release device:

1. Switch off the robot controller and secure it (e.g. with a padlock) to prevent 
unauthorized persons from switching it on again.

2. Remove the protective cap from the motor.

This option is not available for all robot models. Information on spe-
cific robot models can be obtained from KUKA Roboter GmbH.

This option is not available for all robot models. Information on spe-
cific robot models can be obtained from KUKA Roboter GmbH.

These options are not available for all robot models. Information on 
specific robot models can be obtained from KUKA Roboter GmbH.

The motors reach temperatures during operation which 
can cause burns to the skin. Contact must be avoided. 

Appropriate safety precautions must be taken, e.g. protective gloves must be 
worn.

The following procedure must be followed exactly!
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3. Push the release device onto the corresponding motor and move the axis 
in the desired direction.

The directions are indicated with arrows on the motors. It is necessary to 
overcome the resistance of the mechanical motor brake and any other 
loads acting on the axis. 

Procedure Moving the manipulator with the brake release device:

1. Switch off the robot controller and secure it (e.g. with a padlock) to prevent 
unauthorized persons from switching it on again.

2. Connect the brake release device to the base frame of the robot:

Unplug connector X30 from interface A1. Plug connector X20 of the brake 
release device into interface A1.

3. Select the brakes to be released (main axes, wrist axes) via the selection 
switch on the brake release device.

4. Press the button on the hand-held device.

The brakes of the main axes or wrist axes are released and the robot can 
be moved manually.

3.6.7 Labeling on the industrial robot

All plates, labels, symbols and marks constitute safety-relevant parts of the in-
dustrial robot. They must not be modified or removed.

Labeling on the industrial robot consists of:

 Identification plates

 Warning labels

 Safety symbols

 Designation labels

 Cable markings

 Rating plates

Moving an axis with the release device can damage the 
motor brake. This can result in personal injury and mate-

rial damage. After using the release device, the motor must be exchanged.

If a robot axis has been moved by the release device, all 
robot axes must be remastered. Serious infuries or dam-

age to property may otherwise result. 

Use of the brake release device may result in unexpect-
ed robot motions, especially sagging of the axes. During 

use of the brake release device, attention must be paid to motion of this kind 
in order to be able to prevent physical injuries or damage to property. Stand-
ing under moving axes is not permitted.

The following procedure must be followed exactly!

Further information about the brake release device can be found in 
the documentation for the brake release device.

Further information is contained in the technical data of the operating 
instructions or assembly instructions of the components of the indus-
trial robot.
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3.6.8 External safeguards

The access of persons to the danger zone of the industrial robot must be pre-
vented by means of safeguards. It is the responsibility of the system integrator 
to ensure this.

Physical safeguards must meet the following requirements:

 They meet the requirements of EN 953.

 They prevent access of persons to the danger zone and cannot be easily 
circumvented.

 They are sufficiently fastened and can withstand all forces that are likely 
to occur in the course of operation, whether from inside or outside the en-
closure.

 They do not, themselves, represent a hazard or potential hazard.

 The prescribed minimum clearance from the danger zone is maintained.

Safety gates (maintenance gates) must meet the following requirements:

 They are reduced to an absolute minimum.

 The interlocks (e.g. safety gate switches) are linked to the operator safety 
input of the robot controller via safety gate switching devices or safety 
PLC.

 Switching devices, switches and the type of switching conform to the re-
quirements of Performance Level d and category 3 according to EN ISO 
13849-1.

 Depending on the risk situation: the safety gate is additionally safeguarded 
by means of a locking mechanism that only allows the gate to be opened 
if the manipulator is safely at a standstill.

 The button for acknowledging the safety gate is located outside the space 
limited by the safeguards.

Other safety 

equipment

Other safety equipment must be integrated into the system in accordance with 
the corresponding standards and regulations.

3.7 Overview of operating modes and safety functions

The following table indicates the operating modes in which the safety functions 
are active.

Further information is contained in the corresponding standards and 
regulations. These also include EN 953.

Safety functions
T1, 

CRR
T2 AUT AUT EXT

Operator safety - - active active

EMERGENCY STOP device active active active active

Enabling device active active - -

Reduced velocity during pro-
gram verification

active - - -

Jog mode active active - -

Software limit switches active active active active
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3.8 Safety measures

3.8.1 General safety measures

The industrial robot may only be used in perfect technical condition in accor-
dance with its intended use and only by safety-conscious persons. Operator 
errors can result in personal injury and damage to property.

It is important to be prepared for possible movements of the industrial robot 
even after the robot controller has been switched off and locked. Incorrect in-
stallation (e.g. overload) or mechanical defects (e.g. brake defect) can cause 
the manipulator or external axes to sag. If work is to be carried out on a 
switched-off industrial robot, the manipulator and external axes must first be 
moved into a position in which they are unable to move on their own, whether 
the payload is mounted or not. If this is not possible, the manipulator and ex-
ternal axes must be secured by appropriate means.

KCP The user must ensure that the industrial robot is only operated with the KCP 
by authorized persons.

If more than one KCP is used in the overall system, it must be ensured that 
each KCP is unambiguously assigned to the corresponding industrial robot. 
They must not be interchanged.

Faults The following tasks must be carried out in the case of faults in the industrial 
robot:

 Switch off the robot controller and secure it (e.g. with a padlock) to prevent 
unauthorized persons from switching it on again. 

 Indicate the fault by means of a label with a corresponding warning (tag-
out).

 Keep a record of the faults.

 Eliminate the fault and carry out a function test.

Modifications After modifications to the industrial robot, checks must be carried out to ensure 
the required safety level. The valid national or regional work safety regulations 

In the absence of operational safety functions and safe-
guards, the industrial robot can cause personal injury or 

material damage. If safety functions or safeguards are dismantled or deacti-
vated, the industrial robot may not be operated.

Standing underneath the robot arm can cause death or 
serious injuries. For this reason, standing underneath the 

robot arm is prohibited!

The motors reach temperatures during operation which 
can cause burns to the skin. Contact must be avoided. 

Appropriate safety precautions must be taken, e.g. protective gloves must be 
worn.

The operator must ensure that decoupled KCPs are im-
mediately removed from the system and stored out of 

sight and reach of personnel working on the industrial robot. This serves to 
prevent operational and non-operational EMERGENCY STOP devices from 
becoming interchanged.
Failure to observe this precaution may result in death, severe injuries or con-
siderable damage to property.
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must be observed for this check. The correct functioning of all safety circuits 
must also be tested.

New or modified programs must always be tested first in Manual Reduced Ve-
locity mode (T1).

After modifications to the industrial robot, existing programs must always be 
tested first in Manual Reduced Velocity mode (T1). This applies to all compo-
nents of the industrial robot and includes modifications to the software and 
configuration settings.

3.8.2 Transportation

Manipulator The prescribed transport position of the manipulator must be observed. Trans-
portation must be carried out in accordance with the operating instructions or 
assembly instructions of the robot.

Robot controller The prescribed transport position of the robot controller must be observed. 
Transportation must be carried out in accordance with the operating instruc-
tions or assembly instructions of the robot controller.

Avoid vibrations and impacts during transportation in order to prevent damage 
to the robot controller.

External axis 

(optional)

The prescribed transport position of the external axis (e.g. KUKA linear unit, 
turn-tilt table, positioner) must be observed. Transportation must be carried 
out in accordance with the operating instructions or assembly instructions of 
the external axis.

3.8.3 Start-up and recommissioning

Before starting up systems and devices for the first time, a check must be car-
ried out to ensure that the systems and devices are complete and operational, 
that they can be operated safely and that any damage is detected.

The valid national or regional work safety regulations must be observed for this 
check. The correct functioning of all safety circuits must also be tested.

The passwords for the user groups must be changed in the KUKA 
System Software before start-up. The passwords must only be com-
municated to authorized personnel.

The robot controller is preconfigured for the specific in-
dustrial robot. If cables are interchanged, the manipula-

tor and the external axes (optional) may receive incorrect data and can thus 
cause personal injury or material damage. If a system consists of more than 
one manipulator, always connect the connecting cables to the manipulators 
and their corresponding robot controllers.

If additional components (e.g. cables), which are not part of the scope 
of supply of KUKA Roboter GmbH, are integrated into the industrial 
robot, the user is responsible for ensuring that these components do 

not adversely affect or disable safety functions.

If the internal cabinet temperature of the robot controller 
differs greatly from the ambient temperature, condensa-

tion can form, which may cause damage to the electrical components. Do not 
put the robot controller into operation until the internal temperature of the 
cabinet has adjusted to the ambient temperature.
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Function test The following tests must be carried out before start-up and recommissioning:

General test:

It must be ensured that:

 The industrial robot is correctly installed and fastened in accordance with 
the specifications in the documentation.

 There are no foreign bodies or loose parts on the industrial robot.

 All required safety equipment is correctly installed and operational.

 The power supply ratings of the industrial robot correspond to the local 
supply voltage and mains type.

 The ground conductor and the equipotential bonding cable are sufficiently 
rated and correctly connected.

 The connecting cables are correctly connected and the connectors are 
locked.

Test of the safety functions:

A function test must be carried out for the following safety functions to ensure 
that they are functioning correctly:

 Local EMERGENCY STOP device

 External EMERGENCY STOP device (input and output)

 Enabling device (in the test modes)

 Operator safety

 All other safety-relevant inputs and outputs used

 Other external safety functions

3.8.3.1 Checking machine data and safety-relevant control configuration

 It must be ensured that the rating plate on the robot controller has the 
same machine data as those entered in the declaration of incorporation. 
The machine data on the rating plate of the manipulator and the external 
axes (optional) must be entered during start-up.

 The practical tests for the machine data must be carried out within the 
scope of the start-up procedure.

 Following modifications to the machine data, the safety configuration must 
always be checked. 

 If changes are made to the machine data when checking the safety con-
figuration (regardless of the reason for the safety configuration check), the 
practical tests for the machine data must be carried out.

If the practical tests are not successfully completed in the initial start-up, KUKA 
Roboter GmbH must be contacted.

If the practical test is not successfully completed during a different procedure, 
the machine data must be checked and corrected.

General practical 

test

If practical tests are required for the machine data, this test must always be 
carried out. 

The following methods are available for performing the practical test:

The industrial robot must not be moved if incorrect ma-
chine data are loaded. Death, severe injuries or consid-

erable damage to property may otherwise result. The correct machine data 
must be loaded.

Information about checking the safety configuration is contained in 
the Operating and Programming Instructions for System Integrators.
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 TCP calibration with the XYZ 4-point method

The practical test is passed if the TCP has been successfully calibrated.

Or: 

1. Align the TCP with a freely selected point. 

The point serves as a reference point. It must be located so that reorien-
tation is possible.

2. Move the TCP manually at least 45° once in each of the A, B and C direc-
tions.

The movements do not have to be accumulative, i.e. after motion in one 
direction it is possible to return to the original position before moving in the 
next direction.

The practical test is passed if the TCP does not deviate from the reference 
point by more than 2 cm in total.

Practical test for 

axes that are not 

mathematically 

coupled

If practical tests are required for the machine data, this test must be carried out 
when axes are present that are not mathematically coupled. 

1. Mark the starting position of the axis that is not mathematically coupled.

2. Move the axis manually by a freely selected path length. Determine the 
path length from the display Actual position on the smartHMI.

 Move linear axes a specific distance.

 Move rotational axes through a specific angle.

3. Measure the length of the path covered and compare it with the value dis-
played on the smartHMI.

The practical test is passed if the values differ by no more than 10%.

4. Repeat the test for each axis that is not mathematically coupled.

Practical test for 

couplable axes

If practical tests are required for the machine data, this test must be carried out 
when axes are present that can be physically coupled and uncoupled, e.g. a 
servo gun. 

1. Physically uncouple the couplable axis.

2. Move all the remaining axes individually.

The practical test is passed if it has been possible to move all the remain-
ing axes.

3.8.3.2 Start-up mode

Description The industrial robot can be set to Start-up mode via the smartHMI user inter-
face. In this mode, the manipulator can be moved in T1 or CRR mode in the 
absence of the safety periphery.

 If the X11 interface is used:

Start-up mode is always possible if all input signals have the state “logic 
zero”. If this is not the case, the robot controller prevents or terminates 
Start-up mode.

 If the Ethernet safety interface is used: 

If a connection to a higher-level safety system exists or is established, the 
robot controller prevents or terminates Start-up mode.

Hazards Possible hazards and risks involved in using Start-up mode:

 A person walks into the manipulator’s danger zone.

 An unauthorized person moves the manipulator.

 In a hazardous situation, a disabled external EMERGENCY STOP device 
is actuated and the manipulator is not shut down.
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Additional measures for avoiding risks in Start-up mode:

 Cover disabled EMERGENCY STOP devices or attach a warning sign in-
dicating that the EMERGENCY STOP device is out of operation.

 If there is no safety fence, other measures must be taken to prevent per-
sons from entering the manipulator’s danger zone, e.g. use of warning 
tape.

 Use of Start-up mode must be minimized – and avoided where possible – 
by means of organizational measures.

Use Intended use of Start-up mode:

 Only service personnel who have received safety instruction may use 
Start-up mode.

 Start-up in T1 mode or CRR mode when the external safeguards have not 
yet been installed or put into operation. The danger zone must be delimit-
ed at least by means of warning tape.

 Fault localization (periphery fault).

Misuse Any use or application deviating from the designated use is deemed to be im-
permissible misuse. This includes, for example, use by any other personnel.

KUKA Roboter GmbH accepts no liability for damage or injury caused thereby. 
The risk lies entirely with the user.

3.8.4 Manual mode

Manual mode is the mode for setup work. Setup work is all the tasks that have 
to be carried out on the industrial robot to enable automatic operation. Setup 
work includes:

 Jog mode

 Teach

 Programming

 Program verification

The following must be taken into consideration in manual mode:

 If the drives are not required, they must be switched off to prevent the ma-
nipulator or the external axes (optional) from being moved unintentionally.

New or modified programs must always be tested first in Manual Reduced 
Velocity mode (T1).

 The manipulator, tooling or external axes (optional) must never touch or 
project beyond the safety fence. 

 Workpieces, tooling and other objects must not become jammed as a re-
sult of the industrial robot motion, nor must they lead to short-circuits or be 
liable to fall off.

 All setup work must be carried out, where possible, from outside the safe-
guarded area.

If the setup work has to be carried out inside the safeguarded area, the follow-
ing must be taken into consideration:

Use of Start-up mode disables all external safeguards. 
The service personnel are responsible for ensuring that 

there is no-one in or near the danger zone of the manipulator as long as the 
safeguards are disabled.
Failure to observe this may result in death to persons, injuries or damage to 
property.
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In Manual Reduced Velocity mode (T1):

 If it can be avoided, there must be no other persons inside the safeguard-
ed area.

If it is necessary for there to be several persons inside the safeguarded ar-
ea, the following must be observed:

 Each person must have an enabling device.

 All persons must have an unimpeded view of the industrial robot.

 Eye-contact between all persons must be possible at all times.

 The operator must be so positioned that he can see into the danger area 
and get out of harm’s way.

In Manual High Velocity mode (T2):

 This mode may only be used if the application requires a test at a velocity 
higher than Manual Reduced Velocity.

 Teaching and programming are not permissible in this operating mode.

 Before commencing the test, the operator must ensure that the enabling 
devices are operational.

 The operator must be positioned outside the danger zone.

 There must be no other persons inside the safeguarded area. It is the re-
sponsibility of the operator to ensure this.

3.8.5 Simulation

Simulation programs do not correspond exactly to reality. Robot programs cre-
ated in simulation programs must be tested in the system in Manual Reduced 
Velocity mode (T1). It may be necessary to modify the program.

3.8.6 Automatic mode

Automatic mode is only permissible in compliance with the following safety 
measures:

 All safety equipment and safeguards are present and operational.

 There are no persons in the system.

 The defined working procedures are adhered to.

If the manipulator or an external axis (optional) comes to a standstill for no ap-
parent reason, the danger zone must not be entered until an EMERGENCY 
STOP has been triggered.

3.8.7 Maintenance and repair

After maintenance and repair work, checks must be carried out to ensure the 
required safety level. The valid national or regional work safety regulations 
must be observed for this check. The correct functioning of all safety circuits 
must also be tested.

The purpose of maintenance and repair work is to ensure that the system is 
kept operational or, in the event of a fault, to return the system to an operation-
al state. Repair work includes troubleshooting in addition to the actual repair 
itself.

The following safety measures must be carried out when working on the indus-
trial robot:

 Carry out work outside the danger zone. If work inside the danger zone is 
necessary, the user must define additional safety measures to ensure the 
safe protection of personnel.
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 Switch off the industrial robot and secure it (e.g. with a padlock) to prevent 
it from being switched on again. If it is necessary to carry out work with the 
robot controller switched on, the user must define additional safety mea-
sures to ensure the safe protection of personnel.

 If it is necessary to carry out work with the robot controller switched on, this 
may only be done in operating mode T1.

 Label the system with a sign indicating that work is in progress. This sign 
must remain in place, even during temporary interruptions to the work.

 The EMERGENCY STOP systems must remain active. If safety functions 
or safeguards are deactivated during maintenance or repair work, they 
must be reactivated immediately after the work is completed.

Faulty components must be replaced using new components with the same 
article numbers or equivalent components approved by KUKA Roboter GmbH 
for this purpose.

Cleaning and preventive maintenance work is to be carried out in accordance 
with the operating instructions.

Robot controller Even when the robot controller is switched off, parts connected to peripheral 
devices may still carry voltage. The external power sources must therefore be 
switched off if work is to be carried out on the robot controller.

The ESD regulations must be adhered to when working on components in the 
robot controller. 

Voltages in excess of 50 V (up to 780 V) can be present in various components 
for several minutes after the robot controller has been switched off! To prevent 
life-threatening injuries, no work may be carried out on the industrial robot in 
this time.

Water and dust must be prevented from entering the robot controller.

Counterbal-

ancing system

Some robot variants are equipped with a hydropneumatic, spring or gas cylin-
der counterbalancing system. 

The hydropneumatic and gas cylinder counterbalancing systems are pressure 
equipment and, as such, are subject to obligatory equipment monitoring. De-
pending on the robot variant, the counterbalancing systems correspond to cat-
egory 0, II or III, fluid group 2, of the Pressure Equipment Directive.

The user must comply with the applicable national laws, regulations and stan-
dards pertaining to pressure equipment. 

Inspection intervals in Germany in accordance with Industrial Safety Order, 
Sections 14 and 15. Inspection by the user before commissioning at the instal-
lation site.

The following safety measures must be carried out when working on the coun-
terbalancing system:

 The manipulator assemblies supported by the counterbalancing systems 
must be secured.

 Work on the counterbalancing systems must only be carried out by quali-
fied personnel.

Before work is commenced on live parts of the robot sys-
tem, the main switch must be turned off and secured 

against being switched on again. The system must then be checked to en-
sure that it is deenergized.
It is not sufficient, before commencing work on live parts, to execute an 
EMERGENCY STOP or a safety stop, or to switch off the drives, as this does 
not disconnect the robot system from the mains power supply in the case of 
the drives of the new generation. Parts remain energized. Death or severe 
injuries may result. 
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Hazardous 

substances

The following safety measures must be carried out when handling hazardous 
substances:

 Avoid prolonged and repeated intensive contact with the skin.

 Avoid breathing in oil spray or vapors.

 Clean skin and apply skin cream.

3.8.8 Decommissioning, storage and disposal

The industrial robot must be decommissioned, stored and disposed of in ac-
cordance with the applicable national laws, regulations and standards.

3.8.9 Safety measures for “single point of control”

Overview If certain components in the industrial robot are operated, safety measures 
must be taken to ensure complete implementation of the principle of “single 
point of control” (SPOC).

Components:

 Submit interpreter

 PLC

 OPC Server

 Remote control tools

 Tools for configuration of bus systems with online functionality

 KUKA.RobotSensorInterface

Since only the system integrator knows the safe states of actuators in the pe-
riphery of the robot controller, it is his task to set these actuators to a safe 
state, e.g. in the event of an EMERGENCY STOP.

T1, T2, CRR In the test modes T1, T2 and CRR, the components referred to above may 
only access the industrial robot if the following signals have the following 
states:

Submit inter-

preter, PLC

If motions, (e.g. drives or grippers) are controlled with the submit interpreter or 
the PLC via the I/O system, and if they are not safeguarded by other means, 
then this control will take effect even in T1, T2 and CRR modes or while an 
EMERGENCY STOP is active.

If variables that affect the robot motion (e.g. override) are modified with the 
submit interpreter or the PLC, this takes effect even in T1, T2 and CRR modes 
or while an EMERGENCY STOP is active.

Safety measures:

 In T1, T2 and CRR, the system variable $OV_PRO must not be written to 
by the submit interpreter or the PLC.

To ensure safe use of our products, we recommend that our custom-
ers regularly request up-to-date safety data sheets from the manufac-
turers of hazardous substances.

The implementation of additional safety measures may be required. 
This must be clarified for each specific application; this is the respon-
sibility of the system integrator, programmer or user of the system.

Signal State required for SPOC

$USER_SAF TRUE

$SPOC_MOTION_ENABLE TRUE
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 Do not modify safety-relevant signals and variables (e.g. operating mode, 
EMERGENCY STOP, safety gate contact) via the submit interpreter or 
PLC.

If modifications are nonetheless required, all safety-relevant signals and 
variables must be linked in such a way that they cannot be set to a dan-
gerous state by the submit interpreter or PLC.

OPC server, 

remote control 

tools

These components can be used with write access to modify programs, outputs 
or other parameters of the robot controller, without this being noticed by any 
persons located inside the system.

Safety measures:

 KUKA stipulates that these components are to be used exclusively for di-
agnosis and visualization. 

Programs, outputs or other parameters of the robot controller must not be 
modified using these components.

 If these components are used, outputs that could cause a hazard must be 
determined in a risk assessment. These outputs must be designed in such 
a way that they cannot be set without being enabled. This can be done us-
ing an external enabling device, for example.

Tools for configu-

ration of bus 

systems

If these components have an online functionality, they can be used with write 
access to modify programs, outputs or other parameters of the robot control-
ler, without this being noticed by any persons located inside the system.

 WorkVisual from KUKA

 Tools from other manufacturers

Safety measures:

 In the test modes, programs, outputs or other parameters of the robot con-
troller must not be modified using these components.

3.9 Applied norms and regulations

Name Definition Edition

2006/42/EC Machinery Directive:

Directive 2006/42/EC of the European Parliament and of 
the Council of 17 May 2006 on machinery, and amending 
Directive 95/16/EC (recast)

2006

2004/108/EC EMC Directive:

Directive 2004/108/EC of the European Parliament and of 
the Council of 15 December 2004 on the approximation of 
the laws of the Member States relating to electromagnetic 
compatibility and repealing Directive 89/336/EEC

2004

97/23/EC Pressure Equipment Directive:

Directive 97/23/EC of the European Parliament and of the 
Council of 29 May 1997 on the approximation of the laws 
of the Member States concerning pressure equipment

(Only applicable for robots with hydropneumatic counter-
balancing system.)

1997

EN ISO 13850 Safety of machinery:

Emergency stop - Principles for design

2008

EN ISO 13849-1 Safety of machinery:

Safety-related parts of control systems - Part 1: General 
principles of design

2008
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EN ISO 13849-2 Safety of machinery:

Safety-related parts of control systems - Part 2: Validation

2008

EN ISO 12100 Safety of machinery:

General principles of design, risk assessment and risk 
reduction

2010

EN ISO 10218-1 Industrial robots: 

Safety

2011

EN 614-1 Safety of machinery:

Ergonomic design principles - Part 1: Terms and general 
principles

2006

EN 61000-6-2 Electromagnetic compatibility (EMC):

Part 6-2: Generic standards; Immunity for industrial envi-
ronments

2005

EN 61000-6-4 Electromagnetic compatibility (EMC):

Part 6-4: Generic standards; Emission standard for indus-
trial environments

2007

EN 60204-1 Safety of machinery:

Electrical equipment of machines - Part 1: General 
requirements

2006

Name Definition Edition
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4 Operation

4.1 KUKA smartPAD teach pendant

4.1.1 Front view

Function The smartPAD is the teach pendant for the industrial robot. The smartPAD has 
all the operator control and display functions required for operating and pro-
gramming the industrial robot.

The smartPAD has a touch screen: the smartHMI can be operated with a fin-
ger or stylus. An external mouse or external keyboard is not necessary.

Overview

The general term “KCP” (KUKA Control Panel) is often used in this 
documentation for the smartPAD.

Fig. 4-1: KUKA smartPAD, front view
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Item Description

1 Button for disconnecting the smartPAD

 (>>> 4.1.3 "Disconnecting and connecting the smartPAD" 
Page 46)

2 Keyswitch for calling the connection manager. The switch can only 
be turned if the key is inserted.

The operating mode can be changed by using the connection man-
ager.

 (>>> 4.10 "Changing operating mode" Page 59)

3 EMERGENCY STOP button. Stops the robot in hazardous situa-
tions. The EMERGENCY STOP button locks itself in place when it 
is pressed.

4 Space Mouse: For moving the robot manually.

 (>>> 4.12 "Jogging the robot" Page 61)

5 Jog keys: For moving the robot manually.

 (>>> 4.12 "Jogging the robot" Page 61)

6 Key for setting the program override

7 Key for setting the jog override

8 Main menu key: Shows the menu items on the smartHMI

 (>>> 4.4 "Calling the main menu" Page 50)

9 Status keys. The status keys are used primarily for setting param-
eters in technology packages. Their exact function depends on the 
technology packages installed.

10 Start key: The Start key is used to start a program.

11 Start backwards key: The Start backwards key is used to start a 
program backwards. The program is executed step by step.

12 STOP key: The STOP key is used to stop a program that is run-
ning.

13 Keyboard key

Displays the keyboard. It is generally not necessary to press this 
key to display the keyboard, as the smartHMI detects when key-
board input is required and displays the keyboard automatically.

 (>>> 4.2.3 "Keypad" Page 50)
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4.1.2 Rear view

Overview

Description

Fig. 4-2: KUKA smartPAD, rear view

1 Enabling switch 4 USB connection

2 Start key (green) 5 Enabling switch

3 Enabling switch 6 Identification plate

Element Description

Identification 
plate

Identification plate

Start key The Start key is used to start a program.

Enabling 
switch

The enabling switch has 3 positions:

 Not pressed

 Center position

 Panic position

The enabling switch must be held in the center position 
in operating modes T1 and T2 in order to be able to jog 
the manipulator.

In the operating modes Automatic and Automatic Exter-
nal, the enabling switch has no function.

USB connec-
tion

The USB connection is used, for example, for archiving 
and restoring data.

Only for FAT32-formatted USB sticks.
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4.1.3 Disconnecting and connecting the smartPAD

Description The smartPAD can be disconnected while the robot controller is running.

Procedure Disconnection:

1. Press the disconnect button on the smartPAD.

A message and a counter are displayed on the smartHMI. The counter 
runs for 30 s. During this time, the smartPAD can be disconnected from 
the robot controller.

2. Disconnect the smartPAD from the robot controller.

If the counter expires without the smartPAD having been disconnected, 
this has no effect. The disconnect button can be pressed again at any time 
to display the counter again.

Connection:

 Connect the smartPAD to the robot controller.

A smartPAD can be connected at any time. Precondition: Same smartPAD 
variant as the disconnected device. The EMERGENCY STOP and enabling 
switches are operational again 30 s after connection. The smartHMI is auto-
matically displayed again. (This may take longer than 30 s.)

The connected smartPAD assumes the current operating mode of the robot 
controller.

If the smartPAD is disconnected, the system can no lon-
ger be switched off by means of the EMERGENCY 

STOP device on the smartPAD. For this reason, an external EMERGENCY 
STOP must be connected to the robot controller.
The user is responsible for ensuring that the smartPAD is immediately re-
moved from the system when it has been disconnected. The smartPAD must 
be stored out of sight and reach of personnel working on the industrial robot. 
This prevents operational and non-operational EMERGENCY STOP devices 
from becoming interchanged.
Failure to observe these precautions may result in death to persons, severe 
injuries or considerable damage to property.

If the smartPAD is disconnected without the counter running, this trig-
gers an EMERGENCY STOP. The EMERGENCY STOP can only be 
canceled by plugging the smartPAD back in.

The current operating mode is not, in all cases, the same as that be-
fore the smartPAD was disconnected: if the robot controller is part of 
a RoboTeam, the operating mode may have been changed after dis-

connection, e.g. by the master.

The user connecting a smartPAD to the robot controller 
must subsequently stay with the smartPAD for at least 

30 s, i.e. until the EMERGENCY STOP and enabling switches are operation-
al once again. This prevents another user from trying to activate a non-oper-
ational EMERGENCY STOP in an emergency situation, for example.
Failure to observe this may result in death to persons, injuries or damage to 
property.
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4.2 KUKA smartHMI user interface

Fig. 4-3: KUKA smartHMI user interface

Item Description

1 Status bar (>>> 4.2.1 "Status bar" Page 48)

2 Message counter

The message counter indicates how many messages of each mes-
sage type are active. Touching the message counter enlarges the 
display.

3 Message window

By default, only the last message is displayed. Touching the mes-
sage window expands it so that all active messages are displayed.

An acknowledgeable message can be acknowledged with OK. All 
acknowledgeable messages can be acknowledged at once with 
All OK.

4 Space Mouse status indicator

This indicator shows the current coordinate system for jogging with 
the Space Mouse. Touching the indicator displays all coordinate 
systems, allowing a different one to be selected.
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4.2.1 Status bar

The status bar indicates the status of certain central settings of the industrial 
robot. In most cases, touching the display opens a window in which the set-
tings can be modified.

Overview

5 Space Mouse alignment indicator

Touching this indicator opens a window in which the current align-
ment of the Space Mouse is indicated and can be changed.

 (>>> 4.12.8 "Defining the alignment of the Space Mouse" 
Page 69)

6 Jog keys status indicator

This indicator shows the current coordinate system for jogging with 
the jog keys. Touching the indicator displays all coordinate sys-
tems, allowing a different one to be selected.

7 Jog key labels

If axis-specific jogging is selected, the axis numbers are displayed 
here (A1, A2, etc.). If Cartesian jogging is selected, the coordinate 
system axes are displayed here (X, Y, Z, A, B, C).

Touching the label causes the selected kinematics group to be dis-
played.

8 Program override

 (>>> 6.5.4 "Setting the program override (POV)" Page 147)

9 Jog override

 (>>> 4.12.3 "Setting the jog override (HOV)" Page 66)

10 Button bar. The buttons change dynamically and always refer to 
the window that is currently active in the smartHMI.

At the right-hand end is the Edit button. This can be used to call 
numerous commands relating to the Navigator.

11 Clock

The clock displays the system time. Touching the clock displays 
the system time in digital format, together with the current date.

12 WorkVisual icon

If no project can be opened, the icon has a small red X in the bot-
tom left-hand corner. This is the case, for example, if the files be-
longing to the project are missing. In such a case, the system is 
only partially available, e.g. the safety configuration cannot be 
opened.

Item Description

Fig. 4-4: KUKA smartHMI status bar
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4.2.2 “Submit interpreter” status indicator

Item Description

1 Main menu key. Shows the menu items on the smartHMI.

 (>>> 4.4 "Calling the main menu" Page 50)

2 Robot name. The robot name can be changed.

 (>>> 4.15.12 "Displaying/editing robot data" Page 83)

3 If a program has been selected, the name is displayed here.

4 Submit interpreter status indicator

 (>>> 4.2.2 "“Submit interpreter” status indicator" Page 49)

5 Drives status indicator. The drives can be switched on or off here.

 (>>> 6.5.5 "Switching drives on/off" Page 147)

6 Robot interpreter status indicator. Programs can be reset or can-
celed here.

 (>>> 6.5.6 "Robot interpreter status indicator" Page 148)

 (>>> 6.2.1 "Selecting and deselecting a program" Page 142)

 (>>> 6.5.11 "Resetting a program" Page 150)

7 Current operating mode

 (>>> 4.10 "Changing operating mode" Page 59)

8 POV/HOV status indicator. Indicates the current program override 
and the current jog override.

 (>>> 6.5.4 "Setting the program override (POV)" Page 147)

 (>>> 4.12.3 "Setting the jog override (HOV)" Page 66)

9 Program run mode status indicator. Indicates the current program 
run mode.

 (>>> 6.5.2 "Program run modes" Page 146)

10 Tool/base status indicator. Indicates the current tool and base.

 (>>> 4.12.4 "Selecting the tool and base" Page 66)

11 Incremental jogging status indicator.

 (>>> 4.12.10 "Incremental jogging" Page 71)

Icon Color Description

Yellow Submit interpreter is selected. The block 
pointer is situated on the first line of the se-
lected SUB program.

Green Submit interpreter is running.

Red Submit interpreter has been stopped.

Gray Submit interpreter is deselected.
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4.2.3 Keypad

The smartPAD has a touch screen: the smartHMI can be operated with a fin-
ger or stylus.

There is a keypad on the smartHMI for entering letters and numbers. The sm-
artHMI detects when the entry of letters or numbers is required and automati-
cally displays the keypad.

The keypad only ever displays the characters that are required. If, for example, 
a box is edited in which only numbers can be entered, then only numbers are 
displayed and not letters.

4.3 Switching on the robot controller and starting the KSS

Procedure  Turn the main switch on the robot controller to ON.

The operating system and the KSS start automatically.

If the KSS does not start automatically, e.g. because the Startup function has 
been disabled, execute the file StartKRC.exe in the directory C:\KRC.

If the robot controller is logged onto the network, the start may take longer.

4.4 Calling the main menu

Procedure  Press “Main menu” key on the KCP. The Main menu window is opened. 

The display is always the same as that which was in the window before it 
was last closed. 

Description Properties of the Main Menu window:

 The main menu is displayed in the left-hand column.

 Touching a menu item that contains an arrow opens the corresponding 
submenu (e.g. Configure).

Depending on how many nested submenus are open, the Main Menu col-
umn may no longer be visible, with only the submenus remaining visible.

 The arrow key in the top right-hand corner closes the most recently 
opened submenu.

 The Home key in the top right-hand corner closes all open submenus.

Fig. 4-5: Example keypad
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 The most recently selected menu items are displayed in the bottom sec-
tion (maximum 6). 

This makes it possible to select these menu items again directly without 
first having to close other submenus that might be open.

 The white cross on the left-hand side closes the window.

4.5 Exiting or restarting KSS

Precondition  For certain options: “Expert” user group

Procedure 1. Select the menu item Shutdown in the main menu.

2. Select the desired options.

3. Press Shut down control PC or Reboot control PC. 

4. Confirm the request for confirmation with Yes. The System Software is ter-
minated and restarted in accordance with the selected option.

After the restart, the following message is displayed:

 Cold start of controller

 Or, if Reload files has been selected: Initial cold start of controller

Fig. 4-6: Example: Configuration submenu is open.

If, on shutting down, the option Reboot control PC is se-
lected, the main switch on the robot controller must not 

be pressed until the reboot has been completed. System files may otherwise 
be destroyed.
If this option was not selected on shutting down, the main switch can be 
pressed once the controller has shut down.
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Description

Fig. 4-7: Shutdown window

Option Description

Default settings for switching off the controller via main switch

Cold start After a power failure, the robot controller starts 
with a cold start. 

(A power failure and start are generally triggered 
by switching the main switch on the robot con-
troller off and on.)

Can only be selected in the “Expert” user group.

 (>>>  "Start types" Page 54)

Hibernate After a power failure, the robot controller starts 
with Hibernate.

Can only be selected in the “Expert” user group.

 (>>>  "Start types" Page 54)

Power-off delay time Wait time before the robot controller is shut 
down. This ensures that the system does not 
immediately shut down, for example, in the event 
of very brief power failures, but bridges the 
power failure.

Can only be changed in the “Expert” user group.

Settings valid next time the system is switched off using the main 
switch

These settings only apply to the next start. 

Force cold start Activated: The next start is a cold start. 

Only available if Hibernate has been selected.
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Reload files Activated: The next start is an initial cold start. 

This option must be selected in the following 
cases:

 If XML files have been changed directly, i.e. 
the user has opened the file and modified it. 

(Any other changes to XML files, e.g. if the ro-
bot controller modifies them in the back-
ground, are irrelevant.)

 If hardware components are to be exchanged 
after shutdown.

Can only be selected in the “Expert” user group. 
Only available if Cold start or Force cold start 
has been selected.

Depending on the hardware, the initial cold start 
takes approx. 30 to 150 seconds longer than a 
normal cold start. 

Power-off delay time Activated: The wait time is adhered to the next 
time the system is shut down.

Deactivated: The wait time is ignored the next 
time the system is shut down.

Instant actions

Shut down control 
PC

Only available in operating modes T1 and T2.

The robot controller is shut down

Reboot control PC Only available in operating modes T1 and T2.

The robot controller is shut down and then 
restarted.

Drive bus

OFF / ON

Only available in operating modes T1 and T2.

The drive bus can be switched off or on.

Drive bus status indicator:

 Green: Drive bus is on.

 Red: Drive bus is off.

 Gray: Status of the drive bus is unknown.

Option Description
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Start types

4.6 Switching the robot controller off

Procedure  Turn the main switch on the robot controller to OFF.

The robot controller automatically backs up data.

4.7 Setting the user interface language

Procedure 1. In the main menu, select Configuration > Miscellaneous > Language.

2. Select the desired language. Confirm with OK.

Description The following languages are available:

Start type Description

Cold start After a cold start the robot controller displays the Navi-
gator. No program is selected. The robot controller is 
reinitialized, e.g. all user outputs are set to FALSE.

Note: If XML files have been changed directly, i.e. the 
user has opened the file and modified it, these changes 
are taken into consideration in the case of a cold start 
with Reload files. This cold start is called an “initial 
cold start”.

In the case of a cold start without Reload files, these 
changes are not taken into consideration.

Hibernate After a start with Hibernate, the previously selected 
robot program can be resumed. The state of the kernel 
system: programs, block pointer, variable contents and 
outputs, is completely restored.

Additionally, all programs that were open parallel to the 
robot controller are reopened and have the same state 
that they had before the system was shut down. The 
last state of Windows is also restored.

The main switch on the robot controller must not be op-
erated if the KSS has been exited with the option Reboot 

control PC and the reboot has not yet been completed. System files may 
otherwise be destroyed.

Chinese (simplified) Polish

Danish Portuguese

German Romanian

English Russian

Finnish Swedish

French Slovak

Greek Slovenian

Italian Spanish

Japanese Czech

Korean Turkish

Dutch Hungarian
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4.8 Online documentation and online help

4.8.1 Calling online documentation

Description The documentation of the KUKA System Software can be displayed on the ro-
bot controller. Certain technology packages also have documentation that can 
be displayed on the robot controller.

Procedure 1. In the main menu, select Help > Documentation. Then select either Sys-
tem Software or the menu item for the technology package.

The KUKA Embedded Information Service window is opened. The table 
of contents of the documentation is displayed.

2. Touch a chapter. The topics it contains are displayed.

3. Touch a topic. The description is displayed.

Example

4.8.2 Calling online help

Description The online help refers to the messages. The online help can be called in the 
following ways:

 Call the help for a message that is currently displayed in the message win-
dow.

Fig. 4-8: Online documentation – Example from the KUKA System Soft-
ware

Item Description

1, 2 Displays the table of contents.

3 Displays the previous topic in the table of contents.

4 Displays the next topic.
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 Display an overview of the possible messages and call the help for a mes-
sage there.

Procedure Calling the online help for a message in the message window

Most messages contain a button with a question mark. Online help is available 
for these messages.

1. Touch the button containing the question mark. The KUKA Embedded In-
formation Service – Message page window is opened. 

The window contains a variety of information about the message.  
(>>> Fig. 4-9 )

2. The window often also contains information about the causes of the mes-
sage and the corresponding solutions. Details can be displayed:

a. Touch the magnifying glass button next to the cause. The detail page 
is opened.  (>>> Fig. 4-10 )

b. Open the descriptions of the cause and solution.

c. If the message has several possible causes: the magnifying glass but-
tons with arrows can be used to jump to the previous or next detail 
page.

Procedure Displaying an overview of the messages and calling the online help for 
a message there

1. In the main menu, select Help > Messages. Then select either System 
Software or the menu item for the technology package.

The KUKA Embedded Information Service – Index page window is 
opened. The messages are sorted by module (“module” refers here to a 
subsection of the software).

2. Touch an entry. The messages of this module are displayed.

3. Touch a message. The message page is displayed. 

The window contains a variety of information about the message.  
(>>> Fig. 4-9 )

4. The window often also contains information about the causes of the mes-
sage and the corresponding solutions. Details can be displayed:

a. Touch the magnifying glass button next to the cause. The detail page 
is opened.  (>>> Fig. 4-10 )

b. Open the descriptions of the cause and solution.

c. If the message has several possible causes: the magnifying glass but-
tons with arrows can be used to jump to the previous or next detail 
page.
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Message page

Fig. 4-9: Message page – Example from the KUKA System Software

Item Description

1 Displays the previous page.

2 This button is only active if the other arrow button has been used 
to jump to the previous page. This button can then be used to 
return to the original page.

3 Displays the list with the software modules.

4 Message number and text

5 Information about the message

There may be less information available than in the example.

6 Displays details about this cause/solution.  (>>> Fig. 4-10 )
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Detail page

4.9 Changing user group

Procedure 1. Select Configuration > User group in the main menu. The current user 
group is displayed.

2. Press Default to switch to the default user group. (Default is not available 
if the default user group is already selected.)

Press Login... to switch to a different user group. Select the desired user 
group.

3. If prompted: Enter password and confirm with Log-on.

Description Different functions are available in the KSS, depending on the user group. The 
following user groups are available:

 Operator

User group for the operator. This is the default user group.

 User

User group for the operator. (By default, the user groups “Operator” and 
“User” are defined for the same target group.)

 Expert

User group for the programmer. This user group is protected by means of 
a password.

Fig. 4-10: Detail page – Example from the KUKA System Software
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 Safety recovery

User group for the start-up technician. This user can activate and config-
ure the safety configuration of the robot.

This user group is protected by means of a password.

 Safety maintenance

This user group is only relevant if KUKA.SafeOperation or KUKA.Saf-
eRangeMonitoring is used. The user group is protected by means of a 
password.

 Administrator

The range of functions is the same as that for the user group “Expert”. It is 
additionally possible, in this user group, to integrate plug-ins into the robot 
controller.

This user group is protected by means of a password.

The default password is “kuka”. 

When the system is booted, the default user group is selected.

If the mode is switched to AUT or AUT EXT, the robot controller switches to 
the default user group for safety reasons. If a different user group is desired, 
this must be selected subsequently.

If no actions are carried out in the user interface within a certain period of time, 
the robot controller switches to the default user group for safety reasons. The 
default setting is 300 s.

4.10 Changing operating mode

Precondition  The robot controller is not executing a program.

 Key for the switch for calling the connection manager

Procedure 1. On the smartPAD, turn the switch for the connection manager. The con-
nection manager is displayed.

2. Select the operating mode.

3. Return the switch for the connection manager to its original position.

The selected operating mode is displayed in the status bar of the smart-
PAD.

Do not change the operating mode while a program is running. If the 
operating mode is changed during program execution, the industrial 
robot is stopped with a safety stop 2.

Operat-
ing mode

Use Velocities

T1
For test operation, pro-
gramming and teach-
ing

 Program verification:

Programmed velocity, maxi-
mum 250 mm/s

 Jog mode:

Jog velocity, maximum 250 mm/
s

T2 For test operation

 Program verification:

Programmed velocity

 Jog mode: Not possible

AUT
For industrial robots 
without higher-level 
controllers

 Program mode:

Programmed velocity

 Jog mode: Not possible
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4.11 Coordinate systems

Overview The following Cartesian coordinate systems are defined in the robot controller:

 WORLD

 ROBROOT

 BASE

 TOOL

Description WORLD

The WORLD coordinate system is a permanently defined Cartesian coordi-
nate system. It is the root coordinate system for the ROBROOT and BASE co-
ordinate systems.

By default, the WORLD coordinate system is located at the robot base.

ROBROOT

AUT EXT
For industrial robots 
with higher-level con-
trollers, e.g. PLC

 Program mode:

Programmed velocity

 Jog mode: Not possible

CRR

CRR is only available if KUKA.SafeOperation or KUKA.Saf-
eRangeMonitoring is used. 

If the robot has violated a monitoring function and been 
stopped by the safety controller, it can only be moved out of 
the violated area in CRR mode.

Speeds similar to T1

Operat-
ing mode

Use Velocities

Fig. 4-11: Overview of coordinate systems
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The ROBROOT coordinate system is a Cartesian coordinate system, which is 
always located at the robot base. It defines the position of the robot relative to 
the WORLD coordinate system.

By default, the ROBROOT coordinate system is identical to the WORLD coor-
dinate system. $ROBROOT allows the definition of an offset of the robot rela-
tive to the WORLD coordinate system.

BASE

The BASE coordinate system is a Cartesian coordinate system that defines 
the position of the workpiece. It is relative to the WORLD coordinate system.

By default, the BASE coordinate system is identical to the WORLD coordinate 
system. It is offset to the workpiece by the user.

 (>>> 5.7.2 "Base calibration" Page 114)

TOOL

The TOOL coordinate system is a Cartesian coordinate system which is locat-
ed at the tool center point.

By default, the origin of the TOOL coordinate system is located at the flange 
center point. (In this case it is called the FLANGE coordinate system.) The 
TOOL coordinate system is offset to the tool center point by the user.

 (>>> 5.7.1 "Tool calibration" Page 107)

Angles of rotation of the robot coordinate systems

4.12 Jogging the robot

Description There are 2 ways of jogging the robot:

 Cartesian jogging

The TCP is jogged in the positive or negative direction along the axes of a 
coordinate system.

 Axis-specific jogging

Each axis can be moved individually in a positive and negative direction.

Angle Rotation about axis

Angle A Rotation about the Z axis

Angle B Rotation about the Y axis

Angle C Rotation about the X axis
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There are 2 operator control elements that can be used for jogging the robot:

 Jog keys

 Space Mouse

Overview

4.12.1 “Jog options” window

Description All parameters for jogging the robot can be set in the Jogging Options win-
dow.

Procedure Open the Jogging Options window:

1. Open a status indicator on the smartHMI, e.g. the POV status indicator.

(Not possible for the Submit interpreter, Drives and Robot interpreter 
status indicators.)

A window opens.

2. Press Options. The Jogging Options window is opened.

For most parameters, it is not necessary to open the Jogging Options win-
dow. They can be set directly via the smartHMI status indicators.

Fig. 4-12: Axis-specific jogging

Cartesian jogging Axis-specific jogging

Jog keys  (>>> 4.12.6 "Cartesian jog-
ging with the jog keys" 
Page 67)

 (>>> 4.12.5 "Axis-specific 
jogging with the jog keys" 
Page 67)

Space 
Mouse

 (>>> 4.12.9 "Cartesian jog-
ging with the Space Mouse" 
Page 70)

Axis-specific jogging with 
the Space Mouse is possi-
ble, but is not described 
here.
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4.12.1.1 “General” tab

Description

4.12.1.2 “Keys” tab

Fig. 4-13: General tab

Item Description

1 Set program override

 (>>> 6.5.4 "Setting the program override (POV)" Page 147)

2 Set jog override

 (>>> 4.12.3 "Setting the jog override (HOV)" Page 66)

3 Select the program run mode

 (>>> 6.5.2 "Program run modes" Page 146)

Fig. 4-14: Keys tab
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Description

4.12.1.3 “Mouse” tab

Description

Item Description

1 Activate jog mode “Jog keys”

 (>>> 4.12.2 "Activating the jog mode" Page 66)

2 Select a kinematics group. The kinematics group defines the axes 
to which the jog keys refer.

Default: Robot axes (= A1 to A6)

Depending on the system configuration, other kinematics groups 
may be available.

 (>>> 4.13 "Jogging external axes" Page 72)

3 Select the coordinate system for jogging with the jog keys

4 Incremental jogging

 (>>> 4.12.10 "Incremental jogging" Page 71)

Fig. 4-15: Mouse tab

Item Description

1 Activate jog mode “Space Mouse”

 (>>> 4.12.2 "Activating the jog mode" Page 66)

2 Configure the Space Mouse

 (>>> 4.12.7 "Configuring the Space Mouse" Page 67)

3 Select the coordinate system for jogging with the Space Mouse
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4.12.1.4 “KCP pos.” tab

Description

4.12.1.5 “Cur. tool/base” tab

Description

Fig. 4-16: Kcp Pos. tab

Item Description

1  (>>> 4.12.8 "Defining the alignment of the Space Mouse" 
Page 69)

Fig. 4-17: Act. Tool/Base tab

Item Description

1 The current tool is displayed here. A different tool can be selected.

 (>>> 4.12.4 "Selecting the tool and base" Page 66)

The display Unknown [?] means that no tool has yet been calibrat-
ed.
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4.12.2 Activating the jog mode

Procedure 1. Open the Jogging Options window.

 (>>> 4.12.1 "“Jog options” window" Page 62)

2. To activate the jog mode “Jog keys”:

On the Keys tab, activate the Activate Keys check box.

To activate the jog mode “Space Mouse”:

On the Mouse tab, activate the Activate Mouse check box.

Description Both jog modes “Jog keys” and “Space Mouse” can be activated simultane-
ously. If the robot is jogged using the keys, the Space Mouse is disabled until 
the robot comes to a standstill. If the Space Mouse is actuated, the keys are 
disabled.

4.12.3 Setting the jog override (HOV)

Description Jog override determines the velocity of the robot during jogging. The velocity 
actually achieved by the robot with a jog override setting of 100% depends on 
various factors, including the robot type. The velocity cannot exceed 250 mm/
s however.

Procedure 1. Touch the POV/HOV status indicator. The Overrides window is opened.

2. Set the desired jog override. It can be set using either the plus/minus keys 
or by means of the slide controller.

 Plus/minus keys: The value can be set to 100%, 75%, 50%, 30%, 
10%, 3%, 1%

 Slide controller: The override can be adjusted in 1% steps.

3. Touch the POV/HOV status indicator again. (Or touch the area outside the 
window.) 

The window closes and the selected override value is applied.

Alternative 

procedure

Alternatively, the override can be set using the plus/minus key on the right-
hand side of the KCP.

The value can be set to 100%, 75%, 50%, 30%, 10%, 3%, 1%.

4.12.4 Selecting the tool and base

Description A maximum of 16 TOOL and 32 BASE coordinate systems can be saved in 
the robot controller. One tool (TOOL coordinate system) and one base (BASE 
coordinate system) must be selected for Cartesian jogging.

2 The current base is displayed here. A different base can be select-
ed.

 (>>> 4.12.4 "Selecting the tool and base" Page 66)

The display Unknown [?] means that no base has yet been cali-
brated.

3 Select the interpolation mode:

 Flange: The tool is mounted on the mounting flange.

 ext. Tool: The tool is a fixed tool.

Item Description

The Jog options window can be opened via Options in the Over-
rides window.
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Procedure 1. Touch the Tool/base status indicator. The Act. Tool/Base window is 
opened.

2. Select the desired tool and base.

3. The window closes and the selection is applied.

4.12.5 Axis-specific jogging with the jog keys

Precondition  The jog mode “Jog keys” is active.

 Operating mode T1

Procedure 1. Select Axes as the coordinate system for the jog keys.

2. Set jog override.

3. Hold down the enabling switch.

Axes A1 to A6 are displayed next to the jog keys.

4. Press the Plus or Minus jog key to move an axis in the positive or negative 
direction.

4.12.6 Cartesian jogging with the jog keys

Precondition  The jog mode “Jog keys” is active.

 Operating mode T1

 Tool and base have been selected.

 (>>> 4.12.4 "Selecting the tool and base" Page 66)

Procedure 1. Select World, Base or Tool as the coordinate system for the jog keys.

2. Set jog override.

3. Hold down the enabling switch.

The following designations are displayed next to the jog keys:

 X, Y, Z: for the linear motions along the axes of the selected coordinate 
system

 A, B, C: for the rotational motions about the axes of the selected coor-
dinate system

4. Press the Plus or Minus jog key to move the robot in the positive or nega-
tive direction.

4.12.7 Configuring the Space Mouse

Procedure 1. Open the Jogging Options window and select the Mouse tab.

 (>>> 4.12.1 "“Jog options” window" Page 62)

2. Mouse Settings group:

 Dominant check box: 

Activate or deactivate dominant mode as desired.

 6D/XYZ/ABC option box: 

Select whether the TCP is to be moved using translational motions, ro-
tational motions, or both.

The position of the robot during jogging can be displayed: select Dis-
play > Actual position in the main menu.

The position of the robot during jogging can be displayed: select Dis-
play > Actual position in the main menu.
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3. Close the Jogging Options window.

Description

Dominant check box:

Depending on the dominant mode, the Space Mouse can be used to move just 
one axis or several axes simultaneously.

Fig. 4-18: Mouse settings

Check box Description

Active Dominant mode is activated. Only the coordinate axis 
with the greatest deflection of the Space Mouse is 
moved.

Inactive Dominant mode is deactivated. Depending on the axis 
selection, either 3 or 6 axes can be moved simultane-
ously.

Option Description

6D The robot can be moved by pulling, pushing, rotating or 
tilting the Space Mouse.

The following motions are possible with Cartesian jog-
ging:

 Translational motions in the X, Y and Z directions

 Rotational motions about the X, Y and Z axes

XYZ The robot can only be moved by pulling or pushing the 
Space Mouse.

The following motions are possible with Cartesian jog-
ging:

 Translational motions in the X, Y and Z directions

ABC The robot can only be moved by rotating or tilting the 
Space Mouse.

The following motions are possible with Cartesian jog-
ging:

 Rotational motions about the X, Y and Z axes
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4.12.8 Defining the alignment of the Space Mouse

Description The functioning of the Space Mouse can be adapted to the location of the user 
so that the motion direction of the TCP corresponds to the deflection of the 
Space Mouse.

The location of the user is specified in degrees. The reference point for the 
specification in degrees is the junction box on the base frame. The position of 
the robot arm or axes is irrelevant.

Default setting: 0°. This corresponds to a user standing opposite the junction 
box.

Fig. 4-19: Pushing and pulling the Space Mouse

Fig. 4-20: Rotating and tilting the Space Mouse
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Precondition  Operating mode T1

Procedure 1. Open the Jog options window and select the KCP pos. tab.

2. Drag the KCP to the position corresponding to the location of the user (in 
45° steps).

3. Close the Jog options window.

4.12.9 Cartesian jogging with the Space Mouse

Precondition  The jog mode “Space Mouse” is active.

 Operating mode T1

 Tool and base have been selected.

 (>>> 4.12.4 "Selecting the tool and base" Page 66)

 The Space Mouse is configured.

 (>>> 4.12.7 "Configuring the Space Mouse" Page 67)

Fig. 4-21:  Space Mouse: 0° and 270°

Fig. 4-22: Defining the alignment of the Space Mouse

Switching to Automatic External mode automatically resets the align-
ment of the Space Mouse to 0°.
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 The alignment of the Space Mouse has been defined.

 (>>> 4.12.8 "Defining the alignment of the Space Mouse" Page 69)

Procedure 1. Select World, Base or Tool as the coordinate system for the 
Space Mouse.

2. Set jog override.

3. Hold down the enabling switch.

4. Move the robot in the desired direction using the Space Mouse.

4.12.10 Incremental jogging

Description Incremental jogging makes it possible to move the robot a defined distance, 
e.g. 10 mm or 3°. The robot then stops by itself.

Incremental jogging can be activated for jogging with the jog keys. Incremental 
jogging is not possible in the case of jogging with the Space Mouse.

Areas of application:

 Positioning of equidistant points

 Moving a defined distance away from a position, e.g. in the event of a fault

 Mastering with the dial gauge

The following options are available:

Increments in mm:

 Valid for Cartesian jogging in the X, Y or Z direction.

Increments in degrees:

 Valid for Cartesian jogging in the A, B or C direction.

 Valid for axis-specific jogging.

Precondition  The jog mode “Jog keys” is active.

 Operating mode T1

Procedure 1. Select the size of the increment in the status bar.

2. Jog the robot using the jog keys. Jogging can be Cartesian or axis-specif-
ic.

Once the set increment has been reached, the robot stops.

The position of the robot during jogging can be displayed: select Dis-
play > Actual position in the main menu.

Setting Description

Continuous Incremental jogging is deactivated.

100 mm / 10° 1 increment = 100 mm or 10°

10 mm / 3° 1 increment = 10 mm or 3°

1 mm / 1° 1 increment = 1 mm or 1°

0.1 mm / 0.005° 1 increment = 0.1 mm or 0.005°

If the robot motion is interrupted, e.g. by releasing the enabling 
switch, the interrupted increment is not resumed with the next motion; 
a new increment is started instead.
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4.13 Jogging external axes

External axes cannot be moved using the Space Mouse. If “Space Mouse” 
mode is selected, only the robot can be jogged with the Space Mouse. The ex-
ternal axes, on the other hand, must be jogged using the jog keys.

Precondition  The jog mode “Jog keys” is active.

 Operating mode T1

Procedure 1. Select the desired kinematics group, e.g. External axes, on the Keys tab 
in the Jog options window.

The type and number of kinematics groups available depend on the sys-
tem configuration.

2. Set jog override.

3. Hold down the enabling switch.

The axes of the selected kinematics group are displayed next to the jog 
keys.

4. Press the Plus or Minus jog key to move an axis in the positive or negative 
direction.

Description Depending on the system configuration, the following kinematics groups may 
be available.

4.14 Bypassing workspace monitoring

Description Workspaces can be configured for a robot. Workspaces serve to protect the 
system.

There are 2 types of workspace:

 The workspace is an exclusion zone.

The robot may only move outside the workspace.

 Only the workspace is a permitted zone.

The robot may not move outside the workspace.

Exactly what reactions occur when the robot violates a workspace depends on 
the configuration. 

One possible reaction, for example, is that the robot stops and an error mes-
sage is generated. The workspace monitoring must be bypassed in such a 
case. The robot can then move back out of the prohibited workspace.

Kinematics group Description

Robot Axes The robot axes can be moved using the jog keys. 
The external axes cannot be jogged.

External Axes All configured external axes (e.g. external axes 
E1 to E5) can be moved using the jog keys.

NAME / 

External Kinematics 
Groupn

The axes of an external kinematics group can be 
moved using the jog keys.

The name is taken from the system variable 
$ETn_NAME (n = number of the external kinemat-
ic system). If $ETn_NAME is empty, the default 
name External Kinematics Groupn is dis-
played.

[User-defined kinemat-
ics group]

The axes of a user-defined kinematics group can 
be moved using the jog keys.

The name corresponds to the name of the user-
defined kinematics group.
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Precondition  User group “Expert”

 Operating mode T1

Procedure 1. In the main menu, select Configuration > Miscellaneous > Workspace 
monitoring > Override.

2. Move the robot manually out of the prohibited workspace.

Once the robot has left the prohibited workspace, the workspace monitor-
ing is automatically active again.

4.15 Monitor functions

4.15.1 Measuring and displaying energy consumption

Description The overall energy consumption of the robot and robot controller can be dis-
played on the smartHMI. A prerequisite for this is that measurement of energy 
consumption is possible for the robot type used. 

The energy consumption of optional robot controller components (e.g. US1, 
US2, etc.) and of other controllers is not taken into consideration. It is always 
the consumption for the last 60 minutes since the most recent cold start that is 
displayed. Furthermore, the user has the option of starting and stopping mea-
surements manually.

Traces can be made for the consumption values. The predefined configuration 
Tracedef_KRC_EnergyCalc is available for this.

The data can also be transferred to a higher-level controller by means of PRO-
FIenergy. PROFIenergy is a component of KR C4 PROFINET for KSS/VSS 
8.3.

There are two ways of starting and stopping measurements:

 In the Energy consumption window  (>>> Fig. 4-23 )

 Via KRL

Precondition  Measurement of energy consumption is possible for the robot type used. 

If not, the boxes in the Energy consumption window are grayed out.

Procedure Starting and stopping a measurement in the Energy consumption window:

1. In the main menu, select Display > Energy consumption. The Energy 
consumption window is opened.

2. If required, activate the check box Refresh.

3. Press Start measuring. A red dot to the right of the top line now indicates 
that a measurement is in progress.

4. To stop the measurement, press Stop measuring. The result is displayed.

Starting and stopping a measurement via KRL:

1. Start the measurement via $ENERGY_MEASURING.ACTIVE = TRUE 
(possible via the KRL program or variable correction function). The mea-
surement starts.

2. In the main menu, select Display > Energy consumption. The Energy 
consumption window is opened. A red dot to the right of the top line indi-
cates the measurement that is in progress.

3. If required, activate the check box Refresh.

4. Stop the measurement by means of $ENERGY_MEASURING.ACTIVE = 
FALSE. 

The Energy consumption window can also be opened independently of the 
measurement. The top line always indicates the result of the active or most re-
cent measurement.
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Measurement 

properties

 A measurement that has been started runs until it is stopped. This is not 
dependent on whether the Energy consumption window is open or 
closed.

 A measurement that has been started via KRL can be stopped via KRL or 
via the Stop measuring button.

 A measurement that has been started by means of Start measuring can 
only be stopped by means of Stop measuring as long as the Energy con-
sumption window remains open. If an attempt is made to stop the mea-
surement via KRL, the robot controller displays the following message: 
Energy measurement cannot currently be stopped.

Once the Energy consumption window has been closed again, the mea-
surement can also be stopped via KRL. This prevents a measurement 
started in the Energy consumption window from permanently blocking 
measurements via KRL.

 It is not possible to start a measurement while a measurement is already 
active. In this case, the robot controller displays the following message: An 
energy measurement is already active.. The active measurement must be 
stopped first.

Energy 

consumption 

window

Fig. 4-23: Energy consumption window

Item Description

1 Results of the measurements started by the user

The last 3 results are displayed. The most recent result is dis-
played in the top line. If a measurement is currently active, this is 
indicated by means of a red dot to the right of the line.

2 Energy consumption for the last 60 minutes since the most recent 
cold start

3 Starts a measurement. 

Start measuring is not available if a measurement is currently 
active.

4 Stops an active measurement. 

How the measurement was started (by means of Start measuring 
or via KRL) is irrelevant.

5  Check box active: While a measurement is being carried out, 
the result display is continually refreshed.

 Check box not active: While a measurement is being carried 
out, the most recently refreshed value is displayed. The result 
is not displayed until the measurement is stopped.
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4.15.2 Displaying the actual position

Procedure 1. In the main menu, select Display > Actual position. The Cartesian actual 
position is displayed.

2. To display the axis-specific actual position, press Axis-specific.

3. To display the Cartesian actual position again, press Cartesian.

Description Actual position, Cartesian:

The current position (X, Y, Z) and orientation (A, B, C) of the TCP are dis-
played. Status and Turn are also displayed.

Actual position, axis-specific:

The current position of axes A1 to A6 is indicated. If external axes are being 
used, the position of the external axes is also displayed.

The actual position can also be displayed while the robot is moving.

4.15.3 Displaying digital inputs/outputs

Procedure 1. In the main menu, select Display > Inputs/outputs > Digital I/O.

2. To display a specific input/output:

 Click on the Go to button. The Go to: box is displayed.

 Enter the number and confirm with the Enter key.

The display jumps to the input/output with this number.

Fig. 4-24: Actual position, axis-specific
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Description

The following buttons are available:

Fig. 4-25: Digital inputs

Fig. 4-26: Digital outputs

Item Description

1 Input/output number

2 Value of the input/output. The icon is red if the input or output is 
TRUE.

3 SIM entry: The input/output is simulated.

SYS entry: The value of the input/output is saved in a system vari-
able. This input/output is write-protected.

4 Name of the input/output

Button Description

-100 Toggles back 100 inputs or outputs in the display.

+100 Toggles forward 100 inputs or outputs in the dis-
play.

Go to The number of the input or output being searched 
for can be entered.
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4.15.4 Displaying analog inputs/outputs

Procedure 1. In the main menu, select Display > Inputs/outputs > Analog I/O.

2. To display a specific input/output:

 Click on the Go to button. The Go to: box is displayed.

 Enter the number and confirm with the Enter key.

The display jumps to the input/output with this number.

The following buttons are available:

4.15.5 Displaying inputs/outputs for Automatic External

Procedure  In the main menu, select Display > Inputs/outputs > Automatic Exter-
nal.

Description

Value Toggles the selected input/output between TRUE 
and FALSE. Precondition: The enabling switch is 
pressed.

This button is not available in AUT EXT mode, 
and is only available for inputs if simulation is ac-
tivated.

Name The name of the selected input or output can be 
changed.

Button Description

Button Description

Go to The number of the input or output being searched 
for can be entered.

Voltage A voltage can be entered for the selected output.

 -10 … 10 V

This button is only available for outputs.

Name The name of the selected input or output can be 
changed.

Fig. 4-27: Automatic External inputs (detail view)
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Columns 4, 5 and 6 are only displayed if Details has been pressed.

The following buttons are available:

4.15.6 Displaying cyclical flags

Procedure 1. In the main menu, select Display > Variable > Cyclical flags. The Cycli-
cal flags window is opened.

2. To display a specific flag:

 Click on the Go to button. The Go to: box is displayed.

 Enter the number and confirm with the Enter key.

The display jumps to the flag with this number.

Fig. 4-28: Automatic External outputs (detail view)

Item Description

1 Number

2 Status

 Gray: inactive (FALSE)

 Red: active (TRUE)

3 Long text name of the input/output

4 Type

 Green: input/output

 Yellow: variable or system variable ($...)

5 Name of the signal or variable

6 Input/output number or channel number

Button Description

Config. Switches to the configuration of the Automatic 
External interface. 

Inputs/Outputs Toggles between the windows for inputs and out-
puts.

Details/Normal Toggles between the Details and Normal views. 
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Description

The following buttons are available:

4.15.7 Displaying flags

Procedure 1. In the main menu, select Display > Variable > Flags. The Flags window 
is opened.

2. To display a specific flag:

 Click on the Go to button. The Go to: box is displayed.

 Enter the number and confirm with the Enter key.

The display jumps to the flag with this number.

Fig. 4-29: Cyclical flags

Item Description

1 Number of the flag

2 Value of the flag. The icon is red if a flag is set.

3 Name of the flag

4 The conditions linked to the setting of a cyclical flag are indicated 
here.

Button Description

-100 Toggles back 100 flags in the display.

+100 Toggles forward 100 flags in the display.

Go to The number of the flag being searched for can be 
entered.

Name The name of the selected flag can be modified.
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Description

The following buttons are available:

4.15.8 Displaying counters

Procedure 1. In the main menu, select Display > Variable > Counter. The Counter 
window is opened.

2. To display a specific counter:

 Click on the Go to button. The Go to: box is displayed.

 Enter the number and confirm with the Enter key.

The display jumps to the counter with this number.

Fig. 4-30: Flags

Item Description

1 Number of the flag

2 Value of the flag. The icon is red if a flag is set.

3 Name of the flag

Button Description

-100 Toggles back 100 flags in the display.

+100 Toggles forward 100 flags in the display.

Go to The number of the flag being searched for can be 
entered.

Value Toggles the selected flag between TRUE and 
FALSE. Precondition: The enabling switch is 
pressed.

This button is not available in AUT EXT mode.

Name The name of the selected flag can be modified.
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Description

The following buttons are available:

4.15.9 Displaying timers

Procedure 1. In the main menu, select Display > Variable > Timer. The Timer window 
is opened.

2. To display a specific timer:

 Click on the Go to button. The Go to: box is displayed.

 Enter the number and confirm with the Enter key.

The display jumps to the timer with this number.

Fig. 4-31: Counter

Item Description

1 Counter number

4 Value of the counter.

5 Name of counter

Button Description

Go to The number of the counter being searched for 
can be entered.

Value A value can be entered for the selected counter.

Name The name of the selected counter can be modi-
fied.
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Description

The following buttons are available:

4.15.10 Displaying calibration data

Procedure 1. In the main menu, select Start-up > Calibrate > Calibration points and 
the desired menu item:

 Tool type

 Base type

 External axis

2. Enter the number of the tool, base or external kinematic system.

The calibration method and the calibration data are displayed.

Fig. 4-32: Timer

Item Description

1 Number of the timer

2 Status of the timer

 If the timer is activated, this is indicated in green.

 If the timer is deactivated, this is indicated in red.

3 State of the timer

 If the value of the timer is > 0, the timer flag is set (red check 
mark).

 If the value of the timer is ≤ 0, no timer flag is set.

4 Value of the timer (unit: ms)

5 Name of timer

Button Description

Go to The number of the timer being searched for can 
be entered.

State Toggles the selected timer between TRUE and 
FALSE. Precondition: The enabling switch is 
pressed.

Value A value can be entered for the selected timer.

Name The name of the selected timer can be modified.
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4.15.11 Displaying information about the robot and robot controller

Procedure  In the main menu, select Help > Info.

Description The information is required, for example, when requesting help from KUKA 
Customer Support.

The tabs contain the following information:

4.15.12 Displaying/editing robot data

Precondition  T1 or T2 operating mode

 No program is selected.

Procedure  In the main menu, select Start-up > Robot data.

Tab Description

Info  Robot controller type

 Robot controller version

 User interface version

 Kernel system version

Robot  Robot name

 Robot type and configuration

 Service life

The operating hours meter is running as long as the 
drives are switched on. Alternatively, the operating 
hours can also be displayed via the variable $ROB-
RUNTIME.

 Number of axes

 List of external axes

 Machine data version

System  Control PC name

 Operating system version

 Storage capacities

Options Additionally installed options and technology packages

Comments Additional comments

Modules Names and versions of important system files

The Export button exports the contents of the Mod-
ules tab to the file C:\KRC\ROBOTER\LOG\FILEVER-
SIONS.TXT.
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Description

The buttons are not available in the user group “User”.

Fig. 4-33: Robot data window

Item Description

1 Serial number

2 Operating hours. The operating hours meter is running as long as 
the drives are switched on. Alternatively, the operating hours can 
also be displayed via the variable $ROBRUNTIME.

3 Machine data name

4 Robot name. The robot name can be changed.

5 Robot controller data can be archived to a network path.

 (>>> 6.8.3 "Archiving on the network" Page 155)

The archive path is defined here.

6 If archiving to the network requires a user name and password, 
these can be entered here. It is then no longer necessary to enter 
them every time for archiving.

7

8 This box is only displayed if the check box Incorporate robot 
name into
archive name. is not activated.

A name for the archive file can be defined here.

9  Check box active: The robot name is used as the name for the 
archive file. If no robot name is defined, the name archive is 
used.

 Check box not active: A separate name can be defined for 
the archive file.
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5 Start-up and recommissioning

5.1 Start-up wizard

Description Start-up can be carried out using the Start-up wizard. This guides the user 
through the basic start-up steps.

Precondition  No program is selected.

 Operating mode T1

Procedure  Select Start-up > Start-up wizard in the main menu.

5.2 Checking the machine data

Description The correct machine data must be loaded. This must be checked by compar-
ing the loaded machine data with the machine data on the rating plate.

If machine data are reloaded, the version of the machine data must corre-
spond exactly to the KSS version. This is ensured if the machine data supplied 
together with the KSS release are used.

Precondition  T1 or T2 operating mode

 No program is selected.

Procedure 1. In the main menu, select Start-up > Robot data. 

The Robot Data window is opened.

2. Compare the following entries:

 In the Robot data window: the entry in the Machine data box

 On the rating plate on the base of the robot: the entry in the line $TRA-
FONAME()=“# ..... ”

The industrial robot must not be moved if incorrect ma-
chine data are loaded. Death, severe injuries or consid-

erable damage to property may otherwise result. The correct machine data 
must be loaded.

Fig. 5-1: Rating plate
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5.3 Jogging the robot without a higher-level safety controller

Description To jog the robot without a higher-level safety controller, Start-up mode must 
first be activated. The robot can then be jogged in T1 mode. If SafeOperation 
or SafeRangeMonitoring is used, the robot can also be jogged in CRR.

If the RoboTeam option is used, it is only possible to activate Start-up mode 
and jog the robot using the local smartPAD.

The robot controller automatically deactivates Start-up mode in the following 
cases:

 If no operator action has been carried out within 30 min of activation.

 If the smartPAD is switched to passive mode or disconnected from the ro-
bot controller.

 If the Ethernet safety interface is used: when a connection to a higher-level 
safety controller is established.

 If the X11 interface is used: when some input signals no longer have the 
state “logic zero”.

In Start-up mode, the system switches to the following simulated input image:

 The external EMERGENCY STOP is not active.

 The safety gate is open.

 No safety stop 1 has been requested.

 No safety stop 2 has been requested.

 No safe operational stop has been requested.

 Only for VKR C4: E2 is closed.

If SafeOperation or SafeRangeMonitoring is used, Start-up mode also influ-
ences other signals.

Precondition  If the Ethernet safety interface is used: no connection to a higher-level 
safety controller

 If the X11 interface is used: all input signals have the state “logic zero”.

 Operating mode T1 or CRR

 In the case of VKR C4: no E2/E7 signals are activated via a USB stick or 
retrofit interface.

 In the case of RoboTeam: the local smartPAD is used.

Procedure  In the main menu, select Start-up > Service > Start-up mode.

The file path of the machine data on the CD is specified on the rating 
plate in the line ...\MADA\.

External safeguards are disabled in Start-up mode. Ob-
serve the safety instructions relating to Start-up mode.

 (>>> 3.8.3.2 "Start-up mode" Page 35)

Information about the effects of Start-up mode in conjunction with Sa-
feOperation or SafeRangeMonitoring can be found in the documen-
tation SafeOperation and SafeRangeMonitoring.
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5.4 Checking the activation of the positionally accurate robot model

Description If a positionally accurate robot is used, it must be checked that the positionally 
accurate robot model is activated.

In the case of positionally accurate robots, position deviations resulting from 
workpiece tolerances and elastic effects of the individual robots are compen-
sated for. The positionally accurate robot positions the programmed TCP any-
where in the Cartesian workspace within the tolerance limits. The model 
parameters of the positionally accurate robot are determined at a calibration 
station and permanently saved on the robot (RDC).

Functions A positionally accurate robot has the following functions:

 Increased positioning accuracy, approximately by the factor 10

 Increased path accuracy

 Simplified transfer of programs if the robot is exchanged (no reteaching)

 Simplified transfer of programs after offline programming with WorkVisual 
(no reteaching)

Procedure 1. In the main menu, select Help > Info.

2. Check on the Robot tab that the positionally accurate robot model is acti-
vated. (= specification Positionally accurate robot).

5.5 Mastering

Overview Every robot must be mastered. Only if the robot has been mastered can it 
move to programmed positions and be moved using Cartesian coordinates. 
During mastering, the mechanical position and the electronic position of the ro-
bot are aligned. For this purpose, the robot is moved to a defined mechanical 
position, the mastering position. The encoder value for each axis is then 
saved.

The mastering position is similar, but not identical, for all robots. The exact po-
sitions may even vary between individual robots of a single robot type.

Menu Description

Start-up mode is active. Touching 
the menu item deactivates the 
mode.

Start-up mode is not active. Touch-
ing the menu item activates the 
mode.

The positionally accurate robot model is only valid for the robot as de-
livered.
Following conversion or retrofitting of the robot, e.g. with an arm ex-

tension or a new wrist, the robot must be recalibrated.

A precondition for the increased positioning and path accuracy is the 
correct input of the load data into the robot controller.
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A robot must be mastered in the following cases:

5.5.1 Mastering methods

The mastering methods that can be used for a robot depend on the type of 
gauge cartridge with which it is equipped. The types differ visually in terms of 
the size of their protective caps.

Fig. 5-2: Mastering position – approximate position

Case Comments

During commissioning - - -

After maintenance work during 
which the robot loses its mastering, 
e.g. exchange of motor or RDC

 (>>> 5.5.6 "Reference mastering" 
Page 97)

When the robot has been moved 
without the robot controller (e.g. 
with the release device)

- - -

After exchanging a gear unit Before carrying out a new master-
ing procedure, the old mastering 
data must first be deleted! Master-
ing data are deleted by manually 
unmastering the axes.

 (>>> 5.5.8 "Manually unmastering 
axes" Page 105)

After an impact with an end stop at 
more than 250 mm/s

After a collision.
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5.5.2 Moving axes to the pre-mastering position

Description The axes must be moved to the pre-mastering position before every mastering 
operation. To do so, each axis is moved so that the mastering marks line up.

The following figure shows where on the robot the mastering marks are situ-
ated. Depending on the specific robot model, the positions may deviate slightly 
from those illustrated.

Type of gauge cartridge Mastering methods

Gauge cartridge for EMD 

(Electronic Mastering Device)

Protective cap with fine thread, M20

Mastering with the EMD

 (>>> 5.5.3 "Mastering with the 
EMD" Page 90)

Mastering with the dial gauge

 (>>> 5.5.4 "Mastering with the dial 
gauge" Page 95)

Reference mastering

In the case of robots with EMD 
gauge cartridges, reference master-
ing is only used for mastering after 
certain maintenance work.

 (>>> 5.5.6 "Reference mastering" 
Page 97)

Gauge cartridge for MEMD 

(Micro Electronic Mastering Device)

Protective cap with fine thread, M8

For A1 to A5: mastering with the 
MEMD

For A6: mastering to the mark

 (>>> 5.5.7 "Mastering with the 
MEMD and mark" Page 98)

Fig. 5-3: Moving an axis to the pre-mastering position
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Precondition  The jog mode “Jog keys” is active.

 Operating mode T1

Procedure 1. Select Axes as the coordinate system for the jog keys.

2. Hold down the enabling switch.

Axes A1 to A6 are displayed next to the jog keys.

3. Press the Plus or Minus jog key to move an axis in the positive or negative 
direction.

4. Move each axis, starting from A1 and working upwards, so that the mas-
tering marks line up.

5.5.3 Mastering with the EMD

Overview In EMD mastering, the axis is automatically moved by the robot controller to 
the mastering position. Mastering is carried out first without and then with a 
load. It is possible to save mastering data for different loads.

Fig. 5-4: Mastering marks on the robot

If A4 and A6 are moved to the pre-mastering position, 
ensure that the energy supply system – if present – is in 

its correct position and not rotated through 360°.

Robots that are mastered with the MEMD have no pre-mastering po-
sition for A6. Only A1 to A5 have to be moved to the pre-mastering 
position.
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5.5.3.1 First mastering (with EMD)

Precondition  There is no load on the robot; i.e. there is no tool, workpiece or supplemen-
tary load mounted.

 All axes are in the pre-mastering position.

 No program is selected.

 Operating mode T1

Procedure

1. Select Start-up > Master > EMD > With load correction > First master-
ing in the main menu.

A window opens. All axes to be mastered are displayed. The axis with the 
lowest number is highlighted.

2. Remove the cover from connection X32.

Step Description

1 First mastering

 (>>> 5.5.3.1 "First mastering (with EMD)" Page 91)

First mastering is carried out without a load.

2 Teach offset

 (>>> 5.5.3.2 "Teach offset (with EMD)" Page 93)

“Teach offset” is carried out with a load. The difference from 
the first mastering is saved.

3 If required: Master load with offset

 (>>> 5.5.3.3 "Check load mastering with offset (with EMD)" 
Page 94)

“Load mastering with offset” is carried out with a load for 
which an offset has already been taught.

Area of application:

 Checking first mastering

 Restoring first mastering if it has been lost (e.g. follow-
ing exchange of motor or collision). Since an offset that 
has been taught is retained, even if mastering is lost, the 
robot controller can calculate the first mastering.

The EMD must always be screwed onto the gauge car-
tridge without the signal cable attached. Only then may 

the signal cable be attached to the EMD. Otherwise, the signal cable could 
be damaged.
Similarly, when removing the EMD, the signal cable must always be removed 
from the EMD first. Only then may the EMD be removed from the gauge car-
tridge.
After mastering, remove the signal cable from connection X32. Failure to do 
so may result in interference signals or damage.
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3. Connect the signal cable to X32.

4. Remove the protective cap of the gauge cartridge on the axis highlighted 
in the window. (Turned around, the EMD can be used as a screwdriver.)

5. Screw the EMD onto the gauge cartridge.

Fig. 5-5: Removing cover from X32

Fig. 5-6: Connecting signal cable to X32

Fig. 5-7: Removing protective cap from gauge cartridge
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6. Attach the signal cable to the EMD, aligning the red dot on the connector 
with the groove in the EMD.

7. Press Master.

8. Press an enabling switch and the Start key.

When the EMD has passed through the reference notch, the mastering po-
sition is calculated. The robot stops automatically. The values are saved. 
The axis is no longer displayed in the window.

9. Remove the signal cable from the EMD. Then remove the EMD from the 
gauge cartridge and replace the protective cap.

10. Repeat steps 4 to 9 for all axes to be mastered.

11. Close the window.

12. Remove signal cable from connection X32.

5.5.3.2 Teach offset (with EMD)

Description Teach offset is carried out with a load. The difference from the first mastering 
is saved.

If the robot is operated with different loads, Teach offset must be carried out 
for every load. In the case of grippers used for picking up heavy workpieces, 
Teach offset must be carried out for the gripper both with and without the 
workpiece.

Fig. 5-8:  Screwing EMD onto gauge cartridge

Fig. 5-9: Attaching signal cable to EMD
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Precondition  Same ambient conditions (temperature, etc.) as for first mastering.

 The load is mounted on the robot.

 All axes are in the pre-mastering position.

 No program is selected.

 Operating mode T1

Procedure

1. Select Start-up > Master > EMD > With load correction > Teach offset 
in the main menu.

2. Enter tool number. Confirm with Tool OK.

A window opens. All axes for which the tool has not yet been taught are 
displayed. The axis with the lowest number is highlighted.

3. Remove the cover from connection X32 and connect the signal cable.

4. Remove the protective cap of the gauge cartridge on the axis highlighted 
in the window. (Turned around, the EMD can be used as a screwdriver.)

5. Screw the EMD onto the gauge cartridge.

6. Attach the signal cable to the EMD, aligning the red dot on the connector 
with the groove in the EMD.

7. Press Learn.

8. Press an enabling switch and the Start key.

When the EMD has passed through the reference notch, the mastering po-
sition is calculated. The robot stops automatically. A window opens. The 
deviation of this axis from the first mastering is indicated in degrees and 
increments.

9. Click on OK to confirm. The axis is no longer displayed in the window.

10. Remove the signal cable from the EMD. Then remove the EMD from the 
gauge cartridge and replace the protective cap.

11. Repeat steps 4 to 10 for all axes to be mastered.

12. Close the window.

13. Remove signal cable from connection X32.

5.5.3.3 Check load mastering with offset (with EMD)

Description Area of application:

 Checking first mastering

 Restoring first mastering if it has been lost (e.g. following exchange of mo-
tor or collision). Since an offset that has been taught is retained, even if 
mastering is lost, the robot controller can calculate the first mastering.

Precondition  Same ambient conditions (temperature, etc.) as for first mastering.

 A load for which Teach offset has been carried out is mounted on the ro-
bot.

The EMD must always be screwed onto the gauge car-
tridge without the signal cable attached. Only then may 

the signal cable be attached to the EMD. Otherwise, the signal cable could 
be damaged.
Similarly, when removing the EMD, the signal cable must always be removed 
from the EMD first. Only then may the EMD be removed from the gauge car-
tridge.
After mastering, remove the signal cable from connection X32. Failure to do 
so may result in interference signals or damage.

An axis can only be checked if all axes with lower numbers have been 
mastered.
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 All axes are in the pre-mastering position.

 No program is selected.

 Operating mode T1

Procedure

1. In the main menu, select Start-up > Master > EMD > With load correc-
tion > Master load > With offset.

2. Enter tool number. Confirm with Tool OK.

A window opens. All axes for which an offset has been taught with this tool 
are displayed. The axis with the lowest number is highlighted.

3. Remove the cover from connection X32 and connect the signal cable.

4. Remove the protective cap of the gauge cartridge on the axis highlighted 
in the window. (Turned around, the EMD can be used as a screwdriver.)

5. Screw the EMD onto the gauge cartridge.

6. Attach the signal cable to the EMD, aligning the red dot on the connector 
with the groove in the EMD.

7. Press Check.

8. Hold down an enabling switch and press the Start key.

When the EMD has passed through the reference notch, the mastering po-
sition is calculated. The robot stops automatically. The difference from 
“Teach offset” is displayed.

9. If required, press Save to save the values. The old mastering values are 
deleted.

To restore a lost first mastering, always save the values.

10. Remove the signal cable from the EMD. Then remove the EMD from the 
gauge cartridge and replace the protective cap.

11. Repeat steps 4 to 10 for all axes to be mastered.

12. Close the window.

13. Remove signal cable from connection X32.

5.5.4 Mastering with the dial gauge

Description In dial mastering, the axis is moved manually by the user to the mastering po-
sition. Mastering is always carried out with a load. It is not possible to save 
mastering data for different loads.

The EMD must always be screwed onto the gauge car-
tridge without the signal cable attached. Only then may 

the signal cable be attached to the EMD. Otherwise, the signal cable could 
be damaged.
Similarly, when removing the EMD, the signal cable must always be removed 
from the EMD first. Only then may the EMD be removed from the gauge car-
tridge.
After mastering, remove the signal cable from connection X32. Failure to do 
so may result in interference signals or damage.

Axes A4, A5 and A6 are mechanically coupled. This means:
If the values for A4 are deleted, the values for A5 and A6 are also de-
leted.

If the values for A5 are deleted, the values for A6 are also deleted.
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Precondition  The load is mounted on the robot.

 All axes are in the pre-mastering position.

 The jog mode “Jog keys” is active and the coordinate system Axis has 
been selected.

 No program is selected.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Master > Dial.

A window opens. All axes that have not been mastered are displayed. The 
axis that must be mastered first is selected.

2. Remove the protective cap from the gauge cartridge on this axis and 
mount the dial gauge on the gauge cartridge.

Using the Allen key, loosen the screws on the neck of the dial gauge. Turn 
the dial so that it can be viewed easily. Push the pin of the dial gauge in as 
far as the stop.

Using the Allen key, tighten the screws on the neck of the dial gauge.

3. Reduce jog override to 1%.

4. Jog axis from “+” to “-”. At the lowest position of the reference notch, rec-
ognizable by the change in direction of the pointer, set the dial gauge to 0.

If the axis inadvertently overshoots the lowest position, jog the axis back-
wards and forwards until the lowest position is reached. It is immaterial 
whether the axis is moved from “+” to “-” or from “-” to “+”.

5. Move the axis back to the pre-mastering position.

6. Move the axis from “+” to “-” until the pointer is about 5-10 scale divisions 
before zero.

7. Switch to incremental jogging.

8. Move the axis from “+” to “-” until zero is reached.

9. Press Master. The axis that has been mastered is removed from the win-
dow.

10. Remove the dial gauge from the gauge cartridge and replace the protec-
tive cap.

11. Switch back from incremental jogging to the normal jog mode.

12. Repeat steps 2 to 11 for all axes to be mastered.

13. Close the window.

Fig. 5-10: Dial gauge

If the axis overshoots zero, repeat steps 5 to 8.
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5.5.5 Mastering external axes

Description  KUKA external axes can be mastered using either the EMD or the dial 
gauge.

 Non-KUKA external axes can be mastered using the dial gauge. If master-
ing with the EMD is desired, the external axis must be fitted with gauge 
cartridges.

Procedure  The procedure for mastering external axes is the same as that for master-
ing robot axes. Alongside the robot axes, the configured external axes now 
also appear in the axis selection window.

5.5.6 Reference mastering

Description Reference mastering is suitable if maintenance work is due on a correctly 
mastered robot and it is to be expected that the robot will lose its mastering. 
Examples:

 Exchange of RDC

 Exchange of motor

The robot is moved to the $MAMES position before the maintenance work is 
commenced. Afterwards, the axis values of this system variable are reas-
signed to the robot by means of reference mastering. The state of the robot is 
then the same as before the loss of mastering. Taught offsets are retained. No 
EMD or dial gauge is required.

In the case of reference mastering, it is irrelevant whether or not there is a load 
mounted on the robot. Reference mastering can also be used for external ax-
es.

Fig. 5-11: Selection list of axes to be mastered

Mastering in the case of industrial robots with more than 2 external 
axes: if the system contains more than 8 axes, it may be necessary 
to connect the signal cable of the EMD to the second RDC.

The procedure described here must not be used when commission-
ing the robot.
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Preparation  Move the robot to the $MAMES position before commencing the mainte-
nance work. To do so, program a point PTP $MAMES and move the robot 
to it. This is only possible in the user group “Expert”!

Precondition  No program is selected.

 Operating mode T1

 The position of the robot was not changed during the maintenance work.

 If the RDC has been exchanged: the robot data have been transferred 
from the hard drive to the RDC (this can only be done in the user group 
“Expert”!)

Procedure 1. In the main menu, select Start-up > Master > Reference.

The option window Reference mastering is opened. All axes that have 
not been mastered are displayed. The axis that must be mastered first is 
selected.

2. Press Master. The selected axis is mastered and removed from the option 
window.

3. Repeat step 2 for all axes to be mastered.

5.5.7 Mastering with the MEMD and mark

Overview In MEMD mastering, the axis is automatically moved by the robot controller to 
the mastering position. Mastering is carried out first without and then with a 
load. It is possible to save mastering data for different loads.

A6 is not mastered using the MEMD, but with the aid of a mark. The procedure 
is described in the sections describing MEMD mastering.

The robot must not move to the default HOME position 
instead of to $MAMES. $MAMES may be, but is not al-

ways, identical to the default HOME position. Only in the $MAMES position 
will the robot be correctly mastered by means of reference mastering. If the 
robot is reference mastered at any position other than $MAMES, this may re-
sult in injury and material damage.

Step Description

1 First mastering

 (>>> 5.5.7.1 "First mastering (with MEMD)" Page 99)

First mastering is carried out without a load.
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MEMD

The thinner cable is the signal cable. It connects the MEMD to the MEMD box.

The thicker cable is the EtherCAT cable. It is connected to the MEMD box and 
to the robot at X32.

5.5.7.1 First mastering (with MEMD)

Precondition  There is no load on the robot; i.e. there is no tool, workpiece or supplemen-
tary load mounted.

 A1 to A5 are in the pre-mastering position. 

2 Teach offset

 (>>> 5.5.7.2 "Teach offset (with MEMD)" Page 102)

“Teach offset” is carried out with a load. The difference from 
the first mastering is saved.

3 If required: Master load with offset

 (>>> 5.5.7.3 "Check load mastering with offset (with 
MEMD)" Page 103)

“Load mastering with offset” is carried out with a load for 
which an offset has already been taught.

Area of application:

 Checking first mastering

 Restoring first mastering if it has been lost (e.g. follow-
ing exchange of motor or collision). Since an offset that 
has been taught is retained, even if mastering is lost, the 
robot controller can calculate the first mastering.

Step Description

Fig. 5-12: MEMD case

1 MEMD box 3 MEMD

2 Screwdriver 4 Cables

Leave the signal cable connected to the MEMD box and 
disconnect it as little as possible. The pluggability of the 

M8 sensor connector is limited. Frequent connection/disconnection can re-
sult in damage to the connector.
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 No program is selected.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Master > EMD > With load correc-
tion > First mastering.

A window opens. All axes to be mastered are displayed. The axis with the 
lowest number is highlighted.

2. Remove the cover from connection X32.

3. Connect the EtherCAT cable to X32 and to the MEMD box.

4. Remove the protective cap of the gauge cartridge on the axis highlighted 
in the window. 

Fig. 5-13: X32 without cover

Fig. 5-14: EtherCAT cable at X32 and MEMD box
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5. Screw the MEMD onto the gauge cartridge.

6. Press Master.

7. Press an enabling switch and the Start key.

When the MEMD has passed through the reference notch, the mastering 
position is calculated. The robot stops automatically. The values are 
saved. The axis is no longer displayed in the window.

8. Remove the MEMD from the gauge cartridge and replace the protective 
cap.

9. Repeat steps 4 to 8 for all axes to be mastered, except A6.

10. Close the window.

11. Move A6 to the mastering position:

A6 has very fine marks in the metal. Align these marks exactly with one 
another.

Fig. 5-15: Removing protective cap from gauge cartridge

Fig. 5-16: Screwing MEMD onto gauge cartridge
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12. In the main menu, select Start-up > Master > Reference.

The option window Reference mastering is opened. A6 is displayed and 
is selected. 

13. Press Master. A6 is mastered and removed from the option window.

14. Close the window.

15. Disconnect the EtherCAT cable from X32 and the MEMD box.

5.5.7.2 Teach offset (with MEMD)

Description Teach offset is carried out with a load. The difference from the first mastering 
is saved.

If the robot is operated with different loads, Teach offset must be carried out 
for every load. In the case of grippers used for picking up heavy workpieces, 
Teach offset must be carried out for the gripper both with and without the 
workpiece.

Precondition  Same ambient conditions (temperature, etc.) as for first mastering.

 The load is mounted on the robot.

 A1 to A5 are in the pre-mastering position. 

 No program is selected.

 Operating mode T1

Procedure 1. Select Start-up > Master > EMD > With load correction > Teach offset 
in the main menu.

2. Enter tool number. Confirm with Tool OK.

When moving to the mastering position, it is important to look at the 
fixed mark in a straight line from in front. If the mark is observed from 
the side, the movable mark cannot be aligned accurately enough. 

This results in incorrect mastering.

Fig. 5-17: Mastering position A6 – view from above

Leave the signal cable connected to the MEMD box and 
disconnect it as little as possible. The pluggability of the 

M8 sensor connector is limited. Frequent connection/disconnection can re-
sult in damage to the connector.
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A window opens. All axes for which the tool has not yet been taught are 
displayed. The axis with the lowest number is highlighted.

3. Remove the cover from connection X32.

4. Connect the EtherCAT cable to X32 and to the MEMD box.

5. Remove the protective cap of the gauge cartridge on the axis highlighted 
in the window.

6. Screw the MEMD onto the gauge cartridge.

7. Press Learn.

8. Press an enabling switch and the Start key.

When the MEMD has passed through the reference notch, the mastering 
position is calculated. The robot stops automatically. A window opens. The 
deviation of this axis from the first mastering is indicated in degrees and 
increments.

9. Click on OK to confirm. The axis is no longer displayed in the window.

10. Remove the MEMD from the gauge cartridge and replace the protective 
cap.

11. Repeat steps 5 to 10 for all axes to be mastered, except A6.

12. Close the window.

13. Move A6 to the mastering position:

A6 has very fine marks in the metal. Align these marks exactly with one 
another.

14. In the main menu, select Start-up > Master > Reference.

The option window Reference mastering is opened. A6 is displayed and 
is selected. 

15. Press Master. A6 is mastered and removed from the option window.

16. Close the window.

17. Disconnect the EtherCAT cable from X32 and the MEMD box.

5.5.7.3 Check load mastering with offset (with MEMD)

Description Area of application:

 Checking first mastering

 Restoring first mastering if it has been lost (e.g. following exchange of mo-
tor or collision). Since an offset that has been taught is retained, even if 
mastering is lost, the robot controller can calculate the first mastering.

Precondition  Same ambient conditions (temperature, etc.) as for first mastering.

When moving to the mastering position, it is important to look at the 
fixed mark in a straight line from in front. If the mark is observed from 
the side, the movable mark cannot be aligned accurately enough. 

This results in incorrect mastering.

Leave the signal cable connected to the MEMD box and 
disconnect it as little as possible. The pluggability of the 

M8 sensor connector is limited. Frequent connection/disconnection can re-
sult in damage to the connector.

An axis can only be checked if all axes with lower numbers have been 
mastered.

The value determined for A6 is not displayed, i.e. first mastering can-
not be checked. It is possible to restore lost first mastering, however.
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 A load for which Teach offset has been carried out is mounted on the ro-
bot.

 A1 to A5 are in the pre-mastering position.

 No program is selected.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Master > EMD > With load correc-
tion > Master load > With offset.

2. Enter tool number. Confirm with Tool OK.

A window opens. All axes for which an offset has been taught with this tool 
are displayed. The axis with the lowest number is highlighted.

3. Remove the cover from connection X32.

4. Connect the EtherCAT cable to X32 and to the MEMD box.

5. Remove the protective cap of the gauge cartridge on the axis highlighted 
in the window. 

6. Screw the MEMD onto the gauge cartridge.

7. Press Check.

8. Hold down an enabling switch and press the Start key.

When the MEMD has passed through the reference notch, the mastering 
position is calculated. The robot stops automatically. The difference from 
“Teach offset” is displayed.

9. If required, press Save to save the values. The old mastering values are 
deleted.

To restore a lost first mastering, always save the values.

10. Remove the MEMD from the gauge cartridge and replace the protective 
cap.

11. Repeat steps 5 to 10 for all axes to be mastered, except A6.

12. Close the window.

13. Move A6 to the mastering position:

A6 has very fine marks in the metal. Align these marks exactly with one 
another.

14. In the main menu, select Start-up > Master > Reference.

The option window Reference mastering is opened. A6 is displayed and 
is selected. 

15. Press Master to restore lost first mastering. A6 is removed from the option 
window.

16. Close the window.

17. Disconnect the EtherCAT cable from X32 and the MEMD box.

Axes A4, A5 and A6 are mechanically coupled. This means:
If the values for A4 are deleted, the values for A5 and A6 are also de-
leted.

If the values for A5 are deleted, the values for A6 are also deleted.

When moving to the mastering position, it is important to look at the 
fixed mark in a straight line from in front. If the mark is observed from 
the side, the movable mark cannot be aligned accurately enough. 

This results in incorrect mastering.

Leave the signal cable connected to the MEMD box and 
disconnect it as little as possible. The pluggability of the 

M8 sensor connector is limited. Frequent connection/disconnection can re-
sult in damage to the connector.
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5.5.8 Manually unmastering axes

Description The mastering values of the individual axes can be deleted. The axes do not 
move during unmastering.

Precondition  No program is selected.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Master > Unmaster. A window 
opens.

2. Select the axis to be unmastered.

3. Press Unmaster. The mastering data of the axis are deleted.

4. Repeat steps 2 and 3 for all axes to be unmastered.

5. Close the window.

5.6 Modifying software limit switches

There are 2 ways of modifying the software limit switches:

 Enter the desired values manually.

 Or automatically adapt the limit switches to one or more programs.

The robot controller determines the minimum and maximum axis positions 
occurring in the program. These values can then be set as software limit 
switches. 

Precondition  “Expert” user group

 T1, T2 or AUT mode

Procedure Modifying software limit switches manually:

1. In the main menu, select Start-up > Service > Software limit switch. The 
Software limit switch window is opened.

2. Modify the limit switches as required in the columns Negative and Posi-
tive.

3. Save the changes with Save.

Adapting software limit switches to a program:

1. In the main menu, select Start-up > Service > Software limit switch. The 
Software limit switch window is opened.

2. Click on Auto detection. The following message is displayed: Auto detec-
tion is running.

3. Start the program to which the limit switches are to be adapted. Execute 
the program completely and then cancel it.

The maximum and minimum position reached by each axis is displayed in 
the Software limit switch window.

Axes A4, A5 and A6 are mechanically coupled. This means:
If the values for A4 are deleted, the values for A5 and A6 are also de-
leted.

If the values for A5 are deleted, the values for A6 are also deleted.

The software limit switches of an unmastered robot are 
deactivated. The robot can hit the end stop buffers, thus 

damaging the robot and making it necessary to exchange the buffers. An un-
mastered robot must not be jogged, if at all avoidable. If it must be jogged, 
the jog override must be reduced as far as possible.
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4. Repeat step 3 for all programs to which the limit switches are to be adapt-
ed.

The maximum and minimum position reached by each axis in all executed 
programs is displayed in the Software limit switch window.

5. Once all desired programs have been executed, press End in the Soft-
ware limit switch window.

6. Press Save to save the determined values as software limit switches.

7. If required, modify the automatically determined values manually. 

8. Save the changes with Save.

Description Software limit switch window:

Recommendation: Reduce the determined minimum values by 5°. In-
crease the determined maximum values by 5°. 
This margin prevents the axes from reaching the limit switches during 

program execution and thus triggering a stop.

Fig. 5-18: Before automatic determination

Item Description

1 Current negative limit switch

2 Current position of the axis

3 Current positive limit switch
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Buttons The following buttons are available (only in the “Expert” user group):

5.7 Calibration

5.7.1 Tool calibration

Description During tool calibration, the user assigns a Cartesian coordinate system (TOOL 
coordinate system) to the tool mounted on the mounting flange.

The TOOL coordinate system has its origin at a user-defined point. This is 
called the TCP (Tool Center Point). The TCP is generally situated at the work-
ing point of the tool.

Fig. 5-19: During automatic determination

Item Description

4 Minimum position of the axis since the start of determination

5 Maximum position of the axis since the start of determination

Button Description

Auto detection Starts the automatic determination: 

The robot controller writes the minimum and 
maximum positions adopted by the axes from 
now on to the columns Minimum and Maximum 
in the Software limit switch window.

End Ends the automatic determination. Transfers the 
calculated minimum/maximum positions to the 
columns Negative and Positive, but does not yet 
save them.

Save Saves the values in the columns Negative and 
Positive as software limit switches.

In the case of a fixed tool, the type of calibration described here must 
not be used. A separate type of calibration must be used for fixed 
tools. (>>> 5.7.3 "Fixed tool calibration" Page 118)
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Advantages of tool calibration:

 The tool can be moved in a straight line in the tool direction.

 The tool can be rotated about the TCP without changing the position of the 
TCP.

 In program mode: The programmed velocity is maintained at the TCP 
along the path.

A maximum of 16 TOOL coordinate systems can be saved. Variable: 
TOOL_DATA[1…16].

The following data are saved:

 X, Y, Z:

Origin of the TOOL coordinate system relative to the FLANGE coordinate 
system

 A, B, C:

Orientation of the TOOL coordinate system relative to the FLANGE coor-
dinate system

Overview Tool calibration consists of 2 steps:

Fig. 5-20: TCP calibration principle
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If the calibration data are already known, they can be entered directly.  
(>>> 5.7.1.5 "Numeric input" Page 114)

5.7.1.1 TCP calibration: XYZ 4-point method

Description The TCP of the tool to be calibrated is moved to a reference point from 4 dif-
ferent directions. The reference point can be freely selected. The robot con-
troller calculates the TCP from the different flange positions.

Step Description

1 Definition of the origin of the TOOL coordinate system

The following methods are available:

 XYZ 4-point

 (>>> 5.7.1.1 "TCP calibration: XYZ 4-point method" 
Page 109)

 XYZ Reference

 (>>> 5.7.1.2 "TCP calibration: XYZ Reference method" 
Page 111)

2 Definition of the orientation of the TOOL coordinate sys-
tem

The following methods are available:

 ABC 2-point

 (>>> 5.7.1.4 "Defining the orientation: ABC 2-point meth-
od" Page 112)

 ABC World

 (>>> 5.7.1.3 "Defining the orientation: ABC World meth-
od" Page 112)

The XYZ 4-point method cannot be used for palletizing robots.

The 4 flange positions at the reference point must be sufficiently dif-
ferent from one another.
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Precondition  The tool to be calibrated is mounted on the mounting flange.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Tool > XYZ 4-point.

2. Assign a number and a name for the tool to be calibrated. Confirm with 
Next.

3. Move the TCP to a reference point. Press Calibrate. Answer the request 
for confirmation with Yes.

4. Move the TCP to the reference point from a different direction. Press Cal-
ibrate. Answer the request for confirmation with Yes.

5. Repeat step 4 twice.

6. Enter the payload data. (This step can be skipped if the payload data are 
entered separately instead.)

 (>>> 5.8.3 "Entering payload data" Page 132)

7. Confirm with Next.

8. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by 
pressing Back.

9. Either: press Save and then close the window via the Close icon.

Or: press ABC 2-point or ABC World. The previous data are automatical-
ly saved and a window is opened in which the orientation of the TOOL co-
ordinate system can be defined.

 (>>> 5.7.1.4 "Defining the orientation: ABC 2-point method" Page 112)

 (>>> 5.7.1.3 "Defining the orientation: ABC World method" Page 112)

Fig. 5-21: XYZ 4-Point method
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5.7.1.2 TCP calibration: XYZ Reference method

Description In the case of the XYZ Reference method, a new tool is calibrated with a tool 
that has already been calibrated. The robot controller compares the flange po-
sitions and calculates the TCP of the new tool.

Precondition  A previously calibrated tool is mounted on the mounting flange.

 Operating mode T1

Preparation Calculate the TCP data of the calibrated tool:

1. In the main menu, select Start-up > Calibrate > Tool > XYZ Reference.

2. Enter the number of the calibrated tool.

3. The tool data are displayed. Note the X, Y and Z values.

4. Close the window.

Procedure 1. In the main menu, select Start-up > Calibrate > Tool > XYZ Reference.

2. Assign a number and a name for the new tool. Confirm with Next.

3. Enter the TCP data of the calibrated tool. Confirm with Next.

4. Move the TCP to a reference point. Press Calibrate. Answer the request 
for confirmation with Yes.

5. Move the tool away and remove it. Mount the new tool.

6. Move the TCP of the new tool to the reference point. Press Calibrate. An-
swer the request for confirmation with Yes.

7. Enter the payload data. (This step can be skipped if the payload data are 
entered separately instead.)

 (>>> 5.8.3 "Entering payload data" Page 132)

8. Confirm with Next.

9. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by 
pressing Back.

10. Either: press Save and then close the window via the Close icon.

Or: press ABC 2-point or ABC World. The previous data are automatical-
ly saved and a window is opened in which the orientation of the TOOL co-
ordinate system can be defined.

 (>>> 5.7.1.4 "Defining the orientation: ABC 2-point method" Page 112)

 (>>> 5.7.1.3 "Defining the orientation: ABC World method" Page 112)

Fig. 5-22: XYZ Reference method
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5.7.1.3 Defining the orientation: ABC World method

Description The axes of the TOOL coordinate system are aligned parallel to the axes of 
the WORLD coordinate system. This communicates the orientation of the 
TOOL coordinate system to the robot controller.

There are 2 variants of this method:

 5D: Only the tool direction is communicated to the robot controller. By de-
fault, the tool direction is the X axis. The directions of the other axes are 
defined by the system and cannot be detected easily by the user.

Area of application: e.g. MIG/MAG welding, laser cutting or waterjet cutting

 6D: The directions of all 3 axes are communicated to the robot controller.

Area of application: e.g. for weld guns, grippers or adhesive nozzles

Precondition  The tool to be calibrated is mounted on the mounting flange.

 The TCP of the tool has already been measured.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Tool > ABC World.

2. Enter the number of the tool. Confirm with Next.

3. Select a variant in the box 5D/6D. Confirm with Next.

4. If 5D is selected: 

Align +XTOOL parallel to -ZWORLD. (+XTOOL = tool direction)

If 6D is selected:

Align the axes of the TOOL coordinate system as follows.

 +XTOOL parallel to -ZWORLD. (+XTOOL = tool direction)

 +YTOOL parallel to +YWORLD

 +ZTOOL parallel to +XWORLD

5. Press Calibrate. Answer the request for confirmation with Yes.

6. Enter the payload data. (This step can be skipped if the payload data are 
entered separately instead.)

 (>>> 5.8.3 "Entering payload data" Page 132)

7. Confirm with Next.

8. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by 
pressing Back.

9. Press Save.

5.7.1.4 Defining the orientation: ABC 2-point method

Description The axes of the TOOL coordinate system are communicated to the robot con-
troller by moving to a point on the X axis and a point in the XY plane.

This method is used if it is necessary to define the axis directions with partic-
ular precision.

The following procedure applies if the tool direction is the default tool 
direction (= X axis). If the tool direction has been changed to Y or Z, 
the procedure must also be changed accordingly. 

The following two steps are eliminated if the procedure is not called 
via the main menu, but by means of the ABC World button after TCP 
calibration.
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Precondition  The tool to be calibrated is mounted on the mounting flange.

 The TCP of the tool has already been measured.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Tool > ABC 2-point.

2. Enter the number of the mounted tool. Confirm with Next.

3. Move the TCP to any reference point. Press Calibrate. Answer the re-
quest for confirmation with Yes.

4. Move the tool so that the reference point on the X axis has a negative X 
value (i.e. move against the tool direction). Press Calibrate. Answer the 
request for confirmation with Yes.

5. Move the tool so that the reference point in the XY plane has a negative Y 
value. Press Calibrate. Answer the request for confirmation with Yes.

Fig. 5-23: ABC 2-Point method

The following procedure applies if the tool direction is the default tool 
direction (= X axis). If the tool direction has been changed to Y or Z, 
the procedure must also be changed accordingly. 

The following two steps are eliminated if the procedure is not called 
via the main menu, but by means of the ABC 2-point button after 
TCP calibration.
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6. Enter the payload data. (This step can be skipped if the payload data are 
entered separately instead.)

 (>>> 5.8.3 "Entering payload data" Page 132)

7. Confirm with Next.

8. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by 
pressing Back.

9. Press Save.

5.7.1.5 Numeric input

Description The tool data can be entered manually.

Possible sources of data:

 CAD

 Externally calibrated tool

 Tool manufacturer specifications

Precondition  The following values are known:

 X, Y and Z relative to the FLANGE coordinate system

 A, B and C relative to the FLANGE coordinate system

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Tool > Numeric input.

2. Assign a number and a name for the tool to be calibrated. Confirm with 
Next.

3. Enter the tool data. Confirm with Next.

4. Enter the payload data. (This step can be skipped if the payload data are 
entered separately instead.)

 (>>> 5.8.3 "Entering payload data" Page 132)

5. If online load data verification is available (this depends on the robot type): 
configure as required.

 (>>> 5.8.5 "Online load data check" Page 133)

6. Confirm with Next.

7. Press Save.

5.7.2 Base calibration

Description During base calibration, the user assigns a Cartesian coordinate system 
(BASE coordinate system) to a work surface or the workpiece. The BASE co-
ordinate system has its origin at a user-defined point.

Advantages of base calibration:

 The TCP can be jogged along the edges of the work surface or workpiece.

In the case of palletizing robots with 4 axes, e.g. KR 180 PA, the tool 
data must be entered numerically. The XYZ and ABC methods can-
not be used as reorientation of these robots is highly restricted.

If the workpiece is mounted on the mounting flange, the type of cali-
bration described here must not be used. A separate type of calibra-
tion must be used for workpieces mounted on the mounting flange.  

(>>> 5.7.3 "Fixed tool calibration" Page 118)
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 Points can be taught relative to the base. If it is necessary to offset the 
base, e.g. because the work surface has been offset, the points move with 
it and do not need to be retaught.

A maximum of 32 BASE coordinate systems can be saved. Variable: 
BASE_DATA[1…32].

Overview There are 2 ways of calibrating a base:

 3-point method  (>>> 5.7.2.1 "3-point method" Page 115)

 Indirect method  (>>> 5.7.2.3 "Indirect method" Page 117) 
(>>> 5.7.2.2 "Indirect method" Page 116)

If the calibration data are already known, they can be entered directly. 

5.7.2.1 3-point method

Description The robot moves to the origin and 2 further points of the new base. These 3 
points define the new base.

Precondition  A previously calibrated tool is mounted on the mounting flange.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Base > ABC 3-point.

Fig. 5-24: 3-point method
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2. Assign a number and a name for the base. Confirm with Next.

3. Enter the number of the mounted tool. Confirm with Next.

4. Move the TCP to the origin of the new base. Press Calibrate. Answer the 
request for confirmation with Yes.

5. Move the TCP to a point on the positive X axis of the new base. Press Cal-
ibrate. Answer the request for confirmation with Yes.

6. Move the TCP to a point in the XY plane with a positive Y value. Press Cal-
ibrate. Answer the request for confirmation with Yes.

7. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by 
pressing Back.

8. Press Save.

5.7.2.2 Indirect method

Description The indirect method is used if it is not possible to move to the origin of the 
base, e.g. because it is inside a workpiece or outside the workspace of the ro-
bot.

The TCP is moved to 4 points in the base, the coordinates of which must be 
known. The robot controller calculates the base from these points.

Precondition  A calibrated tool is mounted on the mounting flange.

 The coordinates of 4 points in the new base are known, e.g. from CAD da-
ta. The 4 points are accessible to the TCP.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Base > Indirect.

2. Assign a number and a name for the base. Confirm with Next.

3. Enter the number of the mounted tool. Confirm with Next.

Fig. 5-25: Indirect method
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4. Enter the coordinates of a known point in the new base and move the TCP 
to this point. Press Calibrate. Answer the request for confirmation with 
Yes.

5. Repeat step 4 three times.

6. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by 
pressing Back.

7. Press Save.

5.7.2.3 Indirect method

Description The indirect method is used if it is not possible to move to the origin of the 
base, e.g. because it is inside a workpiece or outside the workspace of the ro-
bot.

The TCP is moved to 4 points in the base, the coordinates of which must be 
known. The robot controller calculates the base from these points.

Precondition  A calibrated tool is mounted on the mounting flange.

 The coordinates of 4 points in the new base are known, e.g. from CAD da-
ta. The 4 points are accessible to the TCP.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Base > Indirect.

2. Assign a number and a name for the base. Confirm with Next.

3. Enter the number of the mounted tool. Confirm with Next.

4. Enter the coordinates of a known point in the new base and move the TCP 
to this point. Press Calibrate. Confirm with Next.

5. Repeat step 4 three times.

6. Press Save.

Fig. 5-26: Indirect method
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5.7.3 Fixed tool calibration

Overview Calibration of a fixed tool consists of 2 steps:

The robot controller saves the external TCP as the BASE coordinate system 
and the workpiece as the TOOL coordinate system. A maximum of 32 BASE 
coordinate systems and 16 TOOL coordinate systems can be saved.

5.7.3.1 Calibrating an external TCP

Description First of all, the TCP of the fixed tool is communicated to the robot controller. 
This is done by moving a calibrated tool to it.

Then, the orientation of the coordinate system of the fixed tool is communicat-
ed to the robot controller. For this purpose, the coordinate system of the cali-
brated tool is aligned parallel to the new coordinate system. There are 2 
variants:

 5D: Only the tool direction of the fixed tool is communicated to the robot 
controller. By default, the tool direction is the X axis. The orientation of the 
other axes is defined by the system and cannot be detected easily by the 
user.

 6D: The orientation of all 3 axes is communicated to the robot controller.

Step Description

1 Calibration of the TCP of the fixed tool

The TCP of a fixed tool is called an external TCP.

 (>>> 5.7.3.1 "Calibrating an external TCP" Page 118)

If the calibration data are already known, they can be entered 
directly.

 (>>> 5.7.3.2 "Entering the external TCP numerically" 
Page 120)

2 Calibration of the workpiece

The following methods are available:

 Direct method 

 (>>> 5.7.3.3 "Workpiece calibration: direct method" 
Page 120)

 Indirect method 

 (>>> 5.7.3.4 "Workpiece calibration: indirect method" 
Page 121)
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Precondition  A previously calibrated tool is mounted on the mounting flange.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Fixed tool > Tool.

2. Assign a number and a name for the fixed tool. Confirm with Next.

3. Enter the number of the calibrated tool. Confirm with Next.

4. Select a variant in the box 5D/6D. Confirm with Next.

5. Move the TCP of the calibrated tool to the TCP of the fixed tool. Press Cal-
ibrate. Answer the request for confirmation with Yes.

6. If 5D is selected: 

Fig. 5-27: Moving to the external TCP

Fig. 5-28: Aligning the coordinate systems parallel to one another

The following procedure applies if the tool direction is the default tool 
direction (= X axis). If the tool direction has been changed to Y or Z, 
the procedure must also be changed accordingly. 
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Align +XBASE parallel to -ZFLANGE.

(i.e. align the mounting flange perpendicular to the tool direction of the 
fixed tool.)

If 6D is selected: 

Align the mounting flange so that its axes are parallel to the axes of the 
fixed tool:

 +XBASE parallel to -ZFLANGE

(i.e. align the mounting flange perpendicular to the tool direction.)

 +YBASE parallel to +YFLANGE

 +ZBASE parallel to +XFLANGE

7. Press Calibrate. Answer the request for confirmation with Yes.

8. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by 
pressing Back.

9. Press Save.

5.7.3.2 Entering the external TCP numerically

Precondition  The following numerical values are known, e.g. from CAD data:

 Distance between the TCP of the fixed tool and the origin of the 
WORLD coordinate system (X, Y, Z)

 Rotation of the axes of the fixed tool relative to the WORLD coordinate 
system (A, B, C)

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Fixed tool > Numeric in-
put.

2. Assign a number and a name for the fixed tool. Confirm with Next.

3. Enter data. Confirm with Next.

4. Press Save.

5.7.3.3 Workpiece calibration: direct method

Description The origin and 2 further points of the workpiece are communicated to the robot 
controller. These 3 points uniquely define the workpiece.

Fig. 5-29
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Precondition  The workpiece is mounted on the mounting flange.

 A previously calibrated fixed tool is mounted.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Fixed tool > Workpiece 
> Direct calibration.

2. Assign a number and a name for the workpiece. Confirm with Next.

3. Enter the number of the fixed tool. Confirm with Next.

4. Move the origin of the workpiece coordinate system to the TCP of the fixed 
tool. Press Calibrate. Answer the request for confirmation with Yes.

5. Move a point on the positive X axis of the workpiece coordinate system to 
the TCP of the fixed tool. Press Calibrate. Answer the request for confir-
mation with Yes.

6. Move a point with a positive Y value in the XY plane of the workpiece co-
ordinate system to the TCP of the fixed tool. Press Calibrate. Answer the 
request for confirmation with Yes.

7. Enter the load data of the workpiece. (This step can be skipped if the load 
data are entered separately instead.)

 (>>> 5.8.3 "Entering payload data" Page 132)

8. Confirm with Next.

9. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by 
pressing Back.

10. Press Save.

5.7.3.4 Workpiece calibration: indirect method

Description The robot controller calculates the workpiece on the basis of 4 points whose 
coordinates must be known. The robot does not move to the origin of the work-
piece.

Fig. 5-30: Workpiece calibration: direct method
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Precondition  A previously calibrated fixed tool is mounted.

 The workpiece to be calibrated is mounted on the mounting flange.

 The coordinates of 4 points of the new workpiece are known, e.g. from 
CAD data. The 4 points are accessible to the TCP.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Fixed tool > Workpiece 
> Indirect calibration.

2. Assign a number and a name for the workpiece. Confirm with Next.

3. Enter the number of the fixed tool. Confirm with Next.

4. Enter the coordinates of a known point on the workpiece and move this 
point to the TCP of the fixed tool. Press Calibrate. Answer the request for 
confirmation with Yes.

5. Repeat step 4 three times.

6. Enter the load data of the workpiece. (This step can be skipped if the load 
data are entered separately instead.)

 (>>> 5.8.3 "Entering payload data" Page 132)

7. Confirm with Next.

8. If required, coordinates and orientation of the calibrated points can be dis-
played in increments and degrees (relative to the FLANGE coordinate sys-
tem). For this, press Meas. points. Then return to the previous view by 
pressing Back.

9. Press Save.

5.7.4 Renaming the tool/base

Precondition  Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Tool or Base > Change 
name.

2. Select the tool or base and press Name.

3. Enter the new name and confirm with Save.

Fig. 5-31: Workpiece calibration: indirect method
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5.7.5 Linear unit

The KUKA linear unit is a self-contained, one-axis linear unit mounted on the 
floor or ceiling. It is used for linear traversing of the robot and is controlled by 
the robot controller as an external axis.

The linear unit is a ROBROOT kinematic system. When the linear unit is 
moved, the position of the robot in the WORLD coordinate system changes. 
The current position of the robot in the WORLD coordinate system is defined 
by the vector $ROBROOT_C.

$ROBROOT_C consists of:

 $ERSYSROOT (static component)

Root point of the linear unit relative to $WORLD. The root point is situated 
by default at the zero position of the linear unit and is not dependent on 
$MAMES.

 #ERSYS (dynamic component)

Current position of the robot on the linear unit relative to the $ERSYS-
ROOT

5.7.5.1 Checking whether the linear unit needs to be calibrated

Description The robot is standing on the flange of the linear unit. Ideally, the ROBROOT 
coordinate system of the robot should be identical to the FLANGE coordinate 
system of the linear unit. In reality, there are often slight discrepancies which 
mean that positions cannot be moved to correctly. Calibration allows mathe-
matical correction of these discrepancies. (Rotations about the direction of 
motion of the linear unit cannot be corrected. They do not, however, cause er-
rors when moving to positions.)

If there are no discrepancies, the linear unit does not need to be calibrated. 
The following procedure can be used to determine whether calibration is re-
quired.

Precondition  The machine data of the linear unit have been configured and loaded into 
the robot controller.

 A previously calibrated tool is mounted on the mounting flange.

 No program is open or selected.

 Operating mode T1

Procedure 1. Align the TCP against a freely selected point and observe it.

Fig. 5-32: ROBROOT kinematic system – linear unit
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2. Execute a Cartesian (not axis-specific!) motion with the linear unit.

 If the TCP stops: the linear unit does not require calibration.

 If the TCP moves: the linear unit does require calibration.

 (>>> 5.7.5.2 "Calibrating the linear unit" Page 124)

If the calibration data are already known (e.g. from CAD), they can be entered 
directly. (>>> 5.7.5.3 "Entering the linear unit numerically" Page 125)

5.7.5.2 Calibrating the linear unit

Description During calibration, the TCP of a tool that has already been calibrated is moved 
to a reference point 3 times.

 The reference point can be freely selected.

 The position of the robot on the linear unit from which the reference point 
is approached must be different all 3 times. The 3 positions must be far 
enough apart.

The correction values determined by the calibration are factored into the sys-
tem variable $ETx_TFLA3.

Precondition  The machine data of the linear unit have been configured and loaded into 
the robot controller.

 A previously calibrated tool is mounted on the mounting flange.

 No program is open or selected.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > External kinematic sys-
tem > Linear unit.

The robot controller detects the linear unit automatically and displays the 
following data:

 Ext. kinematic system no.: number of the external kinematic system 
(1 … 6) ($EX_KIN)

 Axis: number of the external axis (1 … 6) ($ETx_AX)

 Name of the external kinematic system ($ETx_NAME)

(If the robot controller is unable to determine these values, e.g. because 
the linear unit has not yet been configured, calibration cannot be contin-
ued.)

2. Move the linear unit with the jog key “+”.

3. Specify whether the linear unit is moving to “+” or “-”. Confirm with Next.

4. Move the TCP to the reference point.

5. Press Calibrate.

6. Repeat steps 4 and 5 twice, but move the linear unit first each time in order 
to address the reference point from different positions.

7. Press Save. The calibration data are saved.

8. The system asks whether the positions that have already been taught are 
to be corrected.

 If no positions have been taught prior to the calibration, it makes no dif-
ference whether the question is answered with Yes or No.

 If positions have been taught prior to the calibration:

Answering Yes will cause positions with base 0 to be corrected auto-
matically. Other positions will not be corrected!

Answering No will cause no positions to be corrected.
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5.7.5.3 Entering the linear unit numerically

Precondition  The machine data of the linear unit have been configured and loaded into 
the robot controller.

 No program is open or selected.

 The following numerical values are known, e.g. from CAD data:

 Distance between the robot base flange and the origin of the ERSYS-
ROOT coordinate system (X, Y, Z)

 Orientation of the robot base flange relative to the ERSYSROOT coor-
dinate system (A, B, C)

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > External kinematic sys-
tem > Linear unit (numeric).

The robot controller detects the linear unit automatically and displays the 
following data:

 Ext. kinematic system no.: number of the external kinematic system 
(1 … 6)

 Axis: number of the external axis (1 … 6)

 Name of the kinematic system

(If the robot controller is unable to determine these values, e.g. because 
the linear unit has not yet been configured, calibration cannot be contin-
ued.)

2. Move the linear unit with the jog key “+”.

3. Specify whether the linear unit is moving to “+” or “-”. Confirm with Next.

4. Enter data. Confirm with Next.

5. Press Save. The calibration data are saved.

6. The system asks whether the positions that have already been taught are 
to be corrected.

 If no positions have been taught prior to the calibration, it makes no dif-
ference whether the question is answered with Yes or No.

 If positions have been taught prior to the calibration:

Answering Yes will cause positions with base 0 to be corrected auto-
matically. Other positions will not be corrected!

Answering No will cause no positions to be corrected.

After calibration of a linear unit, the following safety mea-
sures must be carried out:

1. Check the software limit switches of the linear unit and adapt them if re-
quired.

2. Test programs in T1.

Damage to property may otherwise result.

After calibration of a linear unit, the following safety mea-
sures must be carried out:

1. Check the software limit switches of the linear unit and adapt them if re-
quired.

2. Test programs in T1.

Damage to property may otherwise result.
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5.7.6 Calibrating an external kinematic system

Description Calibration of the external kinematic system is necessary to enable the motion 
of the axes of the kinematic system to be synchronized and mathematically 
coupled with the robot axes. An external kinematic system can be a turn-tilt ta-
ble or positioner, for example.

Overview Calibration of an external kinematic system consists of 2 steps:

5.7.6.1 Calibrating the root point

Description In order to be able to move the robot with a mathematical coupling to a kine-
matic system, the robot must know the precise location of the kinematic sys-
tem. This location is determined by means of root point calibration.

The TCP of a tool that has already been calibrated is moved to a reference 
point on the kinematic system 4 times. The position of the reference point must 
be different each time. This is achieved by moving the axes of the kinematic 
system. The robot controller uses the different positions of the reference point 
to calculate the root point of the kinematic system.

In the case of external kinematic systems from KUKA, the reference point is 
configured in the system variable $ETx_TPINFL in the machine data. This 
contains the position of the reference point relative to the FLANGE coordinate 
system of the kinematic system. (x = number of the kinematic system.) The ref-
erence point is also marked on the kinematic system. During calibration, this 
reference point must be addressed.

In the case of non-KUKA external kinematic systems, the reference point must 
be configured in the machine data.

For linear units, the type of calibration described here must not be 
used. A separate type of calibration must be used for linear units. 
 (>>> 5.7.5 "Linear unit" Page 123)

Step Description

1 Calibrate the root point of the external kinematic system.

 (>>> 5.7.6.1 "Calibrating the root point" Page 126)

If the calibration data are already known, they can be entered 
directly.

 (>>> 5.7.6.2 "Entering the root point numerically" Page 127)

2 If there is a workpiece on the external kinematic system: cali-
brate the base of the workpiece.

 (>>> 5.7.6.3 "Workpiece base calibration" Page 128)

If the calibration data are already known, they can be entered 
directly.

 (>>> 5.7.6.4 "Entering the workpiece base numerically" 
Page 130)

If there is a tool mounted on the external kinematic system: 
calibrate the external tool.

 (>>> 5.7.6.5 "Calibrating an external tool" Page 130)

If the calibration data are already known, they can be entered 
directly.

 (>>> 5.7.6.6 "Entering the external tool numerically" 
Page 131)
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The robot controller saves the coordinates of the root point as the BASE coor-
dinate system.

Precondition  The machine data of the kinematic system have been configured and load-
ed into the robot controller.

 The number of the external kinematic system is known.

 A previously calibrated tool is mounted on the mounting flange.

 If $ETx_TPINFL is to be modified: user group “Expert”

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > External kinematic sys-
tem > Root point.

2. Select the number of the BASE coordinate system the root point is to be 
saved as. Confirm with Next.

3. Enter the number of the external kinematic system.

4. Assign a name for the external kinematic system. Confirm with Next.

5. Enter the number of the reference tool. Confirm with Next.

6. The value of $ETx_TPINFL is displayed.

 If the value is not correct: the value can be modified here in the user 
group “Expert”.

 If the value is correct: confirm with Next.

7. Move the TCP to the reference point.

8. Press Calibrate. Confirm with Next.

9. Repeat steps 7 and 8 three times. Each time, move the kinematic system 
first so that the reference point is approached from different positions.

10. Press Save.

5.7.6.2 Entering the root point numerically

Precondition  The following numerical values are known, e.g. from CAD data:

 Distance between the origin of the ROOT coordinate system and the 
origin of the WORLD coordinate system (X, Y, Z)

Fig. 5-33: Root point calibration principle
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 Orientation of the ROOT coordinate system relative to the WORLD co-
ordinate system (A, B, C)

 The number of the external kinematic system is known.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > External kinematic sys-
tem > Root point (numeric).

2. Select the number of the BASE coordinate system the root point is to be 
saved as. Confirm with Next.

3. Enter the number of the external kinematic system.

4. Assign a name for the external kinematic system. Confirm with Next.

(The name is automatically also assigned to the BASE coordinate sys-
tem.)

5. Enter the data of the ROOT coordinate system. Confirm with Next.

6. Press Save.

5.7.6.3 Workpiece base calibration

Description During this calibration, the user assigns a BASE coordinate system to a work-
piece located on the kinematic system. This BASE coordinate system is rela-
tive to the FLANGE coordinate system of the kinematic system. The base is 
thus a moving base that moves in the same way as the kinematic system.

It is not strictly necessary to calibrate a base. If none is calibrated, the 
FLANGE coordinate system of the kinematic system is taken as the base.

During calibration, the TCP of a calibrated tool is moved to the origin and 2 oth-
er points of the desired base. These 3 points define the base. Only one base 
can be calibrated per kinematic system.



129 / 237Issued: 22.01.2013 Version: KSS 8.3 END V1 en (PDF)

5 Start-up and recommissioning

Precondition  The machine data of the kinematic system have been configured and load-
ed into the robot controller.

 A previously calibrated tool is mounted on the mounting flange.

 The root point of the external kinematic system has been calibrated.

 The number of the external kinematic system is known.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > External kinematic sys-
tem > Offset.

2. Enter the number of the BASE coordinate system the root point was saved 
as. The name of the BASE coordinate system is displayed.

Confirm with Next.

3. Enter the number of the external kinematic system. The name of the ex-
ternal kinematic system is displayed. 

Confirm with Next.

Fig. 5-34: Base calibration principle
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4. Enter the number of the reference tool. Confirm with Next.

5. Move the TCP to the origin of the workpiece base. Press Calibrate and 
confirm with Next.

6. Move the TCP to a point on the positive X axis of the workpiece base. 
Press Calibrate and confirm with Next.

7. Move the TCP to a point in the XY plane with a positive Y value. Press Cal-
ibrate and confirm with Next.

8. Press Save.

5.7.6.4 Entering the workpiece base numerically

Precondition  The following numerical values are known, e.g. from CAD data:

 Distance between the origin of the workpiece base and the origin of the 
FLANGE coordinate system of the kinematic system (X, Y, Z)

 Rotation of the axes of the workpiece base relative to the FLANGE co-
ordinate system of the kinematic system (A, B, C) 

 The root point of the external kinematic system has been calibrated.

 The number of the external kinematic system is known.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > External kinematic sys-
tem > Offset (numeric).

2. Enter the number of the BASE coordinate system the root point was saved 
as. The name of the BASE coordinate system is displayed.

Confirm with Next.

3. Enter the number of the external kinematic system. The name of the ex-
ternal kinematic system is displayed. 

Confirm with Next.

4. Enter data. Confirm with Next.

5. Press Save.

5.7.6.5 Calibrating an external tool

Description During calibration of the external tool, the user assigns a coordinate system to 
the tool mounted on the kinematic system. This coordinate system has its or-
igin in the TCP of the external tool and is relative to the FLANGE coordinate 
system of the kinematic system.

First of all, the user communicates to the robot controller the TCP of the tool 
mounted on the kinematic system. This is done by moving a calibrated tool to 
the TCP.

Then, the orientation of the coordinate system of the tool is communicated to 
the robot controller. For this purpose, the user aligns the coordinate system of 
the calibrated tool parallel to the new coordinate system. There are 2 variants:

 5D: The user communicates the tool direction to the robot controller. By 
default, the tool direction is the X axis. The orientation of the other axes is 
defined by the system and cannot be influenced by the user.

The system always defines the orientation of the other axes in the same 
way. If the tool subsequently has to be calibrated again, e.g. after a crash, 
it is therefore sufficient to define the tool direction again. Rotation about 
the tool direction need not be taken into consideration.

 6D: The user communicates the direction of all 3 axes to the robot control-
ler.
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The robot controller saves the coordinates of the external tool as the BASE co-
ordinate system.

Precondition  The machine data of the kinematic system have been configured and load-
ed into the robot controller.

 A previously calibrated tool is mounted on the mounting flange.

 The root point of the external kinematic system has been calibrated.

 The number of the external kinematic system is known.

 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Fixed tool > External ki-
nematic offset.

2. Enter the number of the BASE coordinate system the root point was saved 
as. The name of the BASE coordinate system is displayed.

Confirm with Next.

3. Enter the number of the external kinematic system. The name of the ex-
ternal kinematic system is displayed. 

Confirm with Next.

4. Enter the number of the reference tool. Confirm with Next.

5. Select a variant in the box 5D/6D. Confirm with Next.

6. Move the TCP of the calibrated tool to the TCP of the external tool. Press 
Calibrate and confirm with Next.

7. If 5D is selected: 

Align +XBASE parallel to -ZFLANGE.

(i.e. align the mounting flange perpendicular to the tool direction of the ex-
ternal tool.)

If 6D is selected: 

Align the mounting flange so that its axes are parallel to the axes of the 
external tool:

 +XBASE parallel to -ZFLANGE

(i.e. align the mounting flange perpendicular to the tool direction of the 
external tool.)

 +YBASE parallel to +YFLANGE

 +ZBASE parallel to +XFLANGE

8. Press Calibrate and confirm with Next.

9. Press Save.

5.7.6.6 Entering the external tool numerically

Precondition  The following numerical values are known, e.g. from CAD data:

 Distance between the TCP of the external tool and the origin of the 
FLANGE coordinate system of the kinematic system (X, Y, Z)

 Rotation of the axes of the external tool relative to the FLANGE coor-
dinate system of the kinematic system (A, B, C) 

If 6D is selected: it is advisable to document the alignment of all axes. 
If the tool subsequently has to be calibrated again, e.g. after a crash, 
the axes must be aligned the same way as the first time in order to be 

able to continue moving to existing points correctly.

The following procedure applies if the tool direction is the default tool 
direction (= X axis). If the tool direction has been changed to Y or Z, 
the procedure must also be changed accordingly. 
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 Operating mode T1

Procedure 1. In the main menu, select Start-up > Calibrate > Fixed tool > Numeric in-
put.

2. Assign a number and a name for the external tool. Confirm with Next.

3. Enter data. Confirm with Next.

4. Press Save.

5.8 Load data

The load data are factored into the calculation of the paths and accelerations 
and help to optimize the cycle times. The load data must be entered in the ro-
bot controller.

Sources Load data can be obtained from the following sources:

 Software option KUKA.LoadDataDetermination (only for payloads on the 
flange)

 Manufacturer information

 Manual calculation

 CAD programs

5.8.1 Checking loads with KUKA.Load

All load data (payload and supplementary loads) must be checked with the 
KUKA.Load software. Exception: If the payload is checked with KUKA.Load-
DataDetermination, it is not necessary to check it with KUKA.Load.

A sign-off sheet can be generated for the loads with KUKA.Load. KUKA.Load 
can be downloaded free of charge, complete with the documentation, from the 
KUKA website www.kuka.com.

5.8.2 Calculating payloads with KUKA.LoadDataDetermination

Description KUKA.LoadDataDetermination can be used to calculate payloads exactly and 
transfer them to the robot controller. 

Precondition  T1 or T2 operating mode

 No program is selected.

Procedure  In the main menu, select Start-up > Service > Load data determination.

5.8.3 Entering payload data

Description The payload data must be entered in the robot controller and assigned to the 
correct tool.

Exception: If the payload data have already been transferred to the robot con-
troller by KUKA.LoadDataDetermination, no manual entry is required.

More information is contained in the KUKA.Load documentation.

More information is contained in the KUKA.LoadDataDetermination 
documentation.
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Precondition  The payload data have been checked with KUKA.Load or KUKA.Load-
DataDetermination and the robot is suitable for these payloads.

Procedure 1. In the main menu, select Start-up > Calibrate > Tool > Payload data.

2. Enter the number of the tool in the box Tool no.. Confirm with Next.

3. Enter the payload data:

 Box M: Mass

 Boxes X, Y, Z: Position of the center of gravity relative to the flange

 Boxes A, B, C: Orientation of the principal inertia axes relative to the 
flange

 Boxes JX, JY, JZ: Mass moments of inertia

(JX is the inertia about the X axis of the coordinate system that is ro-
tated relative to the flange by A, B and C. JY and JZ are the analogous 
inertia about the Y and Z axes.)

Or, if the default values for this robot type are to be used: press Default.

4. If online load data verification is available (this depends on the robot type): 
configure as required.

 (>>> 5.8.5 "Online load data check" Page 133)

5. Confirm with Next.

6. Press Save.

5.8.4 Entering supplementary load data

Description The supplementary load data must be entered in the robot controller.

Reference systems of the X, Y and Z values for each supplementary load:

Precondition  The supplementary loads have been verified with KUKA.Load and are 
suitable for this robot type.

Procedure 1. In the main menu, select Setup > Measure > Supplementary load data.

2. Enter the number of the axis on which the supplementary load is to be 
mounted. Confirm with Continue.

3. Enter the load data. Confirm with Continue.

4. Press Save.

5.8.5 Online load data check

Configuration OLDC can be configured as follows:

 During manual entry of the tool data

 (>>> 5.7.1.5 "Numeric input" Page 114)

 During separate entry of the payload data

 (>>> 5.8.3 "Entering payload data" Page 132)

Load Reference system

Supplementary load 
A1

ROBROOT coordinate system

A1 = 0°

Supplementary load 
A2

ROBROOT coordinate system

A2 = -90°

Supplementary load 
A3

FLANGE coordinate system

A4 = 0°, A5 = 0°, A6 = 0°
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The following boxes are displayed in the same window in which the payload 
data are also entered:

The reactions can be modified in the KRL program using the system variable 
$LDC_CONFIG. 

5.9 Exporting/importing long texts

Description If names have been assigned to inputs/outputs, flags, etc., these names (so-
called “long texts”) can be exported to a file. It is also possible to import a file 
with long text names. In this way, the long texts do not need to be re-entered 
manually for each robot after reinstallation.

Precondition  USB memory stick

For import only:

 The long text names are present on the stick in a TXT or CSV file.

 The file structure is suitable for importing.

If the file to be imported was generated by means of a long text export, it is 
automatically suitable. If the file is to be created manually, it is advisable first 
to assign a few dummy long text names in the robot controller, perform an ex-
port and adopt the structure of the exported file.

Procedure 1. Plug the USB stick into the cabinet or smartPAD.

2. In the main menu, select Start-up > Service > Long texts. The Long 
texts window is opened.

3. Select the Export or Import tab as required. Make the desired settings.

Fig. 5-35: Online load data check

Item Description

1 TRUE: OLDC is activated for the tool displayed in the same win-
dow. The defined reactions are carried out in the case of an over-
load or underload.

FALSE: OLDC is deactivated for the tool displayed in the same 
window. There is no reaction in the case of an overload or under-
load.

2 The overload reaction can be defined here.

 None: No reaction.

 Warning: The robot controller generates the following status 
message: Check of robot load (Tool {No.}) calculated overload.

 Stop robot: The robot controller generates an acknowledge-
ment message with the same content as that generated under 
Warning. The robot stops with a STOP 2.

3 The underload reaction can be defined here. The possible reac-
tions are analogous to those for an overload.
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4. Press the Export or Import button.

When the import is finished, the message Import successful. is displayed.

When the export is finished, the message Export successful. is displayed.

“Export” tab

“Import” tab

Fig. 5-36: Exporting long texts

Item Description

1 Select the destination for the exported file.

2 Specify the desired file name.

A suffix corresponding to the language selected is automatically 
appended to the name.

3 Select the language from which the long texts are to be exported. 
If, for example, the smartHMI is set to “English” and “Italiano” is 
selected here, a file with the suffix “it” is created. It contains the 
long texts that have been stored on the Italian smartHMI. 

It is also possible to select All languages.

4 Select the desired file format.

5 Starts the export.

Fig. 5-37: Importing long texts

Item Description

1 Specify where the stick with the import file is plugged in.

2 Specify the name of the import file, but without the language suffix.

3 Specify the language matching the language suffix of the import 
file.
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5.10 Maintenance handbook

The Maintenance handbook functionality is available in the KUKA System 
Software. The maintenance handbook enables logging of the maintenance 
work. The logged maintenance work can be displayed in an overview.

The robot controller uses messages to indicate when maintenance is due:

 A message is generated one month before the maintenance work is due. 
This message can be acknowledged.

 At the end of the month, the robot controller generates a message indicat-
ing that the maintenance is now due. This message cannot be acknowl-
edged. Additionally, LED4 on the Controller System Panel flashes (= first 
LED from the left in the bottom row).

Only when the corresponding maintenance work has been logged does 
the robot controller reset the message and the LED stops flashing.

The due dates are determined by the maintenance intervals specified in the 
KUKA maintenance agreements. The intervals are counted from the initial 
start-up of the robot controller. The operating hours of the robot are counted.

5.10.1 Logging maintenance

Description It is not possible to log multiple maintenance activities of the same kind on one 
day.

Precondition  “Expert” user group

Procedure 1. In the main menu, select Start-up > Service > Maintenance handbook. 
The Maintenance handbook window is opened.

2. Select the Maintenance input tab and enter the maintenance details. En-
tries must be made in all boxes.

3. Press Save. A request for confirmation is displayed.

4. If all entries are correct, answer the request for confirmation with Yes.

The entries are now saved. Switching to the Maintenance overview tab 
causes the maintenance to be displayed there. 

4 Specify the format of the import file.

5  Activated: The existing long text names are retained. New en-
tries will be added.

 Deactivated: The existing long text names are deleted and re-
placed by the new entries.

6 Starts the import.

Item Description

The controller variant “KR C4 compact” has no Controller System 
Panel and no flashing lights to indicate when maintenance work is 
due.

Once saved, changes can no longer be made.



137 / 237Issued: 22.01.2013 Version: KSS 8.3 END V1 en (PDF)

5 Start-up and recommissioning

Maintenance 

types

By default, the following maintenance types can be selected:

 Basic inspection

 In-line wrist maintenance

 Main axis maintenance

 Gear backlash measurement

 Minor electrical maintenance

 Major electrical maintenance

 Data backup with spare hard drive

 Repair

These maintenance types correspond to those in the KUKA maintenance 
agreements. Depending on the options used (e.g. linear axis or technology 
packages), other maintenance types may be available for selection.

5.10.2 Displaying a maintenance log

Description The logged maintenance work can be displayed in an overview.

If the KUKA System Software is updated (e.g. from KSS 8.3.1 to KSS 8.3.2), 
this overview is retained.

Fig. 5-38: Maintenance input

Item Description

1 Select which type of maintenance has been carried out.

2 Enter who performed the maintenance.

3 For maintenance carried out and logged by KUKA employees: en-
ter the order number.

For other maintenance: enter any number.

4 Enter a comment.
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When archiving is carried out, the maintenance logs are also archived. If, 
when the data are restored, other maintenance work has been logged on the 
robot controller in the meantime, these logs are not overwritten; instead, the 
restored logs are added to the overview.

Procedure 1. In the main menu, select Start-up > Service > Maintenance handbook. 
The Maintenance handbook window is opened.

2. Select the Maintenance overview tab.

Fig. 5-39: Maintenance overview
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6 Program management

6.1 Navigator file manager

Overview

Description In the Navigator, the user manages programs and system-specific files.

Header

 Left-hand area: the selected filter is displayed.

 (>>> 6.1.1 "Selecting filters" Page 140)

 Right-hand area: the directory or drive selected in the directory structure 
is displayed.

Directory structure

Overview of directories and drives. Exactly which directories and drives are 
displayed depends on the user group and configuration.

File list

The contents of the directory or drive selected in the directory structure are dis-
played. The manner in which programs are displayed depends on the selected 
filter.

The file list has the following columns:

Fig. 6-1: Navigator

1 Header 3 File list

2 Directory structure 4 Status bar
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Status bar

The status bar can display the following information:

 Selected objects

 Action in progress

 User dialogs

 User entry prompts

 Requests for confirmation

6.1.1 Selecting filters

Description This function is not available in the user group “User”.

The filter defines how programs are displayed in the file list. The following fil-
ters are available:

 Detail

Programs are displayed as SRC and DAT files. (Default setting)

 Modules

Programs are displayed as modules.

Precondition  “Expert” user group

Procedure 1. Select the menu sequence Edit > Filter.

2. Select the desired filter in the left-hand section of the Navigator.

3. Confirm with OK.

6.1.2 Creating a new folder

Precondition  The Navigator is displayed.

Procedure 1. In the directory structure, select the folder in which the new folder is to be 
created, e.g. the folder R1. 

Not all folders allow the creation of new folders within them. In the user 
groups “Operator” and “User”, new folders can only be created in the folder 
R1.

2. Press New. 

3. Enter a name for the folder and confirm it with OK.

Column Description

Name Directory or file name

Extension File extension

This column is not displayed in the user group “User”.

Comment Comment

Attributes Attributes of the operating system and kernel system

This column is not displayed in the user group “User”.

Size File size in kilobytes

This column is not displayed in the user group “User”.

# Number of changes made to the file

Changed Date and time of the last change

Created Date and time of file creation

This column is not displayed in the user group “User”.
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6.1.3 Creating a new program

Description It is not possible to select a template in the user group “User”. By default, a 
program of type “Module” is created.

Precondition  The Navigator is displayed.

Procedure 1. In the directory structure, select the folder in which the program is to be 
created, e.g. the folder Program. (Not all folders allow the creation of pro-
grams within them.)

2. Press New. 

3. Only in the user group “Expert”:

The Template selection window is opened. Select the desired template 
and confirm with OK.

4. Enter a name for the program and confirm it with OK.

6.1.4 Renaming a file

Precondition  The Navigator is displayed.

Procedure 1. In the directory structure, select the folder in which the file is located.

2. Select the file in the file list.

3. Select Edit > Rename.

4. Overwrite the file name with the new name and confirm with OK.

6.2 Selecting or opening a program

Overview A program can be selected or opened. Instead of the Navigator, an editor is 
then displayed with the program.

 (>>> 6.2.1 "Selecting and deselecting a program" Page 142)

 (>>> 6.2.2 "Opening a program" Page 143)

It is possible to toggle backwards and forwards between the program display 
and the Navigator.

 (>>> 6.2.3 "Toggling between the Navigator and the program" Page 143)

Differences Program is selected:

 The block pointer is displayed.

 The program can be started.

 The program can be edited to a certain extent.

Selected programs are particularly suitable for editing in the user group 
“User”.

Example: KRL instructions covering several lines (e.g. LOOP … END-
LOOP) are not permissible.

 When the program is deselected, modifications are accepted without a re-
quest for confirmation. If impermissible modifications are programmed, an 
error message is displayed.

Program is opened:

 The program cannot be started.

 The program can be edited.

Opened programs are particularly suitable for editing in the user group 
“Expert”.

 A request for confirmation is generated when the program is closed. Mod-
ifications can be accepted or rejected.
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6.2.1 Selecting and deselecting a program

Precondition  T1, T2 or AUT mode

Procedure 1. Select the program in the Navigator and press Select. 

The program is displayed in the editor. It is irrelevant whether a module, 
an SRC file or a DAT file is selected. It is always the SRC file that is dis-
played in the editor.

2. Start or edit the program.

3. Deselect the program again: 

Select Edit > Cancel program.

Or: In the status bar, touch the Robot interpreter status indicator. A win-
dow opens. Select Cancel program.

If the program is running, it must be stopped before it can be deselected.

Description If a program is selected, this is indicated by the Robot interpreter status indi-
cator.

 (>>> 6.5.6 "Robot interpreter status indicator" Page 148)

If a selected program is edited in the user group “Expert”, the cursor 
must then be removed from the edited line and positioned in any other 
line! 

Only in this way is it certain that the editing will be applied when the program 
is deselected again.

When the program is deselected, modifications are accepted without 
a request for confirmation!

Fig. 6-2: Program is selected

1 Block pointer

2 Cursor

3 Program path and file name
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6.2.2 Opening a program

Precondition  T1, T2 or AUT mode

A program can be opened in AUT EXT mode, but not edited.

Procedure 1. Select the program in the Navigator and press Open. The program is dis-
played in the editor.

If a module has been selected, the SRC file is displayed in the editor. If an 
SRC file or DAT file has been selected, the corresponding file is displayed 
in the editor.

2. Edit the program.

3. Close the program.

4. To accept the changes, answer the request for confirmation with Yes.

Description

6.2.3 Toggling between the Navigator and the program

Description If a program is selected or open, it is possible to display the Navigator again 
without having to deselect or close the program. The user can then return to 
the program.

Procedure Program is selected:

 Toggling from the program to the Navigator: select the menu sequence 
Edit > Navigator.

 Toggling from the Navigator to the program: press PROGRAM.

4 Position of the cursor in the program

5 The icon indicates that the program is selected.

Fig. 6-3: Program is open

1 Cursor

2 Program path and file name

3 Position of the cursor in the program
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Program is open:

 Toggling from the program to the Navigator: select the menu sequence 
Edit > Navigator.

 Toggling from the Navigator to the program: press EDITOR.

6.3 Structure of a KRL program

The first motion instruction in a KRL program must define an unambiguous 
starting position. The HOME position, which is stored by default in the robot 
controller, ensures that this is the case.

If the first motion instruction is not the default HOME position, or if this position 
has been changed, one of the following statements must be used:

 Complete PTP instruction of type POS or E6POS

 Complete PTP instruction of type AXIS or E6AXIS

“Complete” means that all components of the end point must be specified.

Programs that are running or have been interrupted must first be 
stopped before the menu sequences and buttons referred to above 
are available.

1  DEF my_program( )
2  INI
3
4  PTP HOME  Vel= 100 % DEFAULT
   ...
8  LIN point_5 CONT Vel= 2 m/s CPDAT1 Tool[3] Base[4]
   ...
14 PTP point_1 CONT Vel= 100 % PDAT1 Tool[3] Base[4]
   ...
20 PTP HOME  Vel= 100 % DEFAULT
21
22 END

Line Description

1 The DEF line indicates the name of the program. If the pro-
gram is a function, the DEF line begins with “DEFFCT” and 
contains additional information. The DEF line can be dis-
played or hidden.

 (>>> 6.4.1 "Displaying/hiding the DEF line" Page 145)

2 The INI line contains initializations for internal variables and 
parameters.

4 HOME position

 (>>> 6.3.1 "HOME position" Page 145)

8 LIN motion

 (>>> 8.2.3 "Programming a LIN motion" Page 180)

14 PTP motion

 (>>> 8.2.1 "Programming a PTP motion" Page 179)

20 HOME position

22 The END line is the last line in any program. If the program is 
a function, the wording of the END line is “ENDFCT”. The 
END line must not be deleted!

If the HOME position is modified, this affects all pro-
grams in which it is used. Injuries or damage to property 

may result.



145 / 237Issued: 22.01.2013 Version: KSS 8.3 END V1 en (PDF)

6 Program management

In programs that are used exclusively as subprograms, different statements 
can be used as the first motion instruction.

6.3.1 HOME position

The HOME position is not program-specific. It is generally used as the first and 
last position in the program as it is uniquely defined and uncritical.

The HOME position is stored by default with the following values in the robot 
controller:

Additional HOME positions can be taught. A HOME position must meet the fol-
lowing conditions:

 Good starting position for program execution

 Good standstill position. For example, the stationary robot must not be an 
obstacle.

6.4 Displaying/hiding program sections

6.4.1 Displaying/hiding the DEF line

Description By default, the DEF line is hidden. Declarations can only be made in a program 
if the DEF line is visible.

The DEF line is displayed and hidden separately for opened and selected pro-
grams. If detail view (ASCII mode) is activated, the DEF line is visible and does 
not need to be activated separately.

Precondition  User group “Expert”

 Program is selected or open.

Procedure  Select the menu sequence Edit > View > DEF line.

Check mark activated in menu: DEF line is displayed.

Check mark not activated in menu: DEF line is hidden.

6.4.2 Activating detail view

Description Detail view (ASCII mode) is deactivated by default to keep the program trans-
parent. If detail view is activated, hidden program lines, such as the FOLD and 
ENDFOLD lines and the DEF line, are displayed.

Detail view is activated and deactivated separately for opened and selected 
programs.

Precondition  “Expert” user group

Procedure  Select the menu sequence Edit > View > Detail view (ASCII).

Check box activated: Detail view is activated.

Check box deactivated: Detail view is deactivated.

Axis A1 A2 A3 A4 A5 A6

Pos. 0° - 90° + 90° 0° 0° 0°

If the HOME position is modified, this affects all pro-
grams in which it is used. Injuries or damage to property 

may result.
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6.4.3 Activating/deactivating the line break function

Description If a line is wider than the program window, the line is broken by default. The 
part of the line after the break has no line number and is marked with a black, 
L-shaped arrow. The line break function can be deactivated.

The line break function is activated and deactivated separately for opened and 
selected programs.

Precondition  User group “Expert”

 Program is selected or open.

Procedure  Select the menu sequence Edit > View > Line break.

Check mark activated in menu: line break function is activated.

Check mark not activated in menu: line break function is deactivated.

6.5 Starting a program

6.5.1 Selecting the program run mode

Procedure 1. Touch the Program run mode status indicator. The Program run mode 
window is opened.

2. Select the desired program run mode.

 (>>> 6.5.2 "Program run modes" Page 146)

The window closes and the selected program run mode is applied.

6.5.2 Program run modes

Fig. 6-4: Line break

Program run mode Description

Go

#GO

The program is executed through to the 
end without stopping.

Motion Step

#MSTEP

The program is executed with a stop after 
each motion block. The Start key must be 
pressed again for each motion block. The 
program is executed without advance pro-
cessing.

Single Step

#ISTEP

The program is executed with a stop after 
each program line. Program lines that can-
not be seen and blank lines are also taken 
into consideration. The Start key must be 
pressed again for each line. The program is 
executed without advance processing.

Single Step is only available to the user 
group “Expert”.

Backward

#BSTEP

This program run mode is automatically 
selected if the Start backwards key is 
pressed.
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6.5.3 Advance run

The advance run is the maximum number of motion blocks that the robot con-
troller calculates and plans in advance during program execution. The actual 
number is dependent on the capacity of the computer. The default value is 3. 
The advance run refers to the current position of the block pointer. The ad-
vance run is required, for example, in order to be able to calculate approximate 
positioning motions.

Certain statements trigger an advance run stop. These include statements 
that influence the periphery, e.g. OUT statements.

6.5.4 Setting the program override (POV)

Description Program override is the velocity of the robot during program execution. The 
program override is specified as a percentage of the programmed velocity.

Procedure 1. Touch the POV/HOV status indicator. The Overrides window is opened.

2. Set the desired program override. It can be set using either the plus/minus 
keys or by means of the slide controller.

 Plus/minus keys: The value can be set to 100%, 75%, 50%, 30%, 
10%, 3%, 1%

 Slide controller: The override can be adjusted in 1% steps.

3. Touch the POV/HOV status indicator again. (Or touch the area outside the 
window.) 

The window closes and the selected override value is applied.

Alternative 

procedure

Alternatively, the override can be set using the plus/minus key on the right-
hand side of the KCP.

The value can be set to 100%, 75%, 50%, 30%, 10%, 3%, 1%.

6.5.5 Switching drives on/off

The status of the drives is indicated in the status bar. The drives can also be 
switched on or off here.

In T1 mode, the maximum velocity is 250 mm/s, irrespective of the 
value that is set.

The Jog options window can be opened via Options in the Over-
rides window.

Icon Color Description

Green Drives ready

Gray Drives not ready
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6.5.6 Robot interpreter status indicator

6.5.7 Starting a program forwards (manual)

Precondition  A program is selected.

 Operating mode T1 or T2

Procedure 1. Select the program run mode.

2. Hold the enabling switch down and wait until the status bar indicates 
“Drives ready”:

3. Carry out a BCO run: Press Start key and hold it down until the message 
“Programmed path reached (BCO)” is displayed in the message window. The 
robot stops.

4. Press Start key and hold it down.

The program is executed with or without stops, depending on the program 
run mode.

To stop a program that has been started manually, release the Start key.

6.5.8 Starting a program forwards (automatic)

Precondition  A program is selected.

 Operating mode Automatic (not Automatic External)

Procedure 1. Select the program run mode Go.

2. Switch on the drives.

3. Carry out a BCO run: 

Icon Color Description

Gray No program is selected.

Yellow The block pointer is situated on the first line 
of the selected program.

Green The program is selected and is being exe-
cuted.

Red The selected and started program has been 
stopped.

Black The block pointer is situated at the end of 
the selected program.

Fig. 6-5

A BCO run is always executed as a PTP motion from the 
actual position to the target position. Observe the motion 

to avoid collisions. The velocity is automatically reduced during the BCO run.
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Press Start key and hold it down until the message “Programmed path 
reached (BCO)” is displayed in the message window. The robot stops.

4. Press the Start key. The program is executed.

To stop a program that has been started in Automatic mode, press the STOP 
key.

6.5.9 Carrying out a block selection

Description A program can be started at any point by means of a block selection.

Precondition  A program is selected.

 Operating mode T1 or T2

Procedure 1. Select the program run mode.

2. Select the motion block at which the program is to be started.

3. Press Block selection. The block pointer indicates the motion block.

4. Hold the enabling switch down and wait until the status bar indicates 
“Drives ready”:

5. Carry out a BCO run: Press Start key and hold it down until the message 
“Programmed path reached (BCO)” is displayed in the message window. The 
robot stops.

6. The program can now be started manually or automatically. It is not nec-
essary to carry out a BCO run again.

6.5.10 Starting a program backwards

Description In the case of backward motion, the robot stops at every point. Approximate 
positioning is not possible.

Precondition  A program is selected.

 Operating mode T1 or T2

Procedure 1. Hold the enabling switch down and wait until the status bar indicates 
“Drives ready”:

2. Carry out a BCO run: Press Start key and hold it down until the message 
“Programmed path reached (BCO)” is displayed in the message window. The 
robot stops.

A BCO run is always executed as a PTP motion from the 
actual position to the target position. Observe the motion 

to avoid collisions. The velocity is automatically reduced during the BCO run.

A BCO run is always executed as a PTP motion from the 
actual position to the target position. Observe the motion 

to avoid collisions. The velocity is automatically reduced during the BCO run.

A BCO run is always executed as a PTP motion from the 
actual position to the target position. Observe the motion 

to avoid collisions. The velocity is automatically reduced during the BCO run.
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3. Press Start backwards key.

4. Press Start backwards key again for each motion block.

6.5.11 Resetting a program

Description In order to restart an interrupted program from the beginning, it must be reset. 
This returns the program to the initial state.

Precondition  Program is selected.

Procedure  Select the menu sequence Edit > Reset program.

Alternative 

procedure

 In the status bar, touch the Robot interpreter status indicator. A window 
opens.

Select Reset program.

6.5.12 Starting Automatic External mode

Precondition  Operating mode T1 or T2

 Inputs/outputs for Automatic External are configured.

 The program CELL.SRC is configured.

Procedure 1. Select the program CELL.SRC in the Navigator. (This program is located 
in the folder “R1”.)

2. Set program override to 100%. (This is the recommended setting. A differ-
ent value can be set if required.)

3. Carry out a BCO run: 

Hold down the enabling switch. Then press the Start key and hold it down 
until the message “Programmed path reached (BCO)” is displayed in the 
message window.

4. Select “Automatic External” mode.

5. Start the program from a higher-level controller (PLC).

To stop a program that has been started in Automatic mode, press the STOP 
key.

6.6 Editing a program

Overview  A running program cannot be edited.

 Programs cannot be edited in AUT EXT mode.

There is no BCO run in Automatic External mode. This 
means that the robot moves to the first programmed po-

sition after the start at the programmed (not reduced) velocity and does not 
stop there.

A BCO run is always executed as a PTP motion from the 
actual position to the target position. Observe the motion 

to avoid collisions. The velocity is automatically reduced during the BCO run.

If a selected program is edited in the user group “Expert”, the cursor 
must then be removed from the edited line and positioned in any other 
line! 

Only in this way is it certain that the editing will be applied when the program 
is deselected again.
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Action Possible in user group …?

Insert comment or 
stamp               User: Yes

              Expert: Yes

Delete lines
              User: Yes

              Expert: Yes

Create folds
              User: No

              Expert: Yes

Copy
              User: No

              Expert: Yes

Paste
              User: No

              Expert: Yes

Insert blank lines 
(press the Enter key)               User: No

              Expert: Yes

Cut
              User: No

              Expert: Yes

Find
              User: Yes

              Expert: Yes

Possible for all user groups in an open program, 
even in AUT EXT mode.

Replace
              User: No

              Expert: Yes (program is open, not 
selected)

Programming with 
inline forms               User: Yes

              Expert: Yes

KRL programming
              User: Possible to a certain extent. KRL 
instructions covering several lines (e.g. 
LOOP … ENDLOOP) are not permissible.

              Expert: Yes
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6.6.1 Inserting a comment or stamp

Precondition  Program is selected or open.

 Operating mode T1

Procedure 1. Select the line after which the comment or stamp is to be inserted.

2. Select the menu sequence Commands > Comment > Normal or Stamp.

3. Enter the desired data. If a comment or stamp has already been entered 
previously, the inline form still contains the same entries.

 In the case of a comment, the box can be cleared using New text 
ready for entry of a new text.

 In the case of a stamp, the system time can also be updated using 
New time and the NAME box can be cleared using New name.

4. Save with Cmd Ok.

Description 

Comment

Description 

Stamp

A stamp is a comment that is extended to include the system date and time 
and the user ID.

6.6.2 Deleting program lines

Description If a program line containing a motion instruction is deleted, the point name and 
coordinates remain saved in the DAT file. The point can be used in other mo-
tion instructions and does not need to be taught again.

Precondition  Program is selected or open.

 Operating mode T1

Procedure 1. Select the line to be deleted. (The line need not have a colored back-
ground. It is sufficient for the cursor to be in the line.)

Fig. 6-6: Inline form “Comment”

Item Description

1 Any text

Fig. 6-7: Inline form “Stamp”

Item Description

1 System date (cannot be edited)

2 System time

3 Name or ID of the user

4 Any text

Lines cannot be restored once they have been deleted!
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If several consecutive lines are to be deleted: drag a finger or stylus across 
the desired area. (The area must now have a colored background.)

2. Select the menu sequence Edit > Delete.

3. Confirm the request for confirmation with Yes.

6.6.3 Additional editing functions

The following additional program editing functions can be called using Edit:

Copy

Precondition:

 Program is selected or open.

 “Expert” user group

 Operating mode T1

Paste

Precondition:

 Program is selected or open.

 “Expert” user group

 Operating mode T1

Cut

Precondition:

 Program is selected or open.

 “Expert” user group

 Operating mode T1

Find

Precondition:

 Program is selected or open.

Replace

Precondition:

 Program has been opened.

 “Expert” user group

 Operating mode T1

6.7 Printing a program

Procedure 1. Select the program in the Navigator. Multiple program selection is also 
possible.

2. Select the menu sequence Edit > Print.

6.8 Archiving and restoring data

6.8.1 Archiving overview

Target locations Archiving can be performed to the following target destinations:

 USB stick in KCP or robot controller

 Network

Menu items The following menu items are available:
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("*.*" means all files and subdirectories.)

If archiving is carried out using the menu item All and there is an existing ar-
chive present, this will be overwritten.

If archiving is carried out using a menu item other than All or KrcDiag and an 
archive is already available, the robot controller compares its robot name with 

Menu item Archives the directories/files

All  KRC:\*.*

 C:\KRC\Roboter\Config\User\*.*

 C:\KRC\Roboter\Config\System\Common\Mada\*.*

 C:\KRC\Roboter\Init\*.*

 C:\KRC\Roboter\lr_Spec\*.*

 C:\KRC\Roboter\Template\*.*

 C:\KRC\Roboter\Rdc\*.*

 C:\KRC\User\*.*

 C:\KRC\Roboter\log\Mastery.log

 Some additional log data

Applications  KRC:\R1\Program\*.*

 KRC:\R1\System\*.*

 KRC:\R1\cell*.*

 KRC:\Steu\$config*.*

System data  KRC:\R1\Mada\*.*

 KRC:\R1\System\*.*

 KRC:\R1\TP\*.*

 KRC:\Steu\Mada\*.*

 C:\KRC\Roboter\Config\User\*.*

 C:\KRC\Roboter\Config\System\Common\Mada\*.*

 C:\KRC\Roboter\Init\*.*

 C:\KRC\Roboter\lr_Spec\*.*

 C:\KRC\Roboter\Template\*.*

 C:\KRC\Roboter\Rdc\*.*

 C:\KRC\User\*.*

Log data  C:\KRC\Roboter\log\*.*

Except: Poslog.xsl and files with the extension DMP

 Some additional log data

KrcDiag If it is necessary for an error to be analyzed by KUKA 
Roboter GmbH, this menu item can be used to com-
press the data for sending to KUKA.

A screenshot of the current view of the smartHMI is 
automatically generated for the data packet. For this 
reason, display error-relevant information on the 
smartHMI before starting the operation, e.g. expand 
the message window or display the logbook. What 
information is useful here depends on the specific cir-
cumstances.

In addition to the menu sequence File > Archive, there 
are other methods available for compressing these 
data.

 (>>> 6.8.6 "Automatically compressing data for error 
analysis at KUKA" Page 156)
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that in the archive. If the names are different, a request for confirmation is gen-
erated.

If archiving is carried out repeatedly via KrcDiag, a maximum of 10 archives 
can be created. Further archives will overwrite the oldest existing archive.

The logbook can also be activated.  (>>> 6.8.4 "Archiving the logbook" 
Page 156)

6.8.2 Archiving to a USB stick

Description This procedure generates a ZIP file on the stick. By default, this file has the 
same name as the robot. A different name can be defined for the file, however, 
under Robot data.

 (>>> 4.15.12 "Displaying/editing robot data" Page 83)

The archive is displayed in the ARCHIVE:\ directory in the Navigator. Archiving 
is also carried out automatically to D:\ as well as to the stick. The file IN-
TERN.ZIP is generated here. 

Special case KrcDiag: 

This menu item generates the folder KRCDiag on the stick. This contains a 
ZIP file. The ZIP file is also automatically archived in C:\KUKA\KRCDiag.

Procedure 1. Connect the USB stick (to KCP or cabinet).

2. In the main menu, select File > Archive > USB (KCP) or USB (cabinet) 
and then the desired menu item.

3. Confirm the request for confirmation with Yes. The archive is created. 

Once the archiving is completed, this is indicated in the message window.

Special case KrcDiag: If archiving is carried out using this menu item, a 
separate window indicates when archiving has been completed. The win-
dow is then automatically hidden again.

4. The stick can now be removed.

6.8.3 Archiving on the network

Description This procedure generates a ZIP file on the network path. By default, this file 
has the same name as the robot. A different name can be defined for the file, 
however, under Start-up > Robot data.

The network path to which archiving is to be carried out must be configured in 
the Robot data window. If a user name and password are required for ar-
chiving to this path, these can also be entered here. 

 (>>> 4.15.12 "Displaying/editing robot data" Page 83)

The archive is displayed in the ARCHIVE:\ directory in the Navigator. Archiving 
is also carried out automatically to D:\ as well as to the network path. The file 
INTERN.ZIP is generated here. 

Special case KrcDiag: 

This menu item generates the folder KRCDiag on the network path. This con-
tains a ZIP file. The ZIP file is also automatically archived in C:\KUKA\KRCDi-
ag.

Precondition  The network path to which the data are to be archived is configured.

A non-bootable USB stick must be used.
Recommendation: Use a non-bootable KUKA stick. Data 

may be lost if a stick from a different manufacturer is used.
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Procedure 1. In the main menu, select File > Archive > Network and then the desired 
menu item.

2. Confirm the request for confirmation with Yes. The archive is created. 

Once the archiving is completed, this is indicated in the message window. 
Special case KrcDiag: If archiving is carried out using this menu item, a 
separate window indicates when archiving has been completed. The win-
dow is then automatically hidden again.

6.8.4 Archiving the logbook

Description The file “Logbuch.txt” is generated as an archive in the directory C:\KRC\RO-
BOTER\LOG.

Procedure  In the main menu, select File > Archive > Logbook.

The archive is created. Once the archiving is completed, this is indicated 
in the message window. 

6.8.5 Restoring data

Description

The following menu items are available for restoring data:

 All

 Applications

 System data

If the archived files are not the same version as the files present in the system, 
an error message is generated during restoration.

Similarly, if the version of the archived technology packages does not match 
the installed version, an error message is generated.

Precondition  If data are to be restored from the USB stick: a USB stick with the archive 
is connected.

The stick can be connected to the KCP or robot controller.

Procedure 1. In the main menu, select File > Restore and then the desired subitems.

2. Confirm the request for confirmation with Yes. Archived files are restored 
to the robot controller. A message indicates completion of the restoration 
process.

3. If data have been restored from a USB stick: the stick can now be re-
moved.

4. Reboot the robot controller.

6.8.6 Automatically compressing data for error analysis at KUKA

Description If it is necessary for an error to be analyzed by KUKA Roboter GmbH, this pro-
cedure can be used to compress the data for sending to KUKA. The procedure 

Only KSS 8.3 archives may be loaded into KSS 8.3. If 
other archives are loaded, the following may occur:

 Error messages

 Robot controller is not operable.

 Personal injury and damage to property.

A non-bootable USB stick must be used.
Recommendation: Use a non-bootable KUKA stick. Data 

may be lost if a stick from a different manufacturer is used.
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generates a ZIP file in the directory C:\KUKA\KRCDiag. This contains the data 
required by KUKA Roboter GmbH to analyze an error (including information 
about system resources, screenshots, and much more).

Preparation A screenshot of the current view of the smartHMI is automatically generated 
for the data packet. 

 For this reason, display error-relevant information on the smartHMI if pos-
sible before starting the operation, e.g. expand the message window or 
display the logbook.

What information is useful here depends on the specific circumstances.

Procedure via 

“Diagnosis”

 In the main menu, select Diagnosis > KrcDiag. 

The data are compressed. Progress is displayed in a window. Once the 
operation has been completed, this is also indicated in the window. The 
window is then automatically hidden again.

Procedure via 

smartPAD

This procedure uses keys on the smartPAD instead of menu items. It can thus 
also be used if the smartHMI is not available, due to Windows problems for ex-
ample.

Precondition:

 The smartPAD is connected to the robot controller.

 The robot controller is switched on.

1. Press the “Main menu” key and hold it down.

2. Press the keypad key twice.

3. Release the “Main menu” key.

The data are compressed. Progress is displayed in a window. Once the 
operation has been completed, this is also indicated in the window. The 
window is then automatically hidden again.

Procedure via 

“Archive”

Alternatively, the data can also be compressed via File > Archive > [...]. In this 
way, the data can be stored on a USB stick or network path.

 (>>> 6.8 "Archiving and restoring data" Page 153)

The keys must be pressed within 2 seconds. Whether or not the main 
menu and keypad are displayed in the smartHMI is irrelevant.
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7 Basic principles of motion programming

7.1 Overview of motion types

The following motion types can be programmed:

 Point-to-point motions (PTP)

 (>>> 7.2 "Motion type PTP" Page 159)

 Linear motions (LIN)

 (>>> 7.3 "Motion type LIN" Page 160)

 Circular motions (CIRC)

 (>>> 7.4 "Motion type CIRC" Page 160)

 Spline motions

Spline motions have a number of advantages over conventional PTP, LIN 
and CIRC motions.

 (>>> 7.7 "Motion type “Spline”" Page 163)

The following motions are known as CP (“Continuous Path”) motions.

 LIN, CIRC, CP spline blocks, SLIN, SCIRC

7.2 Motion type PTP

The robot guides the TCP along the fastest path to the end point. The fastest 
path is generally not the shortest path and is thus not a straight line. As the 
motions of the robot axes are rotational, curved paths can be executed faster 
than straight paths.

The exact path of the motion cannot be predicted.

The start point of a motion is always the end point of the previous mo-
tion.

Fig. 7-1: PTP motion
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7.3 Motion type LIN

The robot guides the TCP at a defined velocity along a straight path to the end 
point.

7.4 Motion type CIRC

The robot guides the TCP at a defined velocity along a circular path to the end 
point. The circular path is defined by a start point, auxiliary point and end point.

Fig. 7-2: LIN motion

Fig. 7-3: CIRC motion
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7.5 Approximate positioning

Approximate positioning means that the motion does not stop exactly at the 
programmed point. Approximate positioning is an option that can be selected 
during motion programming.

PTP motion

The TCP leaves the path that would lead directly to the end point and moves 
along a faster path. During programming of the motion, the maximum distance 
from the end point at which the TCP may deviate from its original path is de-
fined.

The path of an approximated PTP motion cannot be predicted. It is also not 
possible to predict which side of the approximated point the path will run.

LIN motion

The TCP leaves the path that would lead directly to the end point and moves 
along a shorter path. During programming of the motion, the maximum dis-
tance from the end point at which the TCP may deviate from its original path 
is defined.

The path in the approximate positioning range is not an arc.

CIRC motion

The TCP leaves the path that would lead directly to the end point and moves 
along a shorter path. During programming of the motion, the maximum dis-
tance from the end point at which the TCP may deviate from its original path 
is defined.

The motion always stops exactly at the auxiliary point.

The path in the approximate positioning range is not an arc.

Approximate positioning is not possible if the motion instruction is fol-
lowed by an instruction that triggers an advance run stop.

Fig. 7-4: PTP motion, P2 is approximated

Fig. 7-5: LIN motion, P2 is approximated
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7.6 Orientation control LIN, CIRC

Description The orientation of the TCP can be different at the start point and end point of 
a motion. There are several different types of transition from the start orienta-
tion to the end orientation. A type must be selected when a CP motion is pro-
grammed.

The orientation control for LIN and CIRC motions is defined as follows:

 In the option window Motion parameter

LIN motion

Fig. 7-6: CIRC motion, PEND is approximated

Orientation control Description

Constant orientation The orientation of the TCP remains con-
stant during the motion.

The programmed orientation is disregarded 
for the end point and that of the start point 
is retained.

Standard The orientation of the TCP changes contin-
uously during the motion.

Note: If, with Standard, the robot passes 
through a wrist axis singularity, use Wrist 
PTP instead.

Wrist PTP The orientation of the TCP changes contin-
uously during the motion. This is done by 
linear transformation (axis-specific motion) 
of the wrist axis angles. 

Note: Use Wrist PTP if, with Standard, the 
robot passes through a wrist axis singular-
ity. 
The orientation of the TCP changes contin-
uously during the motion, but not uniformly. 
Wrist PTP is thus not suitable if a specific 
orientation must be maintained exactly, e.g. 
in the case of laser welding.

If a wrist axis singularity occurs with Standard and the desired orien-
tation cannot be maintained exactly enough with Wrist PTP, the fol-
lowing remedy is recommended:

Re-teach start and/or end point. Select orientations that prevent a wrist axis 
singularity from occurring and allow the path to be executed with Standard.
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CIRC motion The same orientation control options are available for selection for CIRC mo-
tions as for LIN motions.

During CIRC motions, the robot controller only takes the programmed orienta-
tion of the end point into consideration. The programmed orientation of the 
auxiliary point is disregarded.

7.7 Motion type “Spline”

Spline is a motion type that is suitable for particularly complex, curved paths. 
Such paths can generally also be generated using approximated LIN and 
CIRC motions, but spline nonetheless has advantages.

The most versatile spline motion is the spline block. A spline block is used to 
group together several motions as an overall motion. The spline block is 
planned and executed by the robot controller as a single motion block. 

The motions that may be included in a spline block are called spline segments. 
They are taught separately. 

 A CP spline block can contain SPL, SLIN and SCIRC segments.

 A PTP spline block can contain SPTP segments.

In addition to spline blocks, individual spline motions can also be programmed: 
SLIN, SCIRC and SPTP.

Fig. 7-7: Constant orientation

Fig. 7-8: Standard or Wrist PTP
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Advantages of 

spline blocks

 The path is defined by means of points that are located on the path. The 
desired path can be generated easily.

 The programmed velocity is maintained better than with conventional mo-
tion types. There are few cases in which the velocity is reduced.

 (>>> 7.7.1 "Velocity profile for spline motions" Page 165)

Furthermore, special constant velocity ranges can be defined in CP spline 
blocks.

 The path always remains the same, irrespective of the override setting, ve-
locity or acceleration.

 Circles and tight radii are executed with great precision.

Disadvantages of 

LIN/CIRC

 The path is defined by means of approximated points that are not located 
on the path. The approximate positioning ranges are difficult to predict. 
Generating the desired path is complicated and time-consuming.

Fig. 7-9: Curved path with spline block

Fig. 7-10: Curved path with approximated LIN motions
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 In many cases, the velocity may be reduced in a manner that is difficult to 
predict, e.g. in the approximate positioning ranges and near points that are 
situated close together.

 The path changes if approximate positioning is not possible, e.g. for time 
reasons.

 The path changes in accordance with the override setting, velocity or ac-
celeration.

7.7.1 Velocity profile for spline motions

The path always remains the same, irrespective of the override setting, veloc-
ity or acceleration.

The robot controller already takes the physical limits of the robot into consid-
eration during planning. The robot moves as fast as possible within the con-
straints of the programmed velocity, i.e. as fast as its physical limits will allow. 
This is an advantage over conventional LIN and CIRC motions for which the 
physical limits are not taken into consideration during planning. It is only during 
motion execution that these limits have any effect and can cause stops to be 
triggered.

Reduction of the velocity

Prime examples of cases in which the velocity has to fall below the pro-
grammed velocity include:

 Tight corners

 Major reorientation

 Large motions of the external axes

 Motion in the vicinity of singularities

Reduction of the velocity due to major reorientation can be avoided with spline 
segments by selecting the orientation control option Ignore orientation.

Reduction of the velocity to 0

This is the case for:

 Successive points with the same coordinates.

 Successive SLIN and/or SCIRC segments. Cause: inconstant velocity di-
rection. 

In the case of SLIN-SCIRC transitions, the velocity is also reduced to 0 if 
the straight line is a tangent of the circle, as the circle, unlike the straight 
line, is curved.

Fig. 7-11: Exact positioning at P2
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Exceptions:

 In the case of successive SLIN segments that result in a straight line and 
in which the orientations change uniformly, the velocity is not reduced.

 In the case of a SCIRC-SCIRC transition, the velocity is not reduced if both 
circles have the same center point and the same radius and if the orienta-
tions change uniformly. (This is difficult to teach, so calculate and program 
points.)

7.7.2 Block selection with spline motions

Spline block Block selection can be made to the segments of a spline block. 

 CP spline block: 

The BCO run is executed as a conventional LIN motion. This is indicated 
by means of a message that must be acknowledged.

 PTP spline block: 

The BCO run is executed as a conventional PTP motion. This is not indi-
cated by a message.

Following a block selection, the path is generally the same as if the spline were 
to be executed during normal program execution. 

Exceptions are possible if the spline has never yet been executed prior to the 
block selection and the block selection is made here to the start of the spline 
block: 

The start point of the spline motion is the last point before the spline block, i.e. 
the start point is outside the block. The robot controller saves the start point 
during normal execution of a spline. In this way, it is already known in the case 
of a block selection being carried out subsequently. If the spline block has nev-
er yet been executed, however, the start point is unknown. 

If the Start key is pressed after the BCO run, the modified path is indicated by 
means of a message that must be acknowledged.

Example: modified path in the case of block selection to P1

Fig. 7-12: Exact positioning at P2

Fig. 7-13: P2 is executed without exact positioning.

Circles with the same center point and the same radius are some-
times programmed to obtain circles ≥ 360°. A simpler method is to 
program a circular angle.
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SCIRC In the case of block selection to a SCIRC segment for which a circular angle 
has been programmed, the motion is executed to the end point including the 
circular angle, provided that the robot controller knows the start point. 

If the robot controller does not know the start point, the motion is executed to 
the programmed end point. In this case, a message is generated, indicating 
that the circular angle is not being taken into consideration.

In the case of a block selection to an individual SCIRC motion, the circular an-
gle is never taken into consideration.

7.7.3 Modifications to spline blocks

Description  Modification of the position of the point:

If a point within a spline block is offset, the path is modified, at most, in the 
2 segments before this point and the 2 segments after it.

Small point offsets generally result in small modifications to the path. If, 
however, very long segments are followed by very short segments or vice 
versa, small modifications can have a very great effect.

 Modification of the segment type:

If an SPL segment is changed into an SLIN segment or vice versa, the 
path changes in the previous segment and the next segment.

Example 1 Original path:

Fig. 7-14: Example: modified path in the case of block selection to P1

1  PTP P0
2  SPLINE
3   SPL P1
4   SPL P2
5   SPL P3
6   SPL P4
7   SCIRC P5, P6
8   SPL P7
9   SLIN P8
10 ENDSPLINE

Line Description

2 Header/start of the CP spline block

3 … 9 Spline segments

10 End of the CP spline block
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A point is offset relative to the original path:

P3 is offset. This causes the path to change in segments P1 - P2, P2 - P3 and 
P3 - P4. Segment P4 - P5 is not changed in this case, as it belongs to an 
SCIRC and a circular path is thus defined.

The type of a segment is changed relative to the original path:

In the original path, the segment type of P2 - P3 is changed from SPL to SLIN. 
The path changes in segments P1 - P2, P2 - P3 and P3 - P4.

PTP P0
SPLINE
 SPL P1
 SPL P2
 SPL P3
 SPL P4
 SCIRC P5, P6
 SPL P7
 SLIN P8
ENDSPLINE

Fig. 7-15: Original path

Fig. 7-16: Point has been offset
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Example 2 Original path:

A point is offset relative to the original path:

P3 is offset. This causes the path to change in all the segments illustrated. 
Since P2 - P3 and P3 - P4 are very short segments and P1 - P2 and P4 - P5 
are long segments, the slight offset causes the path to change greatly.

PTP P0
SPLINE
 SPL P1
 SPL P2
 SLIN P3
 SPL P4
 SCIRC P5, P6
 SPL P7
 SLIN P8
ENDSPLINE

Fig. 7-17: Segment type has been changed

...
SPLINE
 SPL {X 100, Y 0, ...}
 SPL {X 102, Y 0}
 SPL {X 104, Y 0}
 SPL {X 204, Y 0}
ENDSPLINE

Fig. 7-18: Original path

...
SPLINE
 SPL {X 100, Y 0, ...}
 SPL {X 102, Y 1}
 SPL {X 104, Y 0}
 SPL {X 204, Y 0}
ENDSPLINE
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Remedy:

 Distribute the points more evenly

 Program straight lines (except very short ones) as SLIN segments

7.7.4 Approximation of spline motions

All spline blocks and all individual spline motions can be approximated with 
one another. It makes no difference whether they are CP or PTP spline blocks, 
nor is the motion type of the individual motion relevant.

The motion type of the approximate positioning arc always corresponds to the 
second motion. In the case of SPTP-SLIN approximation, for example, the ap-
proximate positioning arc is of type CP.

Spline motions cannot be approximated with conventional motions (LIN, 
CIRC, PTP).

Approximation not possible due to time or advance run stops:

If approximation is not possible for reasons of time or due to an advance run 
stop, the robot waits at the start of the approximate positioning arc.

 In the case of time reasons: the robot moves again as soon as it has been 
possible to plan the next block.

 In the case of an advance run stop: the end of the current block is reached 
at the start of the approximate positioning arc. This means that the ad-
vance run stop is canceled and the robot controller can plan the next block. 
Robot motion is resumed.

In both cases, the robot now moves along the approximate positioning arc. Ap-
proximate positioning is thus technically possible; it is merely delayed.

This response differs from that for LIN, CIRC or PTP motions. If approximate 
positioning is not possible for the reasons specified, the motion is executed to 
the end point with exact positioning.

No approximate positioning in MSTEP and ISTEP:

In the program run modes MSTEP and ISTEP, the robot stops exactly at the 
end point, even in the case of approximated motions.

In the case of approximate positioning from one spline block to another spline 
block, the result of this exact positioning is that the path is different in the last 
segment of the first block and in the first segment of the second block from the 
path in program run mode GO.

In all other segments of both spline blocks, the path is identical in MSTEP, 
ISTEP and GO.

7.7.5 Replacing an approximated CP motion with a spline block

Description In order to replace approximated conventional CP motions with spline blocks, 
the program must be modified as follows:

 Replace LIN - LIN with SLIN - SPL - SLIN.

Fig. 7-19: Point has been offset
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 Replace LIN - CIRC with SLIN - SPL - SCIRC.

Recommendation: Allow the SPL to project a certain way into the original 
circle. The SCIRC thus starts later than the original CIRC.

In approximated motions, the corner point is programmed. In the spline block, 
the points at the start and end of the approximation are programmed instead.

The following approximated motion is to be reproduced:

Spline motion:

P1A = start of approximation, P1B = end of approximation

Ways of determining P1A and P1B:

 Execute the approximated path and save the positions at the desired point 
by means of Trigger.

 Calculate the points in the program with KRL.

 The start of the approximation can be determined from the approximate 
positioning criterion. Example: If C_DIS is specified as the approximate 
positioning criterion, the distance from the start of the approximation to the 
corner point corresponds to the value of $APO.CDIS.

The end of the approximation is dependent on the programmed velocity.

The SPL path does not correspond exactly to the approximate positioning arc, 
even if P1A and P1B are exactly at the start/end of the approximation. In order 
to recreate the exact approximate positioning arc, additional points must be in-
serted into the spline. Generally, one point is sufficient.

Example The following approximated motion is to be reproduced:

LIN P1 C_DIS
LIN P2

SPLINE
 SLIN P1A
 SPL P1B
 SLIN P2
ENDSPLINE

Fig. 7-20: Approximated motion - spline motion

$APO.CDIS=20
$VEL.CP=0.5
LIN {Z 10} C_DIS
LIN {Y 60}
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Spline motion:

The start of the approximate positioning arc has been calculated from the ap-
proximate positioning criterion.

The SPL path does not yet correspond exactly to the approximate positioning 
arc. For this reason, an additional SPL segment is inserted into the spline.

SPLINE WITH $VEL.CP=0.5
 SLIN {Z 30}
 SPL {Y 30, Z 10}
 SLIN {Y 60}
ENDSPLINE

Fig. 7-21: Example: Approximated motion - spline motion 1

SPLINE WITH $VEL.CP=0.5
 SLIN {Z 30}
 SPL {Y 15, Z 15}
 SPL {Y 30, Z 10}
 SLIN {Y 60}
ENDSPLINE
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With the additional point, the path now corresponds to the approximate posi-
tioning arc.

7.7.5.1 SLIN-SPL-SLIN transition

In the case of a SLIN-SPL-SLIN segment sequence, it is usually desirable for 
the SPL segment to be located within the smaller angle between the two 
straight lines. Depending on the start and end point of the SPL segment, the 
path may also move outside this area.

The path remains inside if the following conditions are met:

 The extensions of the two SLIN segments intersect.

Fig. 7-22: Example: Approximated motion - spline motion 2

Fig. 7-23: SLIN-SPL-SLIN
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 2/3 ≤ a/b ≤ 3/2

a = distance from start point of the SPL segment to intersection of the SLIN 
segments

b = distance from intersection of the SLIN segments to end point of the 
SPL segment

7.8 Orientation control for CP spline motions

Description The orientation of the TCP can be different at the start point and end point of 
a motion. When a CP spline motion is programmed, it is necessary to select 
how to deal with the different orientations.

The orientation control type is defined in the option window Motion parame-
ters.

Orientation control Description

Constant orientation The orientation of the TCP remains constant during the motion.

The orientation of the start point is retained. The programmed ori-
entation of the end point is not taken into consideration.

Default The orientation of the TCP changes continuously during the 
motion. At the end point, the TCP has the programmed orienta-
tion.

Wrist PTP The orientation of the TCP changes continuously during the 
motion. This is done by linear transformation (axis-specific 
motion) of the wrist axis angles.

Note: Use Wrist PTP if, with Default, the robot passes through a 
wrist axis singularity. 
The orientation of the TCP changes continuously during the 
motion, but not uniformly. Wrist PTP is thus not suitable if a spe-
cific orientation must be maintained exactly, e.g. in the case of 
laser welding.

Ignore orientation This option is only available for CP spline segments (not for the 
spline block or for individual spline motions).

This option is used if no specific orientation is required at a spe-
cific point.

 (>>>  "Ignore orientation" Page 175)

Fig. 7-24: Constant orientation
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Ignore orientation Ignore orientation is used if no specific orientation is required at a specific 
point. If this option is selected, the robot controller ignores the taught or pro-
grammed orientation of the point. Instead, it calculates the optimal orientation 
for this point on the basis of the orientations of the surrounding points. This re-
duces the cycle time.

Properties of Ignore orientation:

 In the program run modes MSTEP and ISTEP, the robot stops with the ori-
entations calculated by the robot controller.

 In the case of a block selection to a point with Ignore orientation, the ro-
bot adopts the orientation calculated by the robot controller.

Ignore orientation is not allowed for the following segments:

 The last segment in a spline block

 SCIRC segments with the circle orientation control type path-oriented

 Segments followed by a SCIRC segment with path-oriented

 Segments followed by a segment with Constant orientation

SCIRC The same orientation control options are available for selection for SCIRC mo-
tions as for SLIN motions. It is also possible to define for SCIRC motions 
whether the orientation control is to be space-related or path-related.

 (>>> 7.8.1 "Combinations of “Orientation control” and “Circle orientation con-
trol”" Page 176)

The option path-oriented is not allowed for the following motions:

 SCIRC segments for which Ignore orientation applies

 SCIRC motions preceded by a spline segment for which Ignore orienta-
tion applies

Orientation of the auxiliary point:

During SCIRC motions with the orientation control type Default, the robot con-
troller takes the programmed orientation of the auxiliary point into consider-
ation, but only to a certain extent.

The transition from the start orientation to the end orientation passes through 
the programmed orientation of the auxiliary point, i.e. the orientation of the 
auxiliary point is accepted at some point during the transition, but not neces-
sarily at the auxiliary point.

Fig. 7-25: Default orientation control

Orientation control Description

base-related Base-related orientation control during the 
circular motion

path-oriented Path-related orientation control during the 
circular motion
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7.8.1 Combinations of “Orientation control” and “Circle orientation control”

Fig. 7-26: Constant orientation control + path-related

Fig. 7-27: Standard + path-related

Fig. 7-28: Constant orientation control + base-related
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7.9 Singularities

KUKA robots with 6 degrees of freedom have 3 different singularity positions.

 Overhead singularity

 Extended position singularity

 Wrist axis singularity

A singularity position is characterized by the fact that unambiguous reverse 
transformation (conversion of Cartesian coordinates to axis-specific values) is 
not possible, even though Status and Turn are specified. In this case, or if very 
slight Cartesian changes cause very large changes to the axis angles, one 
speaks of singularity positions.

Overhead In the overhead singularity, the wrist root point (intersection of axes A4, A5 and 
A6) is located vertically above axis 1.

The position of axis A1 cannot be determined unambiguously by means of re-
verse transformation and can thus take any value.

If the end point of a PTP motion is situated in this overhead singularity position, 
the robot controller may react as follows by means of the system variable 
$SINGUL_POS[1]:

 0: The angle for axis A1 is defined as 0 degrees (default setting).

 1: The angle for axis A1 remains the same from the start point to the end 
point.

Extended 

position

In the extended position singularity, the wrist root point (intersection of axes 
A4, A5 and A6) is located in the extension of axes A2 and A3 of the robot.

The robot is at the limit of its work envelope.

Although reverse transformation does provide unambiguous axis angles, low 
Cartesian velocities result in high axis velocities for axes A2 and A3.

If the end point of a PTP motion is situated in this extended position singularity, 
the robot controller may react as follows by means of the system variable 
$SINGUL_POS[2]:

 0: The angle for axis A2 is defined as 0 degrees (default setting).

Fig. 7-29: Standard + base-related
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 1: The angle for axis A2 remains the same from the start point to the end 
point.

Wrist axes In the wrist axis singularity position, the axes A4 and A6 are parallel to one an-
other and axis A5 is within the range ±0.01812°.

The position of the two axes cannot be determined unambiguously by reverse 
transformation. There is an infinite number of possible axis positions for axes 
A4 and A6 with identical axis angle sums.

If the end point of a PTP motion is situated in this wrist axis singularity, the ro-
bot controller may react as follows by means of the system variable 
$SINGUL_POS[3]:

 0: The angle for axis A4 is defined as 0 degrees (default setting).

 1: The angle for axis A4 remains the same from the start point to the end 
point.
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8 Programming for user group “User” (inline forms)

8.1 Names in inline forms

Names for data sets can be entered in inline forms. These include, for exam-
ple, point names, names for motion data sets, etc.

The following restrictions apply to names:

 Maximum length 23 characters

 No special characters are permissible, with the exception of $.

 The first character must not be a number.

The restrictions do not apply to output names.

Other restrictions may apply in the case of inline forms in technology packag-
es.

8.2 Programming PTP, LIN and CIRC motions

8.2.1 Programming a PTP motion

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Move the TCP to the position that is to be taught as the end point.

2. Position the cursor in the line after which the motion instruction is to be in-
serted.

3. Select the menu sequence Commands > Motion > PTP.

4. Set the parameters in the inline form.

 (>>> 8.2.2 "Inline form “PTP”" Page 180)

5. Save instruction with Cmd Ok.

In the case of programs with the following axis motions 
or positions, the film of lubricant on the gear units of the 

axes may break down:

 Motions <3°

 Oscillating motions

 Areas of gear units permanently facing upwards

It must be ensured that the gear units have a sufficient supply of oil. For this, 
in the case of oscillating motions or short motions (<3°), programming must 
be carried out in such a way that the affected axes regularly move more than 
40° (e.g. once per cycle).
In the case of areas of gear units permanently facing upwards, sufficient oil 
supply must be achieved by programming re-orientations of the in-line wrist. 
In this way, the oil can reach all areas of the gear units by means of gravity. 
Required frequency of re-orientations:

 With low loads (gear unit temperature <+35 °C): daily

 With medium loads (gear unit temperature +35 °C to 55 °C): hourly

 With heavy loads (gear unit temperature >+55 °C): every 10 minutes

Failure to observe this precaution may result in damage to the gear units.

When programming motions, it must be ensured that the 
energy supply system is not wound up or damaged dur-

ing program execution.
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8.2.2 Inline form “PTP”

8.2.3 Programming a LIN motion

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Move the TCP to the position that is to be taught as the end point.

2. Position the cursor in the line after which the motion instruction is to be in-
serted.

3. Select the menu sequence Commands > Motion > LIN.

4. Set the parameters in the inline form.

 (>>> 8.2.4 "Inline form “LIN”" Page 181)

5. Save instruction with Cmd Ok.

Fig. 8-1: Inline form for PTP motions

Item Description

1 Motion type PTP

2 Name of the end point

The system automatically generates a name. The name can be 
overwritten.

 (>>> 8.1 "Names in inline forms" Page 179)

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 8.2.7 "Option window “Frames”" Page 182)

3  CONT: end point is approximated.

 [Empty box]: the motion stops exactly at the end point.

4 Velocity

 1 … 100%

5 Name for the motion data set

The system automatically generates a name. The name can be 
overwritten.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 8.2.8 "Option window “Motion parameters” (LIN, CIRC, 
PTP)" Page 183)

When programming motions, it must be ensured that the 
energy supply system is not wound up or damaged dur-

ing program execution.
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8.2.4 Inline form “LIN”

8.2.5 Programming a CIRC motion

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Move the TCP to the position that is to be taught as the auxiliary point.

2. Position the cursor in the line after which the motion instruction is to be in-
serted.

3. Select the menu sequence Commands > Motion > CIRC.

4. Set the parameters in the inline form.

 (>>> 8.2.6 "Inline form “CIRC”" Page 182)

5. Press Teach Aux. 

6. Move the TCP to the position that is to be taught as the end point.

7. Save instruction with Cmd Ok.

Fig. 8-2: Inline form for LIN motions

Item Description

1 Motion type LIN

2 Name of the end point

The system automatically generates a name. The name can be 
overwritten.

 (>>> 8.1 "Names in inline forms" Page 179)

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 8.2.7 "Option window “Frames”" Page 182)

3  CONT: end point is approximated.

 [Empty box]: the motion stops exactly at the end point.

4 Velocity

 0.001 … 2 m/s

5 Name for the motion data set

The system automatically generates a name. The name can be 
overwritten.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 8.2.8 "Option window “Motion parameters” (LIN, CIRC, 
PTP)" Page 183)

When programming motions, it must be ensured that the 
energy supply system is not wound up or damaged dur-

ing program execution.
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8.2.6 Inline form “CIRC”

8.2.7 Option window “Frames”

Fig. 8-3: Inline form for CIRC motions

Item Description

1 Motion type CIRC

2 Name of the auxiliary point

The system automatically generates a name. The name can be 
overwritten.

 (>>> 8.1 "Names in inline forms" Page 179)

3 Name of the end point

The system automatically generates a name. The name can be 
overwritten.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 8.2.7 "Option window “Frames”" Page 182)

4  CONT: end point is approximated.

 [Empty box]: the motion stops exactly at the end point.

5 Velocity

 0.001 … 2 m/s

6 Name for the motion data set

The system automatically generates a name. The name can be 
overwritten.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 8.2.8 "Option window “Motion parameters” (LIN, CIRC, 
PTP)" Page 183)

Fig. 8-4: Option window: Frames
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8.2.8 Option window “Motion parameters” (LIN, CIRC, PTP)

Item Description

1 Tool selection.

If True in the box External TCP: workpiece selection.

Range of values: [1] … [16]

2 Base selection.

If True in the box External TCP: fixed tool selection.

Range of values: [1] … [32]

3 Interpolation mode

 False: The tool is mounted on the mounting flange.

 True: The tool is a fixed tool.

4  True: For this motion, the robot controller calculates the axis 
torques. These are required for collision detection.

 False: For this motion, the robot controller does not calculate 
the axis torques. Collision detection is thus not possible for this 
motion.

Fig. 8-5: Option window “Motion parameters” (LIN, CIRC, PTP)

Item Description

1 Acceleration

Refers to the maximum value specified in the machine data. The 
maximum value depends on the robot type and the selected oper-
ating mode.
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8.3 Programming spline motions

8.3.1 Programming tips for spline motions

 It is only possible to exploit the advantages of the spline motion type to the 
full if spline blocks are used. 

 A spline block should cover only one process (e.g. an adhesive seam). 
More than one process in a spline block leads to a loss of structural clarity 
within the program and makes changes more difficult.

 Use SLIN and SCIRC segments in cases where the workpiece necessi-
tates straight lines and arcs. (Exception: use SPL segments for very short 
straight lines.) Otherwise, use SPL segments, particularly if the points are 
close together.

 Procedure for defining the path:

a. First teach or calculate a few characteristic points. Example: points at 
which the curve changes direction.

b. Test the path. At points where the accuracy is still insufficient, add 
more SPL points.

 Avoid successive SLIN and/or SCIRC segments, as this often reduces the 
velocity to 0. 

Program SPL segments between SLIN and SCIRC segments. The length 
of the SPL segments must be at least > 0.5 mm. Depending on the actual 
path, significantly larger SPL segments may be required.

 Avoid successive points with identical Cartesian coordinates, as this re-
duces the velocity to 0.

 The parameters (tool, base, velocity, etc.) assigned to the spline block 
have the same effect as assignments before the spline block. The assign-
ment to the spline block has the advantage, however, that the correct pa-
rameters are read in the case of a block selection.

 Use the option Ignore orientation if no specific orientation is required for 
a SLIN, SCIRC or SPL segment. The robot controller calculates the opti-
mal orientation for this point on the basis of the orientations of the sur-
rounding points. This improves the cycle time.

 The jerk can be modified The jerk is the change in acceleration. Proce-
dure:

a. Use the default values initially.

b. If vibrations occur at tight corners: reduce values.

2 This box is only displayed if it is specified in the inline form that the 
point is to be approximated.

Furthest distance before the end point at which approximate posi-
tioning can begin

The maximum permissible value is half the distance between the 
start point and the end point. If a higher value is entered, this is 
ignored and the maximum value is used.

3 This box is only displayed for LIN and CIRC motions.

Orientation control selection.

 Standard

 Wrist PTP

 Constant orientation

 (>>> 7.6 "Orientation control LIN, CIRC" Page 162)

Item Description
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If the velocity drops or the desired velocity cannot be reached: in-
crease values or increase acceleration.

 If the robot executes points on a work surface, a collision with the work sur-
face is possible when the first point is addressed.

In order to avoid a collision, observe the recommendations for the SLIN-
SPL-SLIN transition.

 (>>> 7.7.5.1 "SLIN-SPL-SLIN transition" Page 173)

 In the case of PTP spline blocks with multiple SPTP segments, it is possi-
ble that the software limit switches may be violated even though the points 
are within the limits! 

In this case, the points must be re-taught, i.e. they must be moved further 
away from the software limit switches. Alternatively, the software limit 
switches can be modified, provided that the required machine protection 
is still assured.

8.3.2 Programming a spline block

Description A spline block can be used to group together several motions as an overall 
motion. The motions that may be included in a spline block are called spline 
segments. They are taught separately. 

A spline block is planned and executed by the robot controller as a single mo-
tion block. 

 A CP spline block may contain SPL, SLIN and SCIRC segments.

 A PTP spline block may contain SPTP segments.

A spline block that contains no segments is not a motion statement. The num-
ber of segments in the block is only limited by the memory capacity. Apart from 
the segments, a spline block may also contain the following elements:

 Inline commands from technology packages that support the spline func-
tionality

 Comments and blank lines

A spline block must not include any other instructions, e.g. variable assign-
ments or logic statements. A spline block does not trigger an advance run 
stop.

Fig. 8-6: Collision with work surface

Fig. 8-7: Avoiding a collision with the work surface



186 / 237 Issued: 22.01.2013 Version: KSS 8.3 END V1 en (PDF)

KUKA System Software 8.3

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Position the cursor in the line after which the spline block is to be inserted.

2. Select the menu sequence Commands > Motion.

 Then select SPLINE block for a CP spline block.

 Or select PTP SPLINE block for a PTP spline block.

3. Set the parameters in the inline form.

 (>>> 8.3.2.1 "Inline form for CP spline block" Page 186)

 (>>> 8.3.2.2 "Inline form “PTP SPLINE block”" Page 187)

4. Press Cmd OK.

5. Press Open/close fold. Spline segments can now be inserted into the 
block.

8.3.2.1 Inline form for CP spline block

The start point of a spline block is the last point before the spline 
block.
The end point of a spline block is the last point in the spline block.

Fig. 8-8: Inline form for CP spline block

Item Description

1 Name of the spline block. The system automatically generates a 
name. The name can be overwritten.

 (>>> 8.1 "Names in inline forms" Page 179)

Position the cursor in this box to edit the motion data. The corre-
sponding option window is opened.

 (>>> 8.3.2.3 "Option window “Frames” (CP and PTP spline 
block)" Page 187)

2  CONT: end point is approximated.

 [Empty box]: the motion stops exactly at the end point.

3 Cartesian velocity

 0.001 … 2 m/s

4 Name for the motion data set. The system automatically gener-
ates a name. The name can be overwritten.

Position the cursor in this box to edit the motion data. The corre-
sponding option window is opened.

 (>>> 8.3.2.4 "Option window “Motion parameters” (CP spline 
block)" Page 188)
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8.3.2.2 Inline form “PTP SPLINE block”

8.3.2.3 Option window “Frames” (CP and PTP spline block)

Fig. 8-9: Inline form “PTP SPLINE block”

Item Description

1 Name of the spline block. The system automatically generates a 
name. The name can be overwritten.

 (>>> 8.1 "Names in inline forms" Page 179)

Position the cursor in this box to edit the motion data. The corre-
sponding option window is opened.

 (>>> 8.3.2.3 "Option window “Frames” (CP and PTP spline 
block)" Page 187)

2  CONT: end point is approximated.

 [Empty box]: the motion stops exactly at the end point.

3 Axis velocity

 1 … 100%

4 Name for the motion data set. The system automatically gener-
ates a name. The name can be overwritten.

Position the cursor in this box to edit the motion data. The corre-
sponding option window is opened.

 (>>> 8.3.2.5 "Option window “Motion parameters” (PTP spline 
block)" Page 189)

Fig. 8-10: Option window “Frames” (CP and PTP spline block)
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8.3.2.4 Option window “Motion parameters” (CP spline block)

Item Description

1 Tool selection.

Or: If True in the box External TCP: workpiece selection.

 [1] … [16]

2 Base selection.

Or: If True in the box External TCP: fixed tool selection.

 [1] … [32]

3 Interpolation mode

 False: The tool is mounted on the mounting flange.

 True: The tool is a fixed tool.

Fig. 8-11: Option window “Motion parameters” (CP spline block)

Item Description

1 Axis velocity. The value refers to the maximum value specified in 
the machine data.

 1 … 100%

2 Axis acceleration. The value refers to the maximum value speci-
fied in the machine data.

 1 … 100%

3 Gear jerk. The jerk is the change in acceleration.

The value refers to the maximum value specified in the machine 
data.

 1 … 100%

4 Orientation control selection.

5 Orientation control reference system selection.

This parameter only affects SCIRC segments (if present).

6 This box is only displayed if CONT was selected in the inline form.

Furthest distance before the end point at which approximate posi-
tioning can begin. 

The maximum distance is that of the last segment in the spline. If 
there is only one segment present, the maximum distance is half 
the segment length. If a higher value is entered, this is ignored 
and the maximum value is used.
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8.3.2.5 Option window “Motion parameters” (PTP spline block)

8.3.3 Programming segments for a spline block

8.3.3.1 Programming an SPL or SLIN segment

Precondition  A program is selected.

 Operating mode T1

 The CP spline block fold is open.

Procedure 1. Move the TCP to the end point.

2. Position the cursor in the line after which the segment is to be inserted in 
the spline block.

3. Select the menu sequence Commands > Motion > SPL or SLIN.

4. Set the parameters in the inline form.

 (>>> 8.3.3.3 "Inline form for CP spline segment" Page 190)

5. Press Cmd OK.

Fig. 8-12: Option window “Motion parameters” (PTP spline block)

Item Description

1 Axis acceleration. The value refers to the maximum value speci-
fied in the machine data.

 1 … 100%

2 This box is only displayed if CONT was selected in the inline form.

Furthest distance before the end point at which approximate posi-
tioning can begin. 

The maximum distance is that of the last segment in the spline. If 
there is only one segment present, the maximum distance is half 
the segment length. If a higher value is entered, this is ignored 
and the maximum value is used.

3 Gear jerk. The jerk is the change in acceleration.

The value refers to the maximum value specified in the machine 
data.

 1 … 100%

When programming motions, it must be ensured that the 
energy supply system is not wound up or damaged dur-

ing program execution.
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8.3.3.2 Programming an SCIRC segment

Precondition  A program is selected.

 Operating mode T1

 The CP spline block fold is open.

Procedure 1. Move the TCP to the auxiliary point.

2. Position the cursor in the line after which the segment is to be inserted in 
the spline block.

3. Select the menu sequence Commands > Motion > SCIRC.

4. Set the parameters in the inline form.

 (>>> 8.3.3.3 "Inline form for CP spline segment" Page 190)

5. Press Teach Aux.

6. Move the TCP to the end point.

7. Press Cmd OK.

8.3.3.3 Inline form for CP spline segment

By default, not all boxes of the inline form are displayed. The boxes can be dis-
played or hidden using the Switch parameter button.

When programming motions, it must be ensured that the 
energy supply system is not wound up or damaged dur-

ing program execution.

Fig. 8-13: Inline form for CP spline segment

Item Description

1 Motion type

 SPL, SLIN or SCIRC

2 Only for SCIRC: point name for the auxiliary point

The system automatically generates a name. The name can be 
overwritten. 

 (>>> 8.1 "Names in inline forms" Page 179)

3 Point name for the end point. The system automatically generates 
a name. The name can be overwritten.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 8.3.3.6 "Option window “Frames” (CP and PTP spline seg-
ments)" Page 193)
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8.3.3.4 Programming an SPTP segment

Precondition  A program is selected.

 Operating mode T1

 The PTP spline block fold is open.

Procedure 1. Move the TCP to the end point.

2. Position the cursor in the line after which the segment is to be inserted in 
the spline block.

3. Select the menu sequence Commands > Motion > SPTP.

4. Set the parameters in the inline form.

 (>>> 8.3.3.5 "Inline form for SPTP segment" Page 192)

5. Press Cmd OK.

4 Cartesian velocity

By default, the value that is valid for the spline block is also valid 
for the segment. A separate value can be assigned here for the 
segment if required. The value applies only for this segment. 

 0.001 … 2 m/s

5 Name for the motion data set. The system automatically gener-
ates a name. The name can be overwritten.

By default, the values that are valid for the spline block are also 
valid for the segment. Separate values can be assigned here for 
the segment if required. The values apply only for this segment. 

Touch the arrow to edit the data. The corresponding option win-
dow is opened.

 (>>> 8.3.3.7 "Option window “Motion parameters” (CP spline 
segment)" Page 193)

6 Only available if the motion type SCIRC has been selected.

Specifies the overall angle of the circular motion. This makes it 
possible to extend the motion beyond the programmed end point 
or to shorten it. The actual end point thus no longer corresponds 
to the programmed end point.

 Positive circular angle: the circular path is executed in the di-
rection Start point › Auxiliary point › End point.

 Negative circular angle: the circular path is executed in the di-
rection Start point › End point › Auxiliary point.

 - 9 999° … + 9 999°

If a circular angle less than -400° or greater than +400° is entered, 
a request for confirmation is generated when the inline form is 
saved asking whether entry is to be confirmed or rejected.

7 Name of the data set containing logic parameters. The system 
automatically generates a name. The name can be overwritten.

Touch the arrow to edit the data. The corresponding option win-
dow is opened.

 (>>> 8.3.3.9 "Option window “Logic parameters”" Page 195)

Item Description

When programming motions, it must be ensured that the 
energy supply system is not wound up or damaged dur-

ing program execution.
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8.3.3.5 Inline form for SPTP segment

By default, not all boxes of the inline form are displayed. The boxes can be dis-
played or hidden using the Switch parameter button.

Fig. 8-14: Inline form for SPTP segment

Item Description

1 Motion type SPTP

2 Point name for end point. The system automatically generates a 
name. The name can be overwritten. 

 (>>> 8.1 "Names in inline forms" Page 179)

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 8.3.3.6 "Option window “Frames” (CP and PTP spline seg-
ments)" Page 193)

3 Axis velocity

By default, the value that is valid for the spline block is also valid 
for the segment. A separate value can be assigned here for the 
segment if required. The value applies only for this segment. 

 1 … 100%

4 Name for the motion data set. The system automatically gener-
ates a name. The name can be overwritten.

By default, the values that are valid for the spline block are also 
valid for the segment. Separate values can be assigned here for 
the segment if required. The values apply only for this segment. 

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 8.3.3.8 "Option window “Motion parameters” (SPTP)" 
Page 194)

5 Name of the data set containing logic parameters. The system 
automatically generates a name. The name can be overwritten.

Touch the arrow to edit the data. The corresponding option win-
dow is opened.

 (>>> 8.3.3.9 "Option window “Logic parameters”" Page 195)
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8.3.3.6 Option window “Frames” (CP and PTP spline segments)

8.3.3.7 Option window “Motion parameters” (CP spline segment)

Motion param-

eters

Fig. 8-15: Option window “Frames” (CP and PTP spline segments)

Item Description

1  True: For this motion, the robot controller calculates the axis 
torques. These are required for collision detection.

 False: For this motion, the robot controller does not calculate 
the axis torques. Collision detection is thus not possible for this 
motion.

Fig. 8-16: Option window “Motion parameters” (CP spline segment)

Item Description

1 Axis velocity. The value refers to the maximum value specified in 
the machine data.

 1 … 100%

2 Axis acceleration. The value refers to the maximum value speci-
fied in the machine data.

 1 … 100%

3 Gear jerk. The jerk is the change in acceleration.

The value refers to the maximum value specified in the machine 
data.

 1 … 100%

4 Orientation control selection

5 Only in the case of SCIRC segments: Orientation control refer-
ence system selection.
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Circle configu-

ration

8.3.3.8 Option window “Motion parameters” (SPTP)

Fig. 8-17: Option window “Circle configuration” (SCIRC segment)

Item Description

6 Only in the case of SCIRC segments: Selection of orientation 
behavior at auxiliary point

7 Only in the case of SCIRC segments: This box is only displayed if 
ANGLE was selected in the inline form.

Selection of orientation behavior at end point

Fig. 8-18: Option window “Motion parameters” (SPTP)

Item Description

1 Axis acceleration. The value refers to the maximum value speci-
fied in the machine data.

 1 … 100%
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8.3.3.9 Option window “Logic parameters”

Trigger Trigger

2 This box is not available for SPTP segments. In the case of indi-
vidual SPTP motions, this box is only displayed if CONT was 
selected in the inline form.

Furthest distance before the end point at which approximate posi-
tioning can begin. 

The maximum permissible value is half the distance between the 
start point and the end point. If a higher value is entered, this is 
ignored and the maximum value is used. 

3 Gear jerk. The jerk is the change in acceleration.

The value refers to the maximum value specified in the machine 
data.

 1 … 100%

Item Description

Fig. 8-19: Trigger

Information about the location of the switching point if the reference 
point is approximated is contained in the Operating and Programming 
Instructions for System Integrators. Information about maximum off-

set limits can also be found there.

Item Description

1 A (further) trigger can be assigned to the motion by means of the 
button Select action > Add trigger. If it is the first trigger for this 
motion, this command also causes the Trigger box to be dis-
played.

A maximum of 8 triggers per motion are possible. 

(A trigger can be removed again by means of Select action > Re-
move trigger.)

2 Reference point of the trigger

 TRUE: Start point 

 FALSE: End point
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Conditional stop Conditional stop

3 Spatial offset relative to the end or start point

 Negative value: Shift towards the start of the motion

 Positive value: Shift towards the end of the motion

The shift in space can also be taught. In this case, the box Start 
point is reference point is automatically set to FALSE.

 (>>> 8.3.3.10 "Teaching the shift in space for logic parameters" 
Page 198)

4 Shift in time relative to Offset

 Negative value: Shift towards the start of the motion.

 Positive value: Trigger is switched after Time has elapsed.

5 Statement that is to be initiated by the trigger. The following are 
possible:

 Assignment of a value to a variable

Note: There must be no runtime variable on the left-hand side 
of the assignment.

 OUT statement; PULSE statement; CYCFLAG statement

 Subprogram call. In this case, the priority must be specified.

Example: my_subprogram() PRIO = 81

Priorities 1, 2, 4 to 39 and 81 to 128 are available. Priorities 40 
to 80 are reserved for cases in which the priority is automati-
cally assigned by the system. If the priority is to be assigned 
automatically by the system, the following is programmed: 
PRIO = -1..

If several triggers call subprograms at the same time, the trig-
ger with the highest priority is processed first, then the triggers 
of lower priority. 1 = highest priority. 

Item Description

Further information about the conditional stop can be found in this 
documentation.
 (>>> 8.3.5 "Conditional stop" Page 205)

Fig. 8-20: Conditional stop
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Constant velocity 

range

Constant velocity range

Item Description

1 Stop condition. The following are permitted:

 a global Boolean variable

 a signal name

 a comparison

 a simple logic operation: NOT, OR, AND or EXOR

2 The conditional stop can refer to either the start point or the end 
point of the motion. 

 TRUE: Start point 

 FALSE: End point

If the reference point is approximated, the same rules apply as for 
the PATH trigger. 

Note: Information about approximate positioning with the PATH 
trigger is contained in the Operating and Programming Instructions 
for System Integrators.

3 The stop point can be shifted in space. For this, the desired dis-
tance from the start or end point must be specified. If no shift in 
space is desired, enter “0”.

 Positive value: Shift towards the end of the motion

 Negative value: Shift towards the start of the motion

There are limits to the distance the stop point can be offset. The 
same limits apply as for the PATH trigger. 

The shift in space can also be taught. In this case, the box Start 
point is reference point is automatically set to FALSE.

 (>>> 8.3.3.10 "Teaching the shift in space for logic parameters" 
Page 198)

Note: Information about the offset limits with the PATH trigger is 
contained in the Operating and Programming Instructions for Sys-
tem Integrators.

Constant velocity range is only available for CP spline segments.

Further information about the constant velocity ranges can be found 
in this documentation.
 (>>> 8.3.6 "Constant velocity range in the CP spline block" 

Page 208)



198 / 237 Issued: 22.01.2013 Version: KSS 8.3 END V1 en (PDF)

KUKA System Software 8.3

8.3.3.10 Teaching the shift in space for logic parameters

Description Shifts in space can be specified in the option window Logic parameters for 
trigger, conditional stop and constant velocity range. Instead of entering these 
offsets numerically, they can also be taught.

Precondition  A program is selected.

 Operating mode T1

Fig. 8-21: Constant velocity range

Item Description

1  Start: Defines the start of the constant velocity range.

 End: Defines the end of the constant velocity range.

2 Start and End can refer to either the start point or the end point of 
the motion. 

 TRUE: Start or End refers to the start point. 

If the start point is approximated, the reference point is gener-
ated in the same way as for homogenous approximate posi-
tioning with the PATH trigger. 

Note: Information about approximate positioning with the 
PATH trigger is contained in the Operating and Programming 
Instructions for System Integrators.

 FALSE: Start or End refers to the end point.

If the end point is approximated, Start or End refers to the start 
of the approximate positioning arc.

3 The start or end of the constant velocity range can be shifted in 
space. For this, the desired distance must be specified. If no shift 
in space is desired, enter “0”.

 Positive value: Shift towards the end of the motion

 Negative value: Shift towards the start of the motion

 (>>> 8.3.6.2 "Maximum limits" Page 209)

The shift in space can also be taught. In this case, the box Start 
point is reference point is automatically set to FALSE.

 (>>> 8.3.3.10 "Teaching the shift in space for logic parameters" 
Page 198)

If an offset is taught, the box Start point is reference point in the cor-
responding tab is automatically set to FALSE, as the taught distance 
refers to the end point of the motion.
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 The point for which the offset is to apply has already been taught.

Procedure 1. Move the TCP to the desired position.

2. Position the cursor in the line containing the motion instruction for which 
the offset is to be taught.

3. Press Change. The inline form for this instruction is opened.

4. Open the option window Logic parameters and select the required tab.

5. Press Select action then one of the following buttons depending on what 
the offset is to be taught for: 

 Teach trigger path

 Teach conditional stop path

 Teach constant velocity range path

The distance from the end point of the current motion statement is now ap-
plied as the value for the offset.

6. Save the change by pressing Cmd OK.

8.3.4 Programming individual spline motions

8.3.4.1 Programming an individual SLIN motion

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Move the TCP to the end point.

2. Position the cursor in the line after which the motion is to be inserted.

3. Select Commands > Motion > SLIN.

4. Set the parameters in the inline form.

 (>>> 8.3.4.2 "Inline form “SLIN”" Page 199)

5. Press Cmd OK.

8.3.4.2 Inline form “SLIN”

When programming motions, it must be ensured that the 
energy supply system is not wound up or damaged dur-

ing program execution.

Fig. 8-22: Inline form “SLIN” (individual motion)

Item Description

1 Motion type SLIN

2 Point name for end point. The system automatically generates a 
name. The name can be overwritten. 

 (>>> 8.1 "Names in inline forms" Page 179)

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 8.2.7 "Option window “Frames”" Page 182)
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8.3.4.3 Option window “Motion parameters” (SLIN)

3  CONT: end point is approximated.

 [Empty box]: the motion stops exactly at the end point.

4 Velocity

 0.001 … 2 m/s

5 Name for the motion data set. The system automatically gener-
ates a name. The name can be overwritten.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 8.3.4.3 "Option window “Motion parameters” (SLIN)" 
Page 200)

6 This box can be displayed or hidden by means of Switch param-
eter.

Name of the data set containing logic parameters. The system 
automatically generates a name. The name can be overwritten. 
Touch the arrow to edit the data. The corresponding option win-
dow is opened.

 (>>> 8.3.3.9 "Option window “Logic parameters”" Page 195)

Item Description

Fig. 8-23: Option window “Motion parameters” (SLIN)

Item Description

1 Axis velocity. The value refers to the maximum value specified in 
the machine data.

 1 … 100%

2 Axis acceleration. The value refers to the maximum value speci-
fied in the machine data.

 1 … 100%

3 Gear jerk. The jerk is the change in acceleration.

The value refers to the maximum value specified in the machine 
data.

 1 … 100%
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8.3.4.4 Programming an individual SCIRC motion

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Move the TCP to the auxiliary point.

2. Position the cursor in the line after which the motion is to be inserted.

3. Select the menu sequence Commands > Motion > SCIRC.

4. Set the parameters in the inline form.

 (>>> 8.3.4.5 "Inline form “SCIRC”" Page 201)

5. Press Teach Aux.

6. Move the TCP to the end point.

7. Press Cmd OK.

8.3.4.5 Inline form “SCIRC”

4 Orientation control selection.

5 This box is only displayed if CONT was selected in the inline form.

Furthest distance before the end point at which approximate posi-
tioning can begin. 

The maximum permissible value is half the distance between the 
start point and the end point. If a higher value is entered, this is 
ignored and the maximum value is used. 

Item Description

When programming motions, it must be ensured that the 
energy supply system is not wound up or damaged dur-

ing program execution.

Fig. 8-24: Inline form “SCIRC” (individual motion)

Item Description

1 Motion type SCIRC

2 Point name for the auxiliary point.

The system automatically generates a name. The name can be 
overwritten.

 (>>> 8.1 "Names in inline forms" Page 179)
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3 Point name for the end point.

The system automatically generates a name. The name can be 
overwritten.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 8.2.7 "Option window “Frames”" Page 182)

4  CONT: end point is approximated.

 [Empty box]: the motion stops exactly at the end point.

5 Velocity

 0.001 … 2 m/s

6 Name for the motion data set. The system automatically gener-
ates a name. The name can be overwritten.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 8.3.4.6 "Option window “Motion parameters” (SCIRC)" 
Page 203)

7 Specifies the overall angle of the circular motion. This makes it 
possible to extend the motion beyond the programmed end point 
or to shorten it. The actual end point thus no longer corresponds 
to the programmed end point.

 Positive circular angle: the circular path is executed in the di-
rection Start point › Auxiliary point › End point.

 Negative circular angle: the circular path is executed in the di-
rection Start point › End point › Auxiliary point.

 - 9 999° … + 9 999°

If a circular angle less than -400° or greater than +400° is entered, 
a request for confirmation is generated when the inline form is 
saved asking whether entry is to be confirmed or rejected.

8 This box can be displayed or hidden by means of Switch param-
eter.

Name of the data set containing logic parameters. The system 
automatically generates a name. The name can be overwritten. 
Touch the arrow to edit the data. The corresponding option win-
dow is opened.

 (>>> 8.3.3.9 "Option window “Logic parameters”" Page 195)

Item Description
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8.3.4.6 Option window “Motion parameters” (SCIRC)

Motion param-

eters

Circle configu-

ration

Fig. 8-25: Motion parameters (SCIRC)

Item Description

1 Axis velocity. The value refers to the maximum value specified in 
the machine data.

 1 … 100%

2 Axis acceleration. The value refers to the maximum value speci-
fied in the machine data.

 1 … 100%

3 Gear jerk. The jerk is the change in acceleration.

The value refers to the maximum value specified in the machine 
data.

 1 … 100%

4 Orientation control selection

5 Orientation control reference system selection

6 This box is only displayed if CONT was selected in the inline form.

Furthest distance before the end point at which approximate posi-
tioning can begin. 

The maximum permissible value is half the distance between the 
start point and the end point. If a higher value is entered, this is 
ignored and the maximum value is used. 

Fig. 8-26: Circle configuration (SCIRC)
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8.3.4.7 Programming an individual SPTP motion

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Move the TCP to the end point.

2. Position the cursor in the line after which the motion is to be inserted.

3. Select Commands > Motion > SPTP.

4. Set the parameters in the inline form.

 (>>> 8.3.4.8 "Inline form “SPTP”" Page 204)

5. Press Cmd OK.

8.3.4.8 Inline form “SPTP”

Item Description

7 Selection of orientation behavior at auxiliary point

8 This box is only displayed if ANGLE was selected in the inline 
form.

Selection of orientation behavior at end point

When programming motions, it must be ensured that the 
energy supply system is not wound up or damaged dur-

ing program execution.

Fig. 8-27: Inline form “SPTP” (individual motion)

Item Description

1 Motion type SPTP

2 Point name for end point. The system automatically generates a 
name. The name can be overwritten. 

 (>>> 8.1 "Names in inline forms" Page 179)

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 8.2.7 "Option window “Frames”" Page 182)

3  CONT: end point is approximated.

 [Empty box]: the motion stops exactly at the end point.

4 Velocity

 1 … 100%
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8.3.5 Conditional stop

Description The “conditional stop” enables the user to define a point on the path at which 
the robot stops if a certain condition is met. This point is called the “stop point”. 
As soon as the condition is no longer met, the robot resumes its motion.

During the runtime, the robot controller calculates the latest point at which the 
robot must brake in order to be able to stop at the stop point. From this point 
(braking point) onwards, it monitors whether or not the condition is met. 

 If the condition is met at the braking point, the robot brakes in order to stop 
at the stop point.

If, however, the condition then switches back to “not met” before the stop 
point is reached, the robot accelerates again and does not stop.

 If the condition is not met at the braking point, the robot motion is continued 
without braking. 

Essentially, any number of conditional stops can be programmed. A maximum 
of 10 “braking point → stop point” paths may overlap, however.

While the robot is braking, the robot controller displays the following message 
in T1/T2 mode: Conditional stop active (line {Line number}).

 (>>> 8.3.5.2 "Stop condition: example and braking characteristics" Page 207)

Programming Programming with KRL syntax:

 using the statement STOP WHEN PATH

Programming with inline forms:

 In the spline block (CP and PTP) or in the individual spline block: 

in the option window “Logic parameters”

 Before a spline block (CP and PTP): 

via the inline form Spline Stop Condition

8.3.5.1 Inline form “Spline Stop Condition”

5 Name for the motion data set. The system automatically gener-
ates a name. The name can be overwritten.

Touch the arrow to edit the point data. The corresponding option 
window is opened.

 (>>> 8.3.3.8 "Option window “Motion parameters” (SPTP)" 
Page 194)

6 This box can be displayed or hidden by means of Switch param-
eter.

Name of the data set containing logic parameters. The system 
automatically generates a name. The name can be overwritten. 
Touch the arrow to edit the data. The corresponding option win-
dow is opened.

 (>>> 8.3.3.9 "Option window “Logic parameters”" Page 195)

Item Description

This inline form may only be used before a spline block. There may 
be other statements between the inline form and the spline block, but 
no motion instructions.
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Teach path

Fig. 8-28: Inline form “Spline Stop Condition”

Item Description

1 Point to which the conditional stop refers

 With ONSTART: last point before the spline block

 Without ONSTART: last point in the spline block

If the spline is approximated, the same rules apply as for the 
PATH trigger. 

Note: Information about approximate positioning with the PATH 
trigger is contained in the Operating and Programming Instruc-
tions for System Integrators.

ONSTART can be set or removed using the Toggle OnStart but-
ton.

2 The stop point can be shifted in space. For this, the desired dis-
tance from the reference point must be specified. If no shift in 
space is desired, enter “0”.

 Positive value: Shift towards the end of the motion

 Negative value: Shift towards the start of the motion

There are limits to the distance the stop point can be offset. The 
same limits apply as for the PATH trigger. 

The shift in space can also be taught. 

 (>>>  "Teach path" Page 206)

3 Stop condition. The following are permitted:

 a global Boolean variable

 a signal name

 a comparison

 a simple logic operation: NOT, OR, AND or EXOR

Button Description

Teach path If an offset is desired, it is not necessary to enter 
the value into the inline form numerically; the off-
set can also be taught. This is done via Teach 
path.

If an offset is taught, ONSTART is automatically 
removed, if set in the inline form, as the taught 
distance always refers to the end point of the mo-
tion.

The teaching sequence is the same as that for 
the option window Logic parameters.  
(>>> 8.3.3.10 "Teaching the shift in space for log-
ic parameters" Page 198)
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8.3.5.2 Stop condition: example and braking characteristics

Example

Braking charac-

teristics

If the stop condition is not met until the robot has already passed BP, it is too 
late to stop at SP with a normal braking ramp. In this case, the robot stops with 
a path-maintaining EMERGENCY STOP and comes to a standstill at an un-
predictable point. 

1  PTP P0
2  SPLINE 
3   SPL P1
4   STOP WHEN PATH = 50 IF $IN[77]==FALSE
5   SPL P2
6   SPL P3
7  ENDSPLINE

Line Description

4 If the input $IN[77] is FALSE, the robot stops 50 mm after P2 
and waits until $IN[77] is TRUE.

Note: The line represents programming in KRL. In the case of 
inline programming, the program looks different, but the se-
quence and the braking characteristics are identical.

Fig. 8-29: Example of STOP WHEN PATH

Point Description

BP Braking Point: The robot must start braking here in order to 
stop at the stop point.

From this point onwards, the robot controller monitors 
whether or not the stop condition is met.

The position of BP depends on the velocity and the override 
setting and cannot be identified by the operator.

SP Stop Point

The distance P2 → SP is 50 mm long.

Situation at BP Behavior of the robot

$IN[77] == FALSE The robot brakes and stops at SP.

$IN[77] == TRUE The robot does not brake and does 
not stop at SP. The program is exe-
cuted as if the STOP WHEN PATH 
statement were not present.

1. $IN[77] == FALSE at BP.

2. The input switches to TRUE be-
tween BP and SP.

1. The robot brakes at BP. 

2. If the input is TRUE, the robot 
accelerates again and does not 
stop at SP.

1. $IN[77] == TRUE at BP.

2. The input switches to FALSE 
between BP and SP.

1. The robot does not brake at BP.

2. If the input is FALSE, the robot 
stops with a path-maintaining 
EMERGENCY STOP and 
comes to a standstill at an un-
predictable point. 
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 If the EMERGENCY STOP causes the robot to stop after SP, the program 
cannot be resumed until the stop condition is no longer met.

 If the path-maintaining EMERGENCY STOP causes the robot to stop be-
fore SP, the following occurs when the program is resumed:

 If the stop condition is no longer met, the robot resumes its motion.

 If the stop condition is still met, the robot moves as far as SP and stops 
there.

8.3.6 Constant velocity range in the CP spline block

Description In a CP spline block, a range can be defined in which the robot maintains the 
programmed velocity constant where possible. This range is called the “con-
stant velocity range”.

 1 constant velocity range can be defined per CP spline block.

 A constant velocity range is defined by a start statement and an end state-
ment.

 The range cannot extend beyond the spline block.

 There is no lower limit to the size of the range. 

If it is not possible to maintain the programmed velocity constant, the robot 
controller indicates this by means of a message during program execution. 

Constant velocity range over several segments:

A constant velocity range can extend over several segments with different pro-
grammed velocities. In this case, the lowest of the velocities is valid for the 
whole range. 

Even in the segments with a higher programmed velocity, the motion is exe-
cuted with the lowest velocity in this case. No message is generated indicating 
that the velocity has not been maintained. This only occurs if the lowest veloc-
ity cannot be maintained. 

Programming A constant velocity range can be programmed in the following ways:

 If programming with KRL syntax: by means of the statement CONST_VEL

 If programming with inline forms: 

The start or end of the range is stored in the corresponding CP segment 
in the option window Logic parameters.

8.3.6.1 Block selection to the constant velocity range

Description If a block selection to a constant velocity range is carried out, the robot con-
troller ignores the CONST_VEL statement and generates a corresponding 
message. The motions are executed as if the CONST_VEL statements were 
not present.

A block selection to the path section defined by the offset values is considered 
as a block selection to the constant velocity range. The position of 
CONST_VEL START and CONST_VEL END is irrelevant here!

Example ...
SPLINE ...
  SLIN P1
  CONST_VEL START = 50
  SLIN P2
  SLIN P3
  SLIN P4
  CONST_VEL END = -50 ONSTART
  SLIN P5
ENDSPLINE
...
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The constant velocity range starts 50 mm after P2 and ends 50 mm before P4.

Which block selection is considered as a block selection to the constant veloc-
ity range?

8.3.6.2 Maximum limits

If the start or end point of the spline block is an exact positioning point:

 The constant velocity range starts at the start point at the earliest.

 The constant velocity range ends at the end point at the latest.

If the offset value is such that these limits would be exceeded, the robot con-
troller automatically reduces the offset and generates the following message: 
CONST_VEL {Start/End} = {Offset} cannot be implemented; {New offset} will 
be used.

The robot controller reduces the offset far enough to create a range in which 
the constant programmed velocity can be maintained. In other words, it does 
not necessarily shift the limit exactly to the start or end point of the spline block, 
but possibly further inwards.

The same message is generated if the range is already in the spline block be-
forehand, but the defined velocity cannot be maintained due to the offset. In 
this case, once again, the robot controller reduces the offset.

If the start or end point of the spline block is approximated:

 The constant velocity range starts at the start of the approximate position-
ing arc of the start point at the earliest.

 The constant velocity range ends at the start of the approximate position-
ing arc of the end point at the latest.

The example shows programming in KRL. In the case of inline pro-
gramming, the program looks different, but the behavior is identical.

Fig. 8-30: Example of block selection

Block selection to point ... P2 P3 P4

= in constant velocity range? No Yes No
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If the offset is such that these limits would be exceeded, the robot controller 
automatically sets the limit to the start of the corresponding approximate posi-
tioning arc. It does not generate a message.

8.4 Modifying motion parameters

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Position the cursor in the line containing the instruction that is to be 
changed.

2. Press Change. The inline form for this instruction is opened.

3. Modify parameters.

4. Save changes by pressing Cmd Ok.

8.5 Re-teaching a point

Description The coordinates of a taught point can be modified. This is done by moving to 
the new position and overwriting the old point with the new position.

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Move the TCP to the desired position.

2. Position the cursor in the line containing the motion instruction that is to be 
changed.

3. Press Change. The inline form for this instruction is opened.

4. For PTP and LIN motions: Press Touch Up to accept the current position 
of the TCP as the new end point.

For CIRC motions:

 Press Teach Aux to accept the current position of the TCP as the new 
auxiliary point.

 Or press Teach End to accept the current position of the TCP as the 
new end point.

5. Confirm the request for confirmation with Yes.

6. Save change by pressing Cmd Ok.

Fig. 8-31: Maximum limits for approximated SPLINE/ENDSPLINE
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8.6 Programming logic instructions

8.6.1 Inputs/outputs

Digital inputs/outputs

The robot controller can manage up to 8192 digital inputs and 8192 digital out-
puts. The configuration is customer-specific.

Analog inputs/outputs

The robot controller can manage 32 analog inputs and 32 analog outputs. The 
configuration is customer-specific.

The inputs/outputs are managed via the following system variables:

$ANIN[…] indicates the input voltage, adapted to the range between -1.0 and 
+1.0. The actual voltage depends on the settings of the analog module.

$ANOUT[…] can be used to set an analog voltage. $ANOUT[…] can have val-
ues from -1.0 to +1.0 written to it. The voltage actually generated depends on 
the settings of the analog module. If an attempt is made to set voltages outside 
the range of values, the robot controller displays the following message: Limit 
{Signal name}

8.6.2 Setting a digital output - OUT

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Position the cursor in the line after which the logic instruction is to be in-
serted.

2. Select the menu sequence Commands > Logic > OUT > OUT.

3. Set the parameters in the inline form.

 (>>> 8.6.3 "Inline form “OUT”" Page 211)

4. Save instruction with Cmd Ok.

8.6.3 Inline form “OUT”

The instruction sets a digital output.

Inputs Outputs

Digital $IN[1] … $IN[8192] $OUT[1] … $OUT[8192]

Analog $ANIN[1] … $ANIN[32] $ANOUT[1] … $ANOUT[32]

Fig. 8-32: Inline form “OUT”

Item Description

1 Output number

2 If a name exists for the output, this name is displayed.

Only for the user group “Expert”:

A name can be entered by pressing Long text. The name is freely 
selectable.
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8.6.4 Setting a pulse output - PULSE

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Position the cursor in the line after which the logic instruction is to be in-
serted.

2. Select the menu sequence Commands > Logic > OUT > PULSE.

3. Set the parameters in the inline form.

 (>>> 8.6.5 "Inline form “PULSE”" Page 212)

4. Save instruction with Cmd Ok.

8.6.5 Inline form “PULSE”

The instruction sets a pulse of a defined length.

8.6.6 Setting an analog output - ANOUT

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Position the cursor in the line after which the instruction is to be inserted.

2. Select Commands > Analog output > Static or Dynamic.

3 State to which the output is switched

 TRUE

 FALSE

4  CONT: Execution in the advance run

 [Empty box]: Execution with advance run stop

Item Description

Fig. 8-33: Inline form “PULSE”

Item Description

1 Output number

2 If a name exists for the output, this name is displayed.

Only for the user group “Expert”:

A name can be entered by pressing Long text. The name is freely 
selectable.

3 State to which the output is switched

 TRUE: “High” level

 FALSE: “Low” level

4  CONT: Execution in the advance run

 [Empty box]: Execution with advance run stop

5 Length of the pulse

 0.10 … 3.00 s
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3. Set the parameters in the inline form.

 (>>> 8.6.7 "Inline form “ANOUT” (static)" Page 213)

 (>>> 8.6.8 "Inline form “ANOUT” (dynamic)" Page 213)

4. Save instruction with Cmd Ok.

8.6.7 Inline form “ANOUT” (static)

This instruction sets a static analog output.

A maximum of 8 analog outputs (static and dynamic together) can be used at 
any one time. ANOUT triggers an advance run stop.

The voltage is set to a fixed level by means of a factor. The actual voltage level 
depends on the analog module used. For example, a 10 V module with a fac-
tor of 0.5 provides a voltage of 5 V.

8.6.8 Inline form “ANOUT” (dynamic)

This instruction activates or deactivates a dynamic analog output.

A maximum of 4 dynamic analog outputs can be activated at any one time. 
ANOUT triggers an advance run stop.

The voltage is determined by a factor. The actual voltage level depends on the 
following values:

 Velocity or function generator

For example, a velocity of 1 m/s with a factor of 0.5 results in a voltage of 
5 V. 

 Offset

For example, an offset of +0.15 for a voltage of 0.5 V results in a voltage 
of 6.5 V.

Fig. 8-34: Inline form “ANOUT” (static)

Item Description

1 Number of the analog output

 CHANNEL_1 … CHANNEL_32

2 Factor for the voltage

 0 … 1 (intervals: 0.01)

Fig. 8-35: Inline form “ANOUT” (dynamic)
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8.6.9 Programming a wait time - WAIT

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Position the cursor in the line after which the logic instruction is to be in-
serted.

2. Select the menu sequence Commands > Logic > WAIT.

3. Set the parameters in the inline form.

 (>>> 8.6.10 "Inline form “WAIT”" Page 214)

4. Save instruction with Cmd Ok.

8.6.10 Inline form “WAIT”

WAIT can be used to program a wait time. The robot motion is stopped for a 
programmed time. WAIT always triggers an advance run stop.

8.6.11 Programming a signal-dependent wait function - WAITFOR

Precondition  A program is selected.

 Operating mode T1

Item Description

1 Activation or deactivation of the analog output

 ON

 OFF

2 Number of the analog output

 CHANNEL_1 … CHANNEL_32

3 Factor for the voltage

 0 … 10 (intervals: 0.01)

4  VEL_ACT: The voltage is dependent on the velocity.

 TECHVAL[1] … TECHVAL[6]: The voltage is controlled by a 
function generator.

5 Value by which the voltage is increased or decreased

 -1 … +1 (intervals: 0.01)

6 Time by which the output signal is delayed (+) or brought forward 
(-)

 -0.2 … +0.5 s

Fig. 8-36: Inline form “WAIT”

Item Description

1 Wait time

 ≥ 0 s
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Procedure 1. Position the cursor in the line after which the logic instruction is to be in-
serted.

2. Select the menu sequence Commands > Logic > WAITFOR.

3. Set the parameters in the inline form.

 (>>> 8.6.12 "Inline form “WAITFOR”" Page 215)

4. Save instruction with Cmd Ok.

8.6.12 Inline form “WAITFOR”

The instruction sets a signal-dependent wait function.

If required, several signals (maximum 12) can be linked. If a logic operation is 
added, boxes are displayed in the inline form for the additional signals and 
links.

Fig. 8-37: Inline form “WAITFOR”

Item Description

1 Add external logic operation. The operator is situated between the 
bracketed expressions.

 AND

 OR

 EXOR

Add NOT.

 NOT

 [Empty box]

Enter the desired operator by means of the corresponding button.

2 Add internal logic operation. The operator is situated inside a 
bracketed expression.

 AND

 OR

 EXOR

Add NOT.

 NOT

 [Empty box]

Enter the desired operator by means of the corresponding button.

3 Signal for which the system is waiting

 IN

 OUT

 CYCFLAG

 TIMER

 FLAG

4 Number of the signal
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8.6.13 Switching on the path - SYN OUT

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Position the cursor in the line after which the logic instruction is to be in-
serted.

2. Select the menu sequence Commands > Logic > OUT > SYN OUT.

3. Set the parameters in the inline form.

 (>>> 8.6.14 "Inline form “SYN OUT”, option “START/END”" Page 216)

 (>>> 8.6.15 "Inline form “SYN OUT”, option “PATH”" Page 219)

4. Save instruction with Cmd Ok.

8.6.14 Inline form “SYN OUT”, option “START/END”

The switching action can be triggered relative to the start or end point of the 
motion. The switching action can be delayed or brought forward. The motion 
can be a LIN, CIRC or PTP motion.

Possible applications include:

 Closing or opening the weld gun during spot welding

 Switching the welding current on/off during arc welding

 Starting or stopping the flow of adhesive in bonding or sealing applica-
tions.

5 If a name exists for the signal, this name is displayed.

Only for the user group “Expert”:

A name can be entered by pressing Long text. The name is freely 
selectable.

6  CONT: Execution in the advance run

 [Empty box]: Execution with advance run stop

Item Description

Fig. 8-38: Inline form “SYN OUT”, option “START/END”

Item Description

1 Output number

2 If a name exists for the output, this name is displayed.

Only for the user group “Expert”:

A name can be entered by pressing Long text. The name is freely 
selectable.

3 State to which the output is switched

 TRUE

 FALSE
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Example 1 Start point and end point are exact positioning points.

OUT 1 and OUT 2 specify approximate positions at which switching is to oc-
cur. The dotted lines indicate the switching limits.

Switching limits:

 START: The switching point can be delayed, at most, as far as exact po-
sitioning point P3 (+ ms).

 END: The switching point can be brought forward, at most, as far as exact 
positioning point P2 (- ms).

If greater values are specified for the delay, the controller automatically switch-
es at the switching limit.

Example 2 Start point is exact positioning point, end point is approximated.

4 Point to which SYN OUT refers:

 START: Start point of the motion

 END: End point of the motion

5 Switching action delay

 -1,000 … +1,000 ms

Note: The time specification is absolute, i.e. the switching point 
varies according to the velocity of the robot.

Item Description

LIN P1 VEL=0.3m/s CPDAT1
LIN P2 VEL=0.3m/s CPDAT2
SYN OUT 1 '' State= TRUE at START Delay=20ms
SYN OUT 2 '' State= TRUE at END Delay=-20ms
LIN P3 VEL=0.3m/s CPDAT3
LIN P4 VEL=0.3m/s CPDAT4

Fig. 8-39

LIN P1 VEL=0.3m/s CPDAT1
LIN P2 VEL=0.3m/s CPDAT2
SYN OUT 1 '' State= TRUE at START Delay=20ms
SYN OUT 2 '' State= TRUE at END Delay=-20ms
LIN P3 CONT VEL=0.3m/s CPDAT3
LIN P4 VEL=0.3m/s CPDAT4
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OUT 1 and OUT 2 specify approximate positions at which switching is to oc-
cur. The dotted lines indicate the switching limits. M = middle of the approxi-
mate positioning range.

Switching limits:

 START: The switching point can be delayed, at most, as far as the start of 
the approximate positioning range of P3 (+ ms).

 END: The switching point can be brought forward, at most, as far as the 
start of the approximate positioning range of P3 (-).

The switching point can be delayed, at most, as far as the end of the ap-
proximate positioning range of P3 (+).

If greater values are specified for the delay, the controller automatically switch-
es at the switching limit.

Example 3 Start point and end point are approximated

OUT 1 and OUT 2 specify approximate positions at which switching is to oc-
cur. The dotted lines indicate the switching limits. M = middle of the approxi-
mate positioning range.

Fig. 8-40

LIN P1 VEL=0.3m/s CPDAT1
LIN P2 CONT VEL=0.3m/s CPDAT2
SYN OUT 1 '' State= TRUE at START Delay=20ms
SYN OUT 2 '' State= TRUE at END Delay=-20ms
LIN P3 CONT VEL=0.3m/s CPDAT3
LIN P4 VEL=0.3m/s CPDAT4

Fig. 8-41
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Switching limits:

 START: The switching point can be situated, at the earliest, at the end of 
the approximate positioning range of P2.

The switching point can be delayed, at most, as far as the start of the ap-
proximate positioning range of P3 (+ ms).

 END: The switching point can be brought forward, at most, as far as the 
start of the approximate positioning range of P3 (-).

The switching point can be delayed, at most, as far as the end of the ap-
proximate positioning range of P3 (+).

If greater values are specified for the delay, the controller automatically switch-
es at the switching limit.

8.6.15 Inline form “SYN OUT”, option “PATH”

The switching action refers to the end point of the motion. The switching action 
can be shifted in space and delayed or brought forward. The motion can be a 
LIN or CIRC motion. It must not be a PTP motion.

Example 1 Start point is exact positioning point, end point is approximated.

Fig. 8-42: Inline form “SYN OUT”, option “PATH”

Item Description

1 Output number

2 If a name exists for the output, this name is displayed.

Only for the user group “Expert”:

A name can be entered by pressing Long text. The name is freely 
selectable.

3 State to which the output is switched

 TRUE

 FALSE

4  PATH: SYN OUT refers to the end point of the motion.

5 This box is only displayed if PATH has been selected.

Distance from the switching point to the end point

 -2,000 … +2,000 mm

6 Switching action delay

 -1,000 … +1,000 ms

Note: The time specification is absolute, i.e. the switching point 
varies according to the velocity of the robot.

LIN P1 VEL=0.3m/s CPDAT1
SYN OUT 1 '' State= TRUE at START PATH=20mm Delay=-5ms
LIN P2 CONT VEL=0.3m/s CPDAT2
LIN P3 CONT VEL=0.3m/s CPDAT3
LIN P4 VEL=0.3m/s CPDAT4
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OUT 1 specifies the approximate position at which switching is to occur. The 
dotted lines indicate the switching limits. M = middle of the approximate posi-
tioning range.

Switching limits:

 The switching point can be brought forward, at most, as far as exact posi-
tioning point P1.

 The switching point can be delayed, at most, as far as the next exact po-
sitioning point P4. If P3 was an exact positioning point, the switching point 
could be delayed, at most, as far as P3.

If greater values are specified for the shift in space or time, the controller au-
tomatically switches at the switching limit.

Example 2 Start point and end point are approximated

OUT 1 specifies the approximate position at which switching is to occur. The 
dotted lines indicate the switching limits. M = middle of the approximate posi-
tioning range.

Fig. 8-43

LIN P1 CONT VEL=0.3m/s CPDAT1
SYN OUT 1 '' State= TRUE at START PATH=20mm Delay=-5ms
LIN P2 CONT VEL=0.3m/s CPDAT2
LIN P3 CONT VEL=0.3m/s CPDAT3
LIN P4 VEL=0.3m/s CPDAT4

Fig. 8-44
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Switching limits:

 The switching point can be brought forward, at most, as far as the start of 
the approximate positioning range of P1.

 The switching point can be delayed, at most, as far as the next exact po-
sitioning point P4. If P3 was an exact positioning point, the switching point 
could be delayed, at most, as far as P3.

If greater values are specified for the shift in space or time, the controller au-
tomatically switches at the switching limit.

8.6.16 Setting a pulse on the path - SYN PULSE

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Position the cursor in the line after which the logic instruction is to be in-
serted.

2. Select the menu sequence Commands > Logic > OUT > SYN PULSE.

3. Set the parameters in the inline form.

 (>>> 8.6.17 "Inline form “SYN PULSE”" Page 221)

4. Save instruction with Cmd Ok.

8.6.17 Inline form “SYN PULSE”

SYN PULSE can be used to trigger a pulse at the start or end point of the mo-
tion. The pulse can be shifted in time and/or space, i.e. it does not have to be 
triggered exactly at the point, but can also be triggered before or after it.

Fig. 8-45: Inline form “SYN PULSE”

Item Description

1 Output number

2 If a name exists for the output, this name is displayed.

Only for the user group “Expert”:

A name can be entered by pressing Long text. The name is freely 
selectable.

3 State to which the output is switched

 TRUE

 FALSE

4 Duration of the pulse

 0.1 … 3 s
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8.6.18 Modifying a logic instruction

Precondition  A program is selected.

 Operating mode T1

Procedure 1. Position the cursor in the line containing the instruction that is to be 
changed.

2. Press Change. The inline form for this instruction is opened.

3. Change the parameters.

4. Save changes by pressing Cmd Ok.

5 Point to which SYN PULSE refers:

 START: Start point of the motion

 END: End point of the motion

See SYN OUT for examples and switching limits.  
(>>> 8.6.14 "Inline form “SYN OUT”, option “START/END”" 
Page 216)

 PATH: SYN PULSE refers to the end point. An offset in space 
is also possible.

See SYN OUT for examples and switching limits.  
(>>> 8.6.15 "Inline form “SYN OUT”, option “PATH”" Page 219)

6 Distance from the switching point to the end point

 -2,000 … +2,000 mm

This box is only displayed if PATH has been selected.

7 Switching action delay

 -1,000 … +1,000 ms

Note: The time specification is absolute. The switching point var-
ies according to the velocity of the robot.

Item Description
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9.1 Automatic External error messages

No. Message text Cause

P00:1 PGNO_TYPE incorrect value
permissible values (1,2,3)

The data type for the program 
number was entered incorrectly.

P00:2 PGNO_LENGTH incorrect value
Range of values 1 ≤ PGNO_LENGTH ≤ 
16

The selected program number 
length in bits was too high.

P00:3 PGNO_LENGTH incorrect value
permissible values (4,8,12,16)

If BCD format was selected for 
reading the program number, a 
corresponding number of bits must 
also be set.

P00:4 PGNO_FBIT incorrect value
not in the $IN range

The value “0” or a non-existent 
input was specified for the first bit 
of the program number.

P00:7 PGNO_REQ incorrect value
not in the $OUT range

The value “0” or a non-existent 
output was specified for the output 
via which the program number is 
to be requested.

P00:10 Transmission error
incorrect parity

Discrepancy detected when 
checking parity. A transmission 
error must have occurred.

P00:11 Transmission error
incorrect program number

The higher-level controller has 
transferred a program number for 
which there is no CASE branch in 
the file CELL.SRC.

P00:12 Transmission error
incorrect BCD encoding

The attempt to read the program 
number in BCD format led to an 
invalid result.

P00:13 Incorrect operating mode The I/O interface output has not 
been activated, i.e. the system 
variable $I_O_ACTCONF cur-
rently has the value FALSE. This 
can have the following causes:

 The mode selector switch is 
not in the “Automatic External” 
position.

 The signal $I_O_ACT currently 
has the value FALSE.

P00:14 Move to Home position in operating 
mode T1

The robot has not reached the 
HOME position.

P00:15 Incorrect program number More than one input set with “1 of 
n”.



224 / 237 Issued: 22.01.2013 Version: KSS 8.3 END V1 en (PDF)

KUKA System Software 8.3



225 / 237Issued: 22.01.2013 Version: KSS 8.3 END V1 en (PDF)

10 KUKA Service

10 KUKA Service

10.1 Requesting support

Introduction The KUKA Roboter GmbH documentation offers information on operation and 
provides assistance with troubleshooting. For further assistance, please con-
tact your local KUKA subsidiary.

Information The following information is required for processing a support request:

 Model and serial number of the robot

 Model and serial number of the controller

 Model and serial number of the linear unit (if applicable)

 Model and serial number of the energy supply system (if applicable)

 Version of the KUKA System Software

 Optional software or modifications

 Archive of the software

For KUKA System Software V8: instead of a conventional archive, gener-
ate the special data package for fault analysis (via KrcDiag).

 Application used

 Any external axes used

 Description of the problem, duration and frequency of the fault

10.2 KUKA Customer Support

Availability KUKA Customer Support is available in many countries. Please do not hesi-
tate to contact us if you have any questions.

Argentina Ruben Costantini S.A. (Agency)

Luis Angel Huergo 13 20

Parque Industrial

2400 San Francisco (CBA)

Argentina

Tel. +54 3564 421033

Fax +54 3564 428877

ventas@costantini-sa.com

Australia Headland Machinery Pty. Ltd.

Victoria (Head Office & Showroom)

95 Highbury Road 

Burwood

Victoria 31 25

Australia

Tel. +61 3 9244-3500

Fax +61 3 9244-3501

vic@headland.com.au

www.headland.com.au
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Belgium KUKA Automatisering + Robots N.V.

Centrum Zuid 1031

3530 Houthalen

Belgium

Tel. +32 11 516160

Fax +32 11 526794

info@kuka.be

www.kuka.be

Brazil KUKA Roboter do Brasil Ltda.

Travessa Claudio Armando, nº 171

Bloco 5 - Galpões 51/52

Bairro Assunção

CEP 09861-7630 São Bernardo do Campo - SP

Brazil

Tel. +55 11 4942-8299

Fax +55 11 2201-7883

info@kuka-roboter.com.br

www.kuka-roboter.com.br

Chile Robotec S.A. (Agency)

Santiago de Chile

Chile

Tel. +56 2 331-5951

Fax +56 2 331-5952

robotec@robotec.cl

www.robotec.cl

China KUKA Robotics China Co.,Ltd.

Songjiang Industrial Zone

No. 388 Minshen Road

201612 Shanghai

China

Tel. +86 21 6787-1888

Fax +86 21 6787-1803

www.kuka-robotics.cn

Germany KUKA Roboter GmbH

Zugspitzstr. 140

86165 Augsburg

Germany

Tel. +49 821 797-4000

Fax +49 821 797-1616

info@kuka-roboter.de

www.kuka-roboter.de
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France KUKA Automatisme + Robotique SAS

Techvallée

6, Avenue du Parc

91140 Villebon S/Yvette

France

Tel. +33 1 6931660-0

Fax +33 1 6931660-1

commercial@kuka.fr

www.kuka.fr

India KUKA Robotics India Pvt. Ltd.

Office Number-7, German Centre,

Level 12, Building No. - 9B

DLF Cyber City Phase III

122 002 Gurgaon

Haryana

India

Tel. +91 124 4635774

Fax +91 124 4635773

info@kuka.in

www.kuka.in

Italy KUKA Roboter Italia S.p.A.

Via Pavia 9/a - int.6

10098 Rivoli (TO)

Italy

Tel. +39 011 959-5013

Fax +39 011 959-5141

kuka@kuka.it

www.kuka.it

Japan KUKA Robotics Japan K.K.

YBP Technical Center

134 Godo-cho, Hodogaya-ku

Yokohama, Kanagawa

240 0005

Japan

Tel. +81 45 744 7691

Fax +81 45 744 7696

info@kuka.co.jp

Canada KUKA Robotics Canada Ltd.

6710 Maritz Drive - Unit 4

Mississauga

L5W 0A1 

Ontario

Canada

Tel. +1 905 670-8600

Fax +1 905 670-8604

info@kukarobotics.com

www.kuka-robotics.com/canada
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Korea KUKA Robotics Korea Co. Ltd.

RIT Center 306, Gyeonggi Technopark

1271-11 Sa 3-dong, Sangnok-gu

Ansan City, Gyeonggi Do

426-901

Korea

Tel. +82 31 501-1451

Fax +82 31 501-1461

info@kukakorea.com

Malaysia KUKA Robot Automation Sdn Bhd

South East Asia Regional Office

No. 24, Jalan TPP 1/10

Taman Industri Puchong

47100 Puchong

Selangor

Malaysia

Tel. +60 3 8061-0613 or -0614

Fax +60 3 8061-7386

info@kuka.com.my

Mexico KUKA de México S. de R.L. de C.V.

Progreso #8

Col. Centro Industrial Puente de Vigas

Tlalnepantla de Baz

54020 Estado de México

Mexico

Tel. +52 55 5203-8407

Fax +52 55 5203-8148

info@kuka.com.mx

www.kuka-robotics.com/mexico

Norway KUKA Sveiseanlegg + Roboter

Sentrumsvegen 5

2867 Hov

Norway

Tel. +47 61 18 91 30

Fax +47 61 18 62 00

info@kuka.no

Austria KUKA Roboter Austria GmbH

Vertriebsbüro Österreich

Regensburger Strasse 9/1

4020 Linz

Austria

Tel. +43 732 784752

Fax +43 732 793880

office@kuka-roboter.at

www.kuka-roboter.at
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Poland KUKA Roboter Austria GmbH

Spółka z ograniczoną odpowiedzialnością

Oddział w Polsce

Ul. Porcelanowa 10

40-246 Katowice

Poland

Tel. +48 327 30 32 13 or -14

Fax +48 327 30 32 26

ServicePL@kuka-roboter.de

Portugal KUKA Sistemas de Automatización S.A.

Rua do Alto da Guerra n° 50

Armazém 04

2910 011 Setúbal

Portugal

Tel. +351 265 729780

Fax +351 265 729782

kuka@mail.telepac.pt

Russia OOO KUKA Robotics Rus

Webnaja ul. 8A

107143 Moskau

Russia

Tel. +7 495 781-31-20

Fax +7 495 781-31-19

kuka-robotics.ru

Sweden KUKA Svetsanläggningar + Robotar AB

A. Odhners gata 15

421 30 Västra Frölunda

Sweden

Tel. +46 31 7266-200

Fax +46 31 7266-201

info@kuka.se

Switzerland KUKA Roboter Schweiz AG

Industriestr. 9

5432 Neuenhof

Switzerland

Tel. +41 44 74490-90

Fax +41 44 74490-91

info@kuka-roboter.ch

www.kuka-roboter.ch
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Spain KUKA Robots IBÉRICA, S.A.

Pol. Industrial

Torrent de la Pastera

Carrer del Bages s/n

08800 Vilanova i la Geltrú (Barcelona)

Spain

Tel. +34 93 8142-353

Fax +34 93 8142-950

Comercial@kuka-e.com

www.kuka-e.com

South Africa Jendamark Automation LTD (Agency)

76a York Road

North End

6000 Port Elizabeth

South Africa

Tel. +27 41 391 4700

Fax +27 41 373 3869

www.jendamark.co.za

Taiwan KUKA Robot Automation Taiwan Co., Ltd.

No. 249 Pujong Road

Jungli City, Taoyuan County 320

Taiwan, R. O. C.

Tel. +886 3 4331988

Fax +886 3 4331948

info@kuka.com.tw

www.kuka.com.tw

Thailand KUKA Robot Automation (M)SdnBhd

Thailand Office

c/o Maccall System Co. Ltd.

49/9-10 Soi Kingkaew 30 Kingkaew Road

Tt. Rachatheva, A. Bangpli

Samutprakarn

10540 Thailand

Tel. +66 2 7502737

Fax +66 2 6612355

atika@ji-net.com

www.kuka-roboter.de

Czech Republic KUKA Roboter Austria GmbH

Organisation Tschechien und Slowakei

Sezemická 2757/2

193 00 Praha

Horní Počernice

Czech Republic

Tel. +420 22 62 12 27 2

Fax +420 22 62 12 27 0

support@kuka.cz
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Hungary KUKA Robotics Hungaria Kft.

Fö út 140

2335 Taksony

Hungary

Tel. +36 24 501609

Fax +36 24 477031

info@kuka-robotics.hu

USA KUKA Robotics Corporation

51870 Shelby Parkway

Shelby Township

48315-1787 

Michigan

USA

Tel. +1 866 873-5852

Fax +1 866 329-5852

info@kukarobotics.com

www.kukarobotics.com

UK KUKA Automation + Robotics

Hereward Rise

Halesowen

B62 8AN

UK

Tel. +44 121 585-0800

Fax +44 121 585-0900

sales@kuka.co.uk
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Index

Symbols
#BSTEP 146
#ISTEP 146
#MSTEP 146
$ANIN 211
$ANOUT 211
$IN 211
$OUT 211
$ROBRUNTIME 83, 84

Numbers
2004/108/EC 40
2006/42/EC 40
3-point method 115
89/336/EEC 40
95/16/EC 40
97/23/EC 40

A
ABC 2-point method 112
ABC World method 112
Accessories 13, 17
Actual position 75
Administrator 59
Advance run 147
ANOUT 212
Applied norms and regulations 40
Approximate positioning 161, 184
Archiving overview 153
Archiving, logbook 156
Archiving, network 155
Archiving, to USB stick 155
ASCII Mode (menu item) 145
Automatic External error messages 223
Automatic mode 37
Auxiliary point 160
Axis range 19
Axis range limitation 28
Axis range monitoring 29

B
Backward motion 149
Base calibration 114
BASE coordinate system 60, 114
Block pointer 142
Block selection 149, 166
Brake defect 32
Brake release device 29
Braking distance 19

C
Calibrating an external kinematic system 126
Calibration 107
Calibration points (menu item) 82
Calibration, base 114
Calibration, external TCP 118
Calibration, fixed tool 118
Calibration, linear unit 124

Calibration, root point, kinematic system 126
Calibration, tool 107
Calibration, TOOL kinematic system 130
Calibration, workpiece 118
Cancel program 142
CE mark 18
CELL.SRC 150
CIRC motion 181
CIRC, motion type 160
Circular angle 191, 202
Cleaning work 38
Cold start 54
Cold start, initial 53, 54
Collision detection 183
Comment 152
Connecting cables 13, 17
Connection manager 44
Constant velocity range 197, 208
Continuous Path 159
Coordinate system for jog keys 48
Coordinate system for Space Mouse 47
Coordinate systems 60
Coordinate systems, angles 61
Coordinate systems, orientation 61
Copy 153
Counterbalancing system 38
Counters, displaying 80
CP motions 159
CP spline block 185
Creating a new folder 140
Creating a new program 141
CRR 19
Cut 153

D
Danger zone 19
Data, restoring 156
Declaration of conformity 18
Declaration of incorporation 17, 18
Decommissioning 39
DEF line (menu item) 145
DEF line, displaying/hiding 145
Deleting mastering 105
Detail view, activating 145
Dial gauge 95
Directory structure 139
Displaying, robot controller information 83
Displaying, robot information 83
Disposal 39
Documentation, industrial robot 11
Drive bus 53

E
EC declaration of conformity 18
Edit (button) 48
Editing a program 150
Editor 141
Electronic Mastering Device 90
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EMC Directive 18, 40
EMD 90
EMERGENCY STOP 44
EMERGENCY STOP device 25, 26, 31
EMERGENCY STOP, external 26, 34
EMERGENCY STOP, local 34
EN 60204-1 41
EN 61000-6-2 41
EN 61000-6-4 41
EN 614-1 41
EN ISO 10218-1 41
EN ISO 12100 41
EN ISO 13849-1 40
EN ISO 13849-2 41
EN ISO 13850 40
Enabling device 27, 31
Enabling device, external 27
Enabling switch 45
Enabling switches 27
Energy consumption, measuring 73
error messages, Automatic External 223
Exiting, KSS 51
External axes 17, 20, 75, 83
External kinematic system, calibration 126

F
Faults 32
File list 139
File, renaming 141
Filter 140
Find 153
First mastering 91, 99
Fixed tool, calibration 118
Flags, displaying 78, 79
FLANGE coordinate system 61, 108
Folder, creating 140
Function test 34

G
General safety measures 32
Guard interlock 25

H
Hazardous substances 39
Header 139
Hibernate 54
HOME position 145
HOV 66

I
Identification plate 45
Increment 71
Incremental jogging 71
Indirect method 116, 117
Industrial robot 13, 17
Info (menu item) 83
Inline forms 179
Inputs/outputs, analog 77, 211
Inputs/outputs, Automatic External 77
Inputs/outputs, digital 75, 211
Intended use 14, 17

INTERN.ZIP 155
Interpolation mode 183, 188
Introduction 11

J
Jerk 188, 189, 193, 195, 200, 203
Jog keys 44, 62, 67
Jog mode 28, 31
Jog mode “Jog keys” 64
Jog mode “Space Mouse” 64
Jog mode, activating 66
Jog override 66
Jogging, axis-specific 61, 67
Jogging, Cartesian 61, 67, 70
Jogging, external axes 72
Jogging, robot 61

K
KCP 19, 32, 43
Keyboard 44
Keyboard key 44
Keypad 50
Kinematics group 48, 64
KUKA Control Panel 43
KUKA Customer Support 83, 225
KUKA smartHMI 47
KUKA smartPAD 19, 43
KUKA.Load 132
KUKA.LoadDataDetermination 132

L
Labeling 30
Language 54
Liability 17
LIN motion 180
LIN, motion type 160
Line break (menu item) 146
Linear unit 17, 123
Load data 132
Long texts, exporting 134
Long texts, importing 134
Loss of mastering 91, 94, 99, 103
Low Voltage Directive 18

M
Machine data 34, 83, 84, 85
Machinery Directive 18, 40
Main menu, calling 50
Maintenance 37, 136
Manipulator 13, 17, 19, 22
Manual mode 36
Mastering 87
Mastering after maintenance work 97
Mastering marks 89
Mastering methods 88
Mechanical axis range limitation 28
Mechanical end stops 28
MEMD 98
Messages 223
Micro Electronic Mastering Device 98
Mode selection 23, 24
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Index

Modifying a logic instruction 222
Modifying coordinates 210
Modifying motion parameters 210
Module 56
Monitoring, velocity 28
Motion programming, basic principles 159
Motion types 159
Motor, exchange 97

N
Name, archive 84
Name, control PC 83
Name, robot 83, 84
Navigator 139
Numeric entry, external TCP 120
Numeric entry, external tool 131
Numeric entry, linear unit 125
Numeric entry, root point, kinematic system 127
Numeric input, tool 114

O
Offset 91, 93, 99, 102, 213
Opening a program 141
Operating hours 84
Operating hours meter 84
Operating mode, changing 59
Operation 43
Operator 19, 21, 58
Operator safety 23, 25, 31
Options 13, 17
Orientation control, LIN, CIRC 162
Orientation control, spline 174
OUT 211
Output, analog 212
Output, digital 211
Overload 32
Override 66, 147
Override (menu item) 73
Overview of the industrial robot 13

P
Palletizing robots 109, 114
Panic position 27
Paste 153
Payload data 132
Payload data (menu item) 133
Performance Level 23
Personnel 20
Plant integrator 20
Point-to-point 159
Positionally accurate robot, checking activation 
87
Positioner 17, 126
POV 147
Pre-mastering position 89
Pressure Equipment Directive 38, 40
Preventive maintenance work 38
Printing a program 153
Product description 13
PROFIenergy 73
Program lines, deleting 152

Program management 139
Program override 147
Program run mode, selecting 146
Program run modes 146
Program, cancel 142
Program, closing 143
Program, creating 141
Program, opening 141
Program, selecting 141
Program, starting 148
Program, stopping 148, 149, 150
Programmer 58
Programming, inline forms 179
Programming, User 179
Protective equipment 28
PTP motion 179
PTP spline block 185
PTP, motion type 159
PULSE 212
Pulse 212
Pulse, path-related 221

R
Rating plate 85
RDC, exchange 97
Re-teaching 210
Reaction distance 19
Recommissioning 33, 85
Reference mastering 97
Release device 29
Renaming a file 141
Renaming the base 122
Renaming the tool 122
Repair 37
Replace 153
Resetting a program 150
Robot controller 13, 17
Robot data (menu item) 83
ROBROOT coordinate system 60

S
Safe operational stop 19, 27
Safeguards, external 31
Safety 17
Safety controller 24
Safety functions 31
Safety functions, overview 23
Safety instructions 11
Safety STOP 0 19
Safety STOP 1 19
Safety STOP 2 20
Safety STOP 0 19
Safety STOP 1 19
Safety STOP 2 20
Safety stop, external 27, 28
Safety zone 19, 22
Safety, general 17
SCIRC motion, programming 201
SCIRC segment, programming 190
Selecting a program 141
Selecting the base 66
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Selecting the tool 66
Serial number 84
Service life 19, 83
Service, KUKA Roboter 225
Shutdown (menu item) 51
Simulation 37
Single point of control 39
Singularities 177
Singularity, CP spline 174
SLIN motion, programming 199
SLIN segment, programming 189
smartHMI 13, 47
smartPAD 19, 43
Software 13, 17
Software limit switches 28, 31, 105
Software limit switches, modifying 105
Space Mouse 44, 62, 67, 69, 70
Special characters 179
SPL segment, programming 189
Spline block, programming 185
Spline segment 163
Spline, motion type 163
SPOC 39
SPTP motion, programming 204
SPTP segment, programming 191
Stamp 152
Start backwards key 44
Start key 44, 45
Start types 54
Start-up 33, 85
Start-up mode 35
Start-up wizard 85
Starting a program, automatic 148
Starting a program, backwards 149
Starting a program, manual 148
Starting Automatic External mode 150
Starting the KSS 50
Status bar 47, 48, 139
Status keys 44
STOP 0 18, 20
STOP 1 18, 20
STOP 2 18, 20
Stop category 0 20
Stop category 1 20
Stop category 2 20
STOP key 44
Stop reactions 22
Stopping a program 148, 149, 150
Stopping distance 19, 22
Storage 39
Storage capacities 83
Submit interpreter 49
Submit interpreter, status indicator 49
Supplementary load data (menu item) 133
Support request 225
Switching action, path-related 216
Switching on the robot controller 50
SYN OUT 216
SYN PULSE 221
System integrator 18, 20, 21
System requirements 14

T
T1 20
T2 20
Target group 11
TCP 107
TCP, external 118
Teach pendant 13, 17
Teaching 210
Technology packages 13, 83, 179
Terms used, safety 18
Timers, displaying 81
Tool calibration 107
Tool Center Point 107
TOOL coordinate system 60, 107
Tool, external 130
Touch screen 43, 50
Trademarks 12
Training 11
Transportation 33
Trigger, for spline inline form 195
Turn-tilt table 17, 126
Type, robot 83
Type, robot controller 83

U
Unmastering 105
USB connection 45
USB sticks 14
Use, contrary to intended use 17
Use, improper 17
User 19, 20
User group, changing 58
User group, default 58
User interface 47

V
Velocity 66, 147
Velocity monitoring 28
Version, kernel system 83
Version, operating system 83
Version, robot controller 83
Version, user interface 83
Voltage 77, 213, 214

W
WAIT 214
Wait function, signal-dependent 214
Wait time 214
WAITFOR 214
Warnings 11
Working range limitation 28
Workpiece base calibration 128
Workpiece base, numeric entry 130
Workspace 19, 22
Workspace monitoring, bypassing 72
WORLD coordinate system 60

X
XYZ 4-point method 109
XYZ Reference method 111
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